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What's New in SketchUp and LayOut 2022.0? 
General Notes 

●​ The OS support for SU 2022.0 includes Windows 11 and macOS Monterey. 
The macOS Mojave (10.14) is no longer officially supported. 

SketchUp 
Search SketchUp 
First introduced in SketchUp for Web, Search SketchUp is now a desktop feature 
that allows you to look up and activate commands by typing. Search supports 
queries for commands by name as well as by 'concept.' This means you can search 
for workflow-related queries -- such as 'elevation,' 'boolean,' or 'chamfer' -- and see 
related SketchUp results. In SketchUp Pro, Search also provides results for installed 
extension commands with associated toolbar or menu listings. Activate Search with 
its toolbar icon (far left in the Getting Started toolbar), from the Help menu, or by its 
default shortcut (Shift + S). 

Lasso 

Lasso is a selection tool that lets you create hand-drawn selection bounds. To 
create a window bounding loop (where only entities entirely inside are selected), 
click-drag and move the cursor clockwise. Move counterclockwise to make a 
crossing bounding loop (where partially contained entities are selected). A stippled 



vector line distinguishes the crossing selection. If you like, you can reverse Lasso's 
directional behavior in Preferences > Drawing. 

Additionally, Lasso can select entities one click at a time and works with the same 
modifier patterns as Select. For Lasso, we are introducing a new default shortcut: 
Shift + Spacebar. 

Tag 
The Tag tool lets you apply tags by clicking entities in the modeling window. To 
specify a tag, select an individual tag in the Tags panel or use the tool's Sample 
modifier to grab a tag from an entity in your model. Keep an eye out for tooltips 
that affirm the tag about to be applied or sampled. When you click to tag entities, a 
purple bounding highlight blinks to confirm the operation. Learn more about the 
Using the Tag tool and its modifier actions...  

The Tag tool may also be used on pre-selected entities, so we've added commands 
improve bulk selection: 

●​ Select > All with Tag (modeling context menu): Select all entities in the active 
modeling context that share any tag with the pre-selection. 

●​ Select > All Instances (modeling context menu): Select all component instances 
(in the active modeling context) that share a definition with the selection. 

●​ Select All Tagged (tag tree context menu): Select all entities in the model (in the 
active modeling context) that share a tag with a pre-selection in the Tags 
panel. This command is available by right-clicking the tag tree and can be 
used on either tags or tag folders. 

Freehand "+" 
We've made a considerable upgrade to the Freehand tool, allowing you to create 
much smoother curve entities. These improved freehand curves generally contain 
more segments. Immediately after drawing a curve, you may decrease the 
segmentation of the curve incrementally, and SketchUp will provide visual feedback 
with each increment. Segment control is available by modifier keypresses specified 
in the Status Bar. Freehand has also received axis locking input to set a drawing 



plane (available before a user starts drawing). And it is now possible to draw across 
adjacent faces on different planes. 

2-Point Arc and 3-Point Arc: Tangent Inference Lock 
There is now a tangent inference lock for the 2-Point and 3-Point Arc tools. This new 
toggle makes it possible to lock tangency from an existing edge so that the next 
click creates a tangent arc. To toggle on this inference lock, tap the Alt key on 
Windows or Command key on Mac. 

With tangency locked, what you see is what you get. Click to set the tangent arc and start 
drawing a new one. 

When multiple edges intersect, you may hover over an edge to request it as the 
basis for tangency before clicking to begin the arc. This behavior is available 
whether or not the inference is locked. 

With tangency locked, what you see is what you get. Click to set the tangent arc and start 
drawing a new one. 
 

Scene search 

When models have a ton of scenes, it can be a bear to scan a long list to identify a 
desired scene to jump to or configure. In SketchUp 2022, we've added a new search 
filter -- available adjacent to Scene Tabs (when there are two or more scenes) that 
lets you type to find a scene name. Click a scene from the search results to jump to 
that scene and also select it in the Scenes panel. 

  
Native Apple silicon Support 

In SketchUp 2022, we are offering a universal installer that enables SketchUp Pro to 
run 'natively' on Mac devices that run with Apple silicon (introduced in late 2020). 



Previously, SketchUp has been running on these devices using the Rosetta 
translation service. 

The 2022 installer also supports SketchUp's installation and operation on Mac 
devices with Intel processors. Apple users will not need to distinguish which chipset 
powers their Mac to install SketchUp Pro. 

Explode performance 

When you explode a large object in SketchUp, there is often a noticeable hang. In 
2022.0, we have made a significant improvement to Explode operations. In large 
models, we expect users may experience a 2-3x improvement with Explode. 

Other notable improvements 
 

Section plane improvements 

When you need to use section planes in a model, it's a good bet you don't just need 
one or two. As the number of section planes grows, section plane visibility becomes 
mutually exclusive with selection, sampling, or painting. In this update, we've 
changed picking logic so that if section planes are visible, entities they obscure are 
still pickable. That means it's now a lot easier to pick, paint, tag, and sample when 
section planes are visible. 

You can still select a section plane by clicking its border or symbol, or by using Outliner. 

Clipping improvements 

'Clipping' is a longstanding problem that occurs when users navigate to modeling 
window views where the camera cannot appropriately interpret model geometry. 
The result is 'clipped' geometry that displays inappropriately. In this release, we 



have made changes that should improve a few scenarios where people experience 
clipping. These include: 

●​ Switching to parallel projection camera views. When switching camera modes, 
it was very common for model views to be (extraordinarily) clipped. SketchUp 
2022 resolves this problem. 

●​ Perspective clipping in models with large extents. When the expanse of a model 
is vast, zooming into a small part of the model will still produce clipping. But 
now, when you enable the 'Hide Rest of Model' display setting, SketchUp will 
re-interpret the view to display geometry properly. This means you can 
entirely mitigate clipping in these scenarios through the use of groups and 
components along with the 'Hide Rest of Model' command. 

Standard Views respect model axes 

In previous versions of SketchUp, Standard View commands -- Top, Front, Right... -- 
did not respect customized model axes. So, you would need to use the Align View 
command to produce camera views for properly aligned elevation and section 
views. Now, the Standard Views will behave as expected to produce properly 
aligned views to customized axes. One other small change: the Align View 
command is now accessible in the Context Menu, even if other entities (like edges 
or objects) are also in the selection set. 

Tape Measure tweaks 

We have made some modifications to smooth over a few rough spots in 
measurement and guide operations. These include: 

●​ When Tape Measure is active, both the Measurements box and tooltips 
provide previews for length, area, or coordinates. In this release, when you 
click to set a guide or take a measurement, the Measurements box will hold 
that value, even if you move your cursor. (Previously, moving the cursor 
would clear the value of your guide or measurement to display previews). 
After measurement operations, previews are still available in tooltips. And 



resetting Tape Measure (by hitting its shortcut or toolbar icon) will restore 
previews in the Measurements box. 

●​ Guides that are being created will now appear in the same color as guides 
that have been placed. Previously, 'in-process' guides would appear light gray 
and be hard to see in some camera positions. 

●​ When 'View Guides' is toggled off, creating a new guide will now toggle on 
guide visibility. Previously, users could forget that guide visibility was off and 
unnecessarily repeat guide creation until remembering... or cursing SketchUp 
in a white-hot rage. 

Directional inference tooltips 

In SketchUp 2021.1, we added the ability to 'pre-lock' a directional inference for 
Line, Freehand, 2-point Arc, 3-Point Arc, Move, and Tape Measure. In this update, 
tooltips confirm when an inference is locked using the arrow keys, before the first 
click of an operation. 

Smart size restrictions for 2D exports 

In previous releases, SketchUp capped the maximum 2D image export size to 9999 
pixels (wide or high). This limitation was meant to prevent SketchUp from freezing if 
people asked their systems for more memory than was available. As the available 
system memory varies across our users' devices, we have now adjusted our 2D 
exports to be less restrictive and more responsive to the working memory on a 
given device. Now users may enter any value into the image size fields. If SketchUp 
thinks that the resulting image will exceed the available system memory, a dialog 
will advise users to reduce the image size. 

Faster model checking 

SketchUp's 'Automatically fix problems' service has not handled small geometry 
well. In many cases, faces could be deleted when model validity checking was 
enabled. In this update, we've improved both the fidelity and performance of 
validity checking and repair, so that small faces are not deleted and that the entire 



process goes significantly faster (between a 1.5 and 5x improvement in the 90+ 
models we tested). 

LayOut 
Zoom Selection 
When LayOut pages grow in detail and complexity, they often become cumbersome 
to use with scroll-to-zoom functionality. Using LayOut's new Zoom Selection 
command, you can jump your view to a selection, decreasing the likelihood you will 
experience lags on zoom in (and then zoom out, when you end up zooming too far 
in! ?). This command is available from the context menu, the View menu, the page 
navigation menu, and as a customizable toolbar icon. There is also a new default 
shortcut: Alt + Z on Windows and Option + Z on Mac. 

Viewport-based Auto-Text labels 
In addition to existing labels that pull attributes from SketchUp entities, we are 
introducing new tags that can either be selected from the Auto-Text menu in label 
creation or utilized in scrapbook labels. To enable these tags, label leaders must be 
pointing to geometry in a viewport. 

Labels can be used in scrapbooks (and with transparent leaders). This means that 
users may drag Auto-Text labels in from a scrapbook, then hit enter to drag the 
label leader to automatically display a value associated with a viewport, even in 
cases where no leader line is desirable.. 

<SceneName> & <SceneDescription> 

<SceneName> Pulls the name of the scene that a viewport is set to display. If you 
slightly modify the camera position of a viewport, this tag will still display the last 
chosen scene. 

Since many drawing titles would be too long to display in a SketchUp scene name, 
we are also exposing <SceneDescription> as an auto-text tag. Using this scene 
attribute -- defined in SketchUp's Scenes panel -- allows you to use abbreviated 



scene names to manage large numbers of scenes and longer strings for scene 
descriptions/drawing titles. 

<Scale> and <Ratio> 

These tag displays the current orthographic scale of a viewport. Use the <Scale> tag 
to display a scale as a unit translation - for instance, 1" = 1' or 1mm = 1m. Use 
<Ratio> to express the viewport scale as a unit-less scale: 1:12 or 1:1000. 

<Coordinates(x,y,z)> 

We are also introducing a new way to customize the value of certain Auto-Text tags 
by specifying a parameter in the tag. 

In the case of the existing <Coordinates> tag, you may specify x, y, and/or z values 
for the tag. So for a given vertex at 12', 6', 32': 

●​ <Coordinates(z)> → 32' 
●​ <Coordinates(x,y) → 12', 6' 
●​ <Coordinates(z,x) → 32', 12' 

Output values match the specified model units in SketchUp and correspond to the 
axes of a viewport's scene. Another improvement: coordinate values can now be 
pulled from a point on an edge or face. 

Page Management Auto-Text 
We are introducing some new and improved Auto-Text with the intention of 
enabling more efficient title block management, as well as the creation of tables of 
contents. 

<PageCount> 



Complementing our existing <PageNumber> tag, <PageCount> yields the number 
of pages in a user-defined range in the document. Similar to <PageCount> users 
may specify: 

<PageCount> includes a customization value for 'End Page' which determines 
where the count ends. By default, End Page is set to Last Page, whatever that page 
is. As pages are added to the document in the count range, this tag will update. 
Learn more about <PageCount>... 

<PageName()> 

Parameter input for the existing <PageName> tag will display the name of a page 
that is not the current page. The value you set in the parentheses reflects the 
relative position of a page in the LayOut document. So, <PageName(3)> will output 
the name of the third page in your document (as specified in the Pages panel). 
Learn more about Page Management Auto-Text in LayOut... 

Sequence Auto-Text 
We are introducing a new Auto-Text tag that automatically increments when 
duplicated. These tags may be used to rapidly annotate drawings and figures, 
create numbered drawing titles, index legends, and many other use cases that 
would previously require text editing between each copy. For guidance on usage 
and customization, learn more about Sequence Auto-Text in LayOut. 

Find & Replace Text 
There are several ways to quickly create and copy text across multiple pages in a 
LayOut document. But, until now, modifying text across a page or an entire 
document has been a real pain in the butt. With Find & Replace in LayOut, making 
changes in a selection, a page, or an entire document can go much quicker. 

Find & Replace can be activated with the Ctrl + F shortcut (Command + F on Mac) as 
well as from the Text menu in LayOut. Learn more about Find & Replace... ​
  



Auto-Text Scrapbooks 
To highlight Auto-Text functionality and capabilities, we are adding two new pages 
to each of LayOut's English title block scrapbooks: the graphics packages which 
complement title block templates. These include a collection of viewport-based 
Auto-Text labels and a table of contents template. Learn more about the objects in 
Auto-Text scrapbooks... 

  
​
  

SketchUp Release Notes 
Bug fixes / small features added 
Stability 

●​ Fixed an issue where copy and paste of a section plane could lead to a crash. 
●​ Fixed a possible file corruption that could occur with extremely large models. 
●​ Performance improvement when copy and pasting a lot of geometry from 

one file into another large model. 



●​ Fixed an issue where corrupt geometry could prevent a paste from 
happening. 

●​ Fixed an issue where using the Offset tool to offset something by a very small 
amount would lead to a crash. 

●​ Fixed an issue where opening a file that was corrupted would never finish 
attempting to open the file. Now it will quickly show a file error message. 

●​ Fixed an issue where certain corrupt SketchUp documents would lead to a 
crash, instead of showing an error message. 

●​ Fixed memory leak issue when thumbnail images were created. 
●​ (Win) Added error trapping to cope with an infrequent Windows related 

misread of a directory. 
●​ (Mac) Fixed an issue where closing a SketchUp document while SketchUp was 

in the background could lead to a crash. 

Tools 

●​ Fixed a scaling issue, where the selected object did not scale to the size of a 
typed in value. 

●​ Removed object grips artifact, where the grips would stay visible in the old 
location after doing a move operation. 

●​ Rotation handles were not appearing when hovering over a cut hole 
component with the Move tool. 

●​ Added help tips to show axis locking before a drawing action is started with 
the Line, Freehand, 2- and 3-point Arc, Move, and Tape Measure tools. 

●​ Fixed an issue where drawing a freehand curve across an edge would 
explode the curve. Now freehand drawing across edges will only create as 
many curves as necessary. 

●​ Improved help tips when hovering over cardinal points with the Move tool, to 
indicate that the object will resize when that point is moved. 

●​ The Measurements box will now display a Tape Measure measurement until 
a new measurement is made or the tool is reset (by hitting its shortcut). Live 
measurement previews for Length, Area, and Coordinates are still available 
before a measurement is taken and in tooltips (before and after a 
measurement). 



●​ Fixed an issue where the Offset tool would offset by an incorrect amount 
when being used with curved edges. 

●​ Fixed an issue where a section plane would prevent the Paint Bucket tool 
from applying or sampling materials on the far side of the section plane. 

●​ Copy and paste of a section plane would lose its current active state. 
●​ Embedded section planes would show distorted handles if the parent object 

was non-uniformly scaled. 
●​ Fixed an issue where hidden section planes were still being picked up by 

inference when using the Line tool. 
●​ Fixed an issue where curved geometry was remaining selected when using 

the Shift key with the Select tool. 
●​ Fixed an issue where the protractor symbol used in Move and Rotate tools 

would appear at the origin instead of at the cursor location. 
●​ Guides being placed by the Tape Measure and Rotate tools were in a dark 

gray color that could be hard to see against darker faces. They are now 
shown in the guides color as set in the current style. 

●​ When adding a guide with guide visibility disabled in the View menu, the 
guide would seem to disappear. Now guide visibility is enabled when creating 
a new guide. 

●​ Fixed an issue where using the Move tool in Copy mode, clicking on an edge 
and typing the distance value, would not create the duplicate edge. 

●​ Added ability to type in the value needed for the second point when creating 
a 2 or 3 point arc. 

●​ Status bar text was not being updated for some tools until the cursor was 
moved. 

●​ Fixed an issue where edges remain selected when using the Eraser tool in its 
Unhide mode. 

●​ Fixed an issue where the Move tool in Copy mode would fail to copy a curve. 
●​ Fixed an issue where moving or copying of cut face components to a 

different face on the same plane wasn't cutting holes. 
●​ Enabled array creation and typing a distance value when using the Move tool 

in Stamp mode. 
●​ (Win) Using a keyboard shortcut that includes a modifier key would change 

the mode of the Move tool. 



Miscellaneous 

●​ Localized templates display shadow settings based on selected language. 
●​ Working inside a component in a model that is very spread out could lead to 

clipping issues, even if Hide Rest of Model was being used. Now if the rest of 
the model is hidden, only the geometry inside the component is considered, 
and very little clipping should occur. 

●​ Moving the camera's location into the middle of the model's geometry, then 
switching to Parallel Projection, would lead to severe clipping. Now the 
camera is backed away from the geometry, and no clipping should occur. 

●​ Improved handling of files that had corrupt materials, which would prevent 
the file from opening. 

●​ Standard Views will now align to custom axes in any modeling context (in or 
outside of groups and components). 

●​ Downloading models from 3D Warehouse while inside a group or component 
would place the new component at the root level of the document, instead of 
inside the object being edited. 

●​ The Advanced Camera Tools extension no longer ships with SketchUp Pro. 
Advanced Camera Tools is still available on Extension Warehouse. 

●​ Fixed an issue where any changes made in the View menu were not updating 
the scene when working in a demanding model. 

●​ Fixed an issue where exporting an .stl as selected would result in an empty 
file. 

●​ Fixed an issue where resetting the axes position of a component which has a 
different orientation than the global axes was causing unexpected orbit 
behavior. 

●​ Fixed an issue where orbiting a model was showing unsmooth transitions 
after using the Align Axes command. 

●​ The Align View command is now available in the Context menu when a user 
right-clicks a face in a selection set that also contains other entities. 

●​ Fixed an issue where a component would fail to cut a hole if the Untagged 
tag was hidden. 

●​ Fixed an issue where switching between scenes and orbiting was causing 
location issues for the model. 



●​ Fixed an issue where models weren't opening due to file corruption. Opening 
corrupted files will now show details of the invalid items causing the 
problem. 

●​ Added new contextual menu items to enable selecting objects with the same 
tag. 

●​ Added file import functionality in Trimble Connect extension. 
●​ Fixed an issue with an untranslated string in the IFC 2x3 Export dialog. 
●​ Export size of 2D images can now be higher than 9999 pixels across, 

provided the system memory needed to create the image is available. 
●​ Fixed an issue where Add Location tiles occasionally import blank if one of 

the imported tiles was a 32 bit image. 
●​ Renaming a scene then clicking on another scene no longer displays an error. 
●​ Scenes can no longer be named with a blank name. 
●​ Right-clicking on a scene name updates the Scene details correctly. 
●​ Import Visual Reference is a new command in the Trimble Connect Extension 

that imports 3D models as a locked instance. If working file is published to 
Trimble Connect, these "references" are removed from the model. 

●​ (Win) Fixed an issue where a second SketchUp instance would show a 
recovered file that was currently open for editing in the first instance of 
SketchUp. 

●​ (Win) Added error checks to prevent installation of SketchUp into the system 
root directory (C:/) or into a non-empty directory. 

●​ (Win) Fixed a problem where installation of the C++ redistributable library 
failed. 

●​ (Win) New icon for SketchUp Viewer. 
●​ (Win) Fixed a crash when clicking the Expert Dimension Settings button in 

Model Info 
●​ (Win) Fixed an issue where the Ctrl modifier was not enabling the Move tool 

Copy mode. 
●​ (Win) Fixed an issue where clicking the Tag visibility button twice would enter 

renaming the tag. 
●​ (Mac) Fixed an issue where textures displayed with an unexpected grid 

pattern when using nicer transparency on an M1 Mac. 



●​ (Mac) Application icon is now the same size as other macOS application 
icons. 

●​ (Mac) Improved the UI styling of the Delete Tag confirmation dialog. 
●​ (Win) Fixed an issue where clicking the Tag visibility button twice would enter 

renaming the tag. 
●​ (Mac) Fixed an issue so that when a row in the Tags panel is selected, the 

tag/folder name and "Default" label in Dashes column will be displayed in 
white to ensure they are more clearly visible. 

●​ (Mac) Fixed a crash that could occur when using an U.S. International -PC 
input keyboard. 

●​ The EULA has been updated with a new set of Trimble's General Product 
Terms. Exceptions to the General Product Terms are specified on 
help.sketchup.com. 

LayOut Release Notes 
Bug fixes / small features added 
DWG Import/Export 

●​ We have updated the DWG Importer and Exporter plugin library for LayOut. 

Stability 

●​ Fixed a crash when inserting a reference file. 
●​ (Win) Fixed a crash that would happen when reloading a SketchUp model. 
●​ (Win) Fixed a crash that could occur when editing a Scrapbook and changing 

pages. 

Miscellaneous 

●​ Fixed a text selection glitch when using the Shift and arrow keys. 
●​ Fixed an issue where there were no highlights when editing line weights. 
●​ Fixed an issue with precision when moving an entity. 
●​ Fixed an issue when a Label associated with an Auto-text entity is moved to a 

different Auto-text entity, the Label will update properly. 
●​ Label coordinates are now based on the axis of a viewport's assigned scene 

or the Last SketchUp View. 



●​ Coordinates can now be pulled from labels pointing to edges and faces, in 
addition to vertices (endpoints, guide points, arc centers). 

●​ (Win) Fixed an error in paper size where the height and width values had 
decimal points. 

●​ (Win) Fixed an issue when an inspector panel was minimized then maximized 
using a shortcut key, the order of the inspectors would change. 

●​ (Mac) Fixed an issue where the line in 'Shape Style' inspector displayed over 
the pull-down menu. 

●​ (Mac) Fixed an issue where a tag line style other than the default would 
display incorrectly. 

●​ (Mac) Fixed an issue where the preferences window 'Close' button did not 
display properly. 

SketchUp API Release Notes 
Apple Silicon support 

We now support universal binaries on macOS that run natively on both Apple 
silicon and Intel-based Mac computers. 

EntitiesBuilder 

We added a new interface, Sketchup::EntitiesBuilder, with the purpose of being able 
to generate bulk geometry with similar speed to Geom::PolygonMesh + 
Sketchup::Entities#fill_from_mesh but with the simplicity and per-entity control that 
Sketchup::Entities offer. This is particularly useful for importers where you can 
expect to see major performance improvements by switching from 
Sketchup::Entities#add_face to Sketchup::EntitiesBuilder#add_face. 

The existing way to add entities (faces, edges, construction geometry, etc) is to 
define a single entity, then add it to the model. The SketchUp engine processes 
each addition separately, performing operations like collision detection between 
the new and the existing geometry, or setting edge properties for every separate 
entity added. The time required to do this is negligible for small operations. But the 
performance degrades quickly once a large amount of geometry (1000+ entities) is 



involved. In internal testing, we found that generating a model with 10K faces is 
over 40 times faster with this new API. For REALLY large operations, with 100,000+ 
faces - SketchUp will now complete operations that previously would have hung the 
application with modest wait times (10-30 seconds). 

We added a Generating Geometry section to the Ruby API Documentation. 

C API Additions and Improvements 

●​ Added SUFaceClearTexturePosition() 
●​ Added SUClassificationsGetNumSchemas() 
●​ Added SUClassificationsGetSchemas() 
●​ Added SUSceneGetDescription() 
●​ Added SUSceneSetDescription() 
●​ Added SUSchemaGetSchemaName() 
●​ Deprecated SUComponentInstanceSaveAs() 
●​ Added SUComponentDefinitionSaveToFile() 
●​ Added SUModelVersion_Current to enum SUModelVersion 
●​ Moved SUModelVersion to new model_version.h header file 
●​ Remove obsolete NamedOptions options provider that never worked 

correctly 
●​ Added a new dll to the LayOut C API package - LayOutUtils.dll 
●​ Added 

LOAutoTextDefinitionType::LOAutoTextDefinitionType_ModelSceneName 
mandatory auto-text type 

●​ Added 
LOAutoTextDefinitionType::LOAutoTextDefinitionType_ModelSceneDescriptio
n mandatory auto-text type 

●​ Added LOAutoTextDefinitionType::LOAutoTextDefinitionType_ModelScale 
mandatory auto-text type 

●​ Added 
LOAutoTextDefinitionType::LOAutoTextDefinitionType_ModelSectionName 
mandatory auto-text type 



●​ Added 
LOAutoTextDefinitionType::LOAutoTextDefinitionType_ModelSectionSymbol 
mandatory auto-text type 

●​ Added LOAutoTextDefinitionType::LOAutoTextDefinitionType_PageCount 
auto-text type 

●​ Added LOAutoTextDefinitionType::LOAutoTextDefinitionType_Sequence 
auto-text type 

●​ Deprecated LOAutoTextDefinitionGetPageNumberStyle() 
●​ Deprecated LOAutoTextDefinitionSetPageNumberStyle() 
●​ Deprecated LOAutoTextDefinitionGetPageNumberStartIndex() 
●​ Deprecated LOAutoTextDefinitionSetPageNumberStartIndex() 
●​ Added LOAutoTextDefinitionGetNumberStyle() 
●​ Added LOAutoTextDefinitionSetNumberStyle() 
●​ Added LOAutoTextDefinitionGetStartIndex() 
●​ Added LOAutoTextDefinitionSetStartIndex() 
●​ Added LOAutoTextDefinitionGetStartPage() 
●​ Added LOAutoTextDefinitionSetStartPage() 
●​ Added LOAutoTextDefinitionGetEndPage() 
●​ Added LOAutoTextDefinitionSetEndPage() 
●​ Added LOAutoTextDefinitionGetIncrement() 
●​ Added LOAutoTextDefinitionSetIncrement() 
●​ Added LOAutoTextDefinitionGetSequenceFormat() 
●​ Added LOAutoTextDefinitionSetSequenceFormat() 
●​ Added LOAutoTextDefinitionRenumberSequence() 
●​ Added missing rendering options DisplaySectionCuts, DrawBackEdges, 

SectionCutDrawEdges, DrawHiddenGeometry and DrawHiddenObjects to the 
SURenderingOptions documentation. 

●​ Removed rendering option FaceColorMode from SURenderingOptions 
documentation. This option was removed from the SDK in SketchUp 2019.1. 

Ruby API Additions and Improvements 

●​ The version of OpenSSL in Ruby was updated to 1.1.1l. 
●​ Added method Sketchup::ComponentDefinition#save_copy 



●​ Added method overload to Sketchup::ComponentDefinition#save_as 
allowing saving as older versions 

●​ Added method Sketchup::Face#clear_texture_position 
●​ Added method Layout::AutoTextDefinition#number_style, Deprecated 

Layout::AutoTextDefinition#page_number_style 
●​ Added method Layout::AutoTextDefinition#number_style=, Deprecated 

Layout::AutoTextDefinition#page_number_style= 
●​ Added method Layout::AutoTextDefinition#end_page 
●​ Added method Layout::AutoTextDefinition#end_page= 
●​ Added method Layout::AutoTextDefinition#start_page 
●​ Added method Layout::AutoTextDefinition#start_page= 
●​ Added method Layout::AutoTextDefinition#increment 
●​ Added method Layout::AutoTextDefinition#increment= 
●​ Added method Layout::AutoTextDefinition#sequence_format 
●​ Added method Layout::AutoTextDefinition#sequence_format= 
●​ Added method Layout::AutoTextDefinition#renumber 
●​ Added Layout::AutoTextDefinition::TYPE_MODEL_SCENE_NAME 
●​ Added Layout::AutoTextDefinition::TYPE_MODEL_SCENE_DESCRIPTION 
●​ Added Layout::AutoTextDefinition::TYPE_MODEL_SCALE 
●​ Added Layout::AutoTextDefinition::TYPE_MODEL_SECTION_NAME 
●​ Added Layout::AutoTextDefinition::TYPE_MODEL_SECTION_SYMBOL 
●​ Added Layout::AutoTextDefinition::TYPE_PAGE_COUNT 
●​ Added Layout::AutoTextDefinition::TYPE_SEQUENCE 
●​ Added method Sketchup::Entities#build 
●​ Added class Sketchup::EntitiesBuilder 
●​ Added method UI::Command#proc 
●​ Added method UI::Command#get_validation_proc 
●​ Added method UI::Command#extension 
●​ Added method UI::Command#extension= 
●​ Added method Sketchup::AppObserver#onExtensionsLoaded 
●​ Added new API to improve extension compatibility with Search, specifically 

for extensions enabled by libraries such as LibFredo. 
(UI::Command#extension= to explicitly associate a command with an 
extension.) 



Ruby Console Improvements 

Earlier versions of SketchUp printed the return values to Ruby Console commands 
different depending on the platform. This has been made consistent following the 
pattern of Ruby's own IRB tool. A side effect of this is that the console now uses 
`.inspect` instead of `.puts` when printing the returned value which makes it less 
ambiguous in many cases. For example `nil` vs `""` that would otherwise print a 
blank line in both cases. 

Ruby API Bug Fixes 

●​ Fixed a bug in UI::HtmlDialog#initialize where max_height and max_width 
were swapped when use_content_size was set to true. 

●​ Fixed a bug where UI::HtmlDialog position was set incorrectly when 
use_content_size was set to true. 

●​ Fixed a bug in UI::HtmlDialog where use_content_size was not persisted 
(when preference_key is set). Due to this bug, in some instances, HtmlDialog 
changed size when it was re-created. 

●​ Fixed "EntityInfo" not being a supported parameter for UI.show_inspector 
●​ Fixed "EntityInfo" not being being listed in UI.inspector_names 
●​ Fixed a bug on Mac where the size and the position of the UI::HtmlDialog 

were not persisted when SketchUp was closed without first closing the 
UI::HtmlDialog window. 

●​ Fixed Sketchup::Face#uv_tile_at could return incorrect values in some edge 
cases. 
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SketchUp Release Notes 

●​ Prevented documents corrupted in a particular way from crashing SketchUp. 
●​ Fixed an issue where increasing or decreasing arc segments required the 

modifier key to be pressed every time. 
●​ Improvements in the Freehand tool when drawing a curve close to existing 

edges. 
●​ Improved closing of an area drawn with the Freehand tool. 
●​ Fixed an issue where internal edges were not always visible when using an 

Intel GPU with Parallel Projection and a standard camera view. 
●​ Change to allow clipping when using the Position Camera tool in Parallel 

Projection. 
●​ Applied updates to the open source credits. 
●​ Fixed SUComponentDefinitionSetName such that it will automatically 

generate a unique name if the given name already exists in the model the 
definition belongs to. 

●​ (Win) Fixed an issue where keyboard input into an extension window would 
activate shortcuts. 

●​ (Win) Fixed an issue where keyboard shortcuts didn't work when Outliner 
was the active window. 

●​ (Win) Fixed an issue involving the deletion and reload of components via the 
Components browser. 



●​ (Win) Fixed an issue where the installer changes the C:\ProgramData folder's 
permissions to allow full access to the entire folder for all users on the 
system. 

●​ (Mac) Fixed an issue where the Name column in Tags would not resize. 

LayOut Release Notes 

●​ Fixed an issue where Auto-Text tags would display an error when a SketchUp 
scene had the Axes Location unchecked. 

●​ Fixed an issue where LayOut would crash when entering an Auto-Text tag 
from the scrapbook or when creating a new custom Auto-Text tag. 

●​ (Win) Fixed an issue where the PageCount Auto-Text tag did not have the End 
Page parameter. 

●​ (Mac) Fixed a crash that would occur when using Window -> Arrange Panels. 

SketchUp API Release Notes 

●​ Fixed a bug where #onKeyDown and #onKeyUp events were being 
inconsistently sent to a Ruby tool when the input focus was inside an 
InputBox 
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What's New in SketchUp and LayOut 2021.0? 
We're rounding out SketchUp's twentieth trip around the sun with several new 
features, improvements, and important changes. As always, we look forward to 
your feedback, and another decade of improving SketchUp. 

Here's what's new… 

New logo icons for SketchUp and its application suite 
 

The red SketchUp logo served us well since 2012. (Do you remember the logo 
before then?) We're moving forward with new marks for SketchUp and its 
application suite. This means new application icons for SketchUp, LayOut, 3D 
Warehouse, Extension Warehouse, and Style Builder, as well as a few modified 
toolbar icons. These new marks align SketchUp to the broader portfolio of Trimble 
products and… they can be modeled in SketchUp! 

We expect that it will take time for people to adjust to the new logos for our 
products. But we're certainly optimistic you'll start to see SketchUp in these new 
marks, and that they will feel 'at home' over time. 

Tag Folders 

We are still keen to make it easier for people who maintain models using large and 
complex lists of tags and scenes. In this release, you can organize multiple tags into 



Tag Folders and control the visibility of folders per scene. Additionally, folders can 
expand and collapse, making it easier to scan your tag structure and find the tags 
you need. 

 
To create tag folders: 

1.​ Select multiple tags in an existing model and click the Add Tag Folder button 
to group them in a tag folder. 

2.​ Or, click the Add Tag Folder button and assign a name to a new tag folder. 
Then select multiple tags, and drag/drop them into a folder. We hope you'll 
try out tag folders with some existing models and also by creating tag 
hierarchies from scratch. 

Tag Folders are also available in LayOut, where the tag tree hierarchy and visibility 
control is available in LayOut's Tags panel. Of course, scenes remember the 
visibility of your tags and tag folders across SketchUp and LayOut. And to 
accommodate models with deeper hierarchies or long tag lists, you can now control 
the width and height of LayOut's Tags panel. 

Tag filtering 
 

A long time coming, we're happy to introduce filtering in SketchUp's Tags panel. We 
hope this makes it a lot easier to zero in on specific tags. You can also use filtering 
when creating tag folders: filter down to a prefix or naming convention, choose 
Select All in the Tag Details menu, and hit the Add Tag Folder button. 

You can also use keyboard selection modifiers to select multiple folders (or tags) 
and set their visibility all at once. To make a custom selection, use the CTRL 
(Command on Mac) and Shift keys to select desired tags and folders. With a tag 
selection in place, click the visibility icon for any tag or folder in your selection: the 
entire selection will respect your visibility change. 

Live Component Configuration 



Live Components are a new breed of parametrically configurable objects, and in 
this release you can control them in SketchUp. 

 
To bring a live component into SketchUp, open 3D Warehouse in SketchUp and 
navigate to our SketchUp Labs Live Component collection (or use the new Live 
Component search filter under advanced search options). Choose a live component 
to tinker with and download it into your SketchUp model! 

Inside SketchUp, when you double-click to edit a Live Component, you'll pull up the 
'Configure Live Component' dialog. Here, you can control the component's 
'parameters'. If you want different configurations of the same object, use the "Make 
Unique" context menu command to create a new definition that can be configured 
separately. If you want to convert a Live Component into a regular component, use 
the "Detach Definition" option. Once you do this, the definition can be edited or 
exploded just like any other component. Notably, you can also insert and configure 
Live Component workflows in SketchUp for Web. 

With SketchUp 2021, we are introducing Live Components with an open beta 
designation we are calling SketchUp Labs. The Labs treatment is meant for features 
that need more user feedback and development, but are stable and useful today. 
Basically, we are explicitly releasing earlier than we might otherwise in order to 
incorporate your feedback as part of our development process. 

Start PreDesign from SketchUp 

Alongside SketchUp 2021, we are also launching a new architectural research tool 
called PreDesign. Available to Pro subscribers, you can launch PreDesign (in a web 
browser) from SketchUp's File menu. 

In PreDesign, you can geolocate a project to understand its predominant and 
seasonal climate, how that climate might affect the comfort and lighting of built 
spaces, and what design strategies may be useful for your project. Think of 
PreDesign as a new way to start architectural design projects in SketchUp. 



 
Under the hood: a re-built .SKP 

SketchUp 2021 brings to light a significant under-the-hood improvement: a re-build 
of the .SKP file format. You are likely to notice a significant reduction in file sizes 
when saving models to the new format, and we're excited about additional 
workflow improvements this new file format will unlock going forward. 

Direct download updates 

As we are releasing more frequent updates to SketchUp, we want to make it easier 
for people to access the improvements we make between 'major' versions. In this 
release, we are introducing a direct download update. This means that the next 
time there is a new version available, you can use this update service to 
automatically download the proper language version. When an update is available, 
you'll receive a notification in SketchUp. You can initialize the direct download 
update at that moment, or defer to a later date. After downloading an update, you 
will be prompted to save and close existing files so that SketchUp can shut down. 
From there, you can install the update to the desired location on your computer. 

Two-finger Pan and Pinch-to-Zoom in LayOut on Mac 

'Enable two-finger Pan' is a new navigation option in LayOut on MacOS (available in 
General preferences). Designed to optimize trackpad use if you don't have a mouse, 
this preference allows you to pan the view using a two-finger swipe on a touchpad. 
If you want to stick with two-finger zooming, you can hold the Command modifier 
key in either state of the preference to switch between Pan and Zoom. Alongside 
this new preference, we've also enabled a pinch-to-zoom gesture. This zoom is 
available whether you choose to pan or zoom with a two-finger swipe. After a round 
of feedback, we are looking forward to bringing this capability to LayOut on 
Windows as well. 

SketchUp Release Notes 
Bug fixes / small features added 
Stability 

●​ Fixed a crash when importing certain .dem files. 
●​ Fixed crashes related to malformed SKP files. 



Tools 

●​ Fixed an issue with Move tool performance when a large number component 
geometry was selected and performance was adversely affected. 

●​ Fixed an issue where the Follow Me tool would not clean up geometry as 
expected. 

●​ Fixed an issue where status bar would not display key modifier text for the 
Select tool. 

●​ Fixed an issue with Tape Measure tool where key-pressing a shortcut caused 
the guide state to unexpectedly change. 

●​ Improved Tape Measure tool messaging to more accurately reflect user 
experience. 

●​ (Win) Fixed an issue where Tape Measure tool would toggle off measure 
mode when Ctrl + Z pressed. 

Model error checking 

●​ Improved SketchUp's 'Fix Problems' capability. By default, SketchUp will no 
longer notify users when problems are found or fixed. SketchUp now always 
fixes problems, and can now fix more problems than it could before. There is 
a new check box option in Preferences > General named "Notify me when 
problems are fixed" which, when checked, will pop up a dialog showing which 
problems were fixed. 

●​ Added a new validity check when invalid component relationships are found. 
●​ Added a new validity check when an invalid font is used for a dimension. 
●​ Added a fix to set the north direction to the green axis when model error 

checking finds the north direction is invalid. 
●​ Fixed an issue where some glued mirrored components were incorrectly 

displaced after fixing model problems. 
●​ Enabled a new validity check when some invalid component relationships are 

found/fixed. 
●​ (Mac) Fixed an issue where the option to Undo Check Validity was not 

available after the validity check that occurs when opening a model. 

Miscellaneous 



●​ Improved Welcome Window performance when loading recent file 
thumbnails. 

●​ Generate Report - A new version of generate report was built for 2021. It is 
available now. The goal is feature parity with the previous version. We expect 
to release improvements and new features over the coming year. 

●​ Removed the Version field from File information in the Model Info window. 
●​ Fixed an issue where the same watermark name cannot be shared by 

different styles. 
●​ Fixed an issue where identical watermarks (e.g., a watermark made by 

making a copy of an existing style) shared watermark properties so that 
editing the properties of one of the watermarks incorrectly changed the 
other. 

●​ Fixed an issue where redo actions in the Edit menu could be lost when 
performing certain actions (e.g., escaping out of a tool). 

●​ Trimble Connect Extension is no longer saving to SketchUp 2016 file format. 
Instead the extension now saves to the format of the SketchUp version 
running the extension. 

●​ Made some minor changes to the Licensing tab, which now reference 
Manage Licensing and contain some UI improvements. 

●​ L10n: Fixed multiple language translation problems. 
●​ Fixed a problem where the translation of the Dimension tool's prefix for 

"Radius" was incorrect for Russian and Korean. 
●​ (Win) Scene Tabs visibility setting is now saved as a user preference. 
●​ (Win) Fixed an issue where a portion of the Delete Tag options dialog was not 

translated. 
●​ (Win) Fixed a problem where the SketchUp installation's "User Account 

Control" screen incorrectly displayed "SketchUp Suite Launcher Unicode" as 
the product being installed. 

●​ (Win) Fixed a problem where the SketchUp uninstaller would not sign the 
user out of their subscription account. 

●​ (Win) The SketchUp installer's "Repair" option has been improved to better 
handle some problems such as incorrect file associations and missing 
thumbnail icons. 



●​ (Mac) Fixed an issue where toolbar icons were sized incorrectly on macOS Big 
Sur. 

●​ (Mac) Fixed a problem with the Ruby Extensions framework that prevented 
linking against the application. If 2019 or before was previously installed, old 
symlinks were inherited. But if 2020 or later was the first version installed 
then builds could be broken. 

LayOut Release Notes 
Bug fixes / small features added 
Stability 

●​ Fixed a crash when opening a LayOut file when the attached SketchUp file 
was missing. 

●​ Fixed a crash that could occur with certain Embedded SketchUp files. This 
was often seen when copying from a Scrapbook. 

Miscellaneous 

●​ Fixed an issue where exporting to pdf would fail with some files containing 
Clipping Masks. 

●​ Fixed an issue where the original selection was not inferencable during 
copy-moves. 

●​ Fixed an issue where the move cursor was not available when locked entities 
were above the selection. 

●​ Added the ability to resize the Tags panel in the SketchUp mode inspector. 
●​ (Win) Fixed an issue where the margins would shift when printing. 
●​ (Mac) Fixed an issue when entering a numeric value to a tag override in the 

Tags dialog. The value would be ignored entering a numeric value then 
selecting OK. 

●​ (Mac) Fixed an issue on the Preferences dialog where text would overlap the 
delete scale button. 

SketchUp API Release Notes 
Upgrade Ruby to 2.7.1 
For SketchUp 2021.0 we have upgraded the version of Ruby that we ship with 
SketchUp from 2.5.5 to 2.7.1. Developers should verify that their extensions are 



working as expected in this new version of Ruby. During this process we have also 
made a change that we are now compiling ruby ourselves during the SketchUp 
build process. It is still vanilla Ruby 2.7.1 that we are compiling. 

New File Format API Accommodations 
SketchUp has done significant work to update the .skp file format (see the Under 
the hood: a re-built SKP section above). This has caused us to reconsider how we 
open files in the APIs. Previously if a .skp file was a newer version than the API being 
used, the file would simply not open. With the new file format, files are supposed to 
be more forward and backward compatible. So opening a file that is newer needs to 
be acceptable. Therefore we have changed the file and definition loading methods 
in the Ruby API and the C API. 

In Ruby we added an additional parameter to the Sketchup#open_file method that 
will allow the API to open newer file formats than the current version of SketchUp 
being used. Sketchup#open_file added a 'with_status' named argument e.g., 
Sketchup#open_file(filename, with_status: true). Sketchup::DefinitionList#load has 
also added the parameter 'allow_newer' to Sketchup::Definition#load(path, 
allow_newer: true). 

In the C API we added three new functions that should now be used to open files. 
These can be made to open newer versions of a skp file than the API, or you can 
choose to not open newer files. The existing functions have been deprecated but 
left in place so as to not break existing functionality. 

Tag Folder API 
Tag folders are a new feature of SketchUp in 2021.0. We have added numerous 
methods around getting, creating, removing, organizing, etc Tag Folders. 

C API Additions and Improvements 

●​ Added SUSkpReadGuid() 
●​ Added SUModelCreateFromFileWithStatus(), Deprecated 

SUModelCreateFromFile() 



●​ Added SUModelCreateFromBufferWithStatus(), Deprecated 
SUModelCreateFromBuffer() 

●​ Added SUModelLoadDefinitionWithStatus(), Deprecated 
SUModelLoadDefinition() 

●​ Added SULayerFolderRef() 
●​ Added SULayerFolderToEntity() 
●​ Added SULayerFolderFromEntity() 
●​ Added SULayerFolderCreate() 
●​ Added SULayerFolderRelease() 
●​ Added SULayerFolderGetName() 
●​ Added SULayerFolderSetName() 
●​ Added SULayerFolderGetVisibility() 
●​ Added SULayerFolderSetVisibility() 
●​ Added SULayerGroupGetVisibleOnNewPages() 
●​ Added SULayerGroupSetVisibleOnNewPages() 
●​ Added SULayerFolderAddLayer() 
●​ Added SULayerFolderRemoveLayer() 
●​ Added SULayerFolderGetNumLayers() 
●​ Added SULayerFolderGetLayers() 
●​ Added SULayerFolderAddLayerFolder() 
●​ Added SULayerFolderGetNumLayerFolders() 
●​ Added SULayerFolderGetLayerFolders() 
●​ Added SULayerFolderGetParentLayerFolder() 
●​ Added SULayerGetParentLayerFolder() 
●​ Added SUModelGetNumLayerFolders() 
●​ Added SUModelGetLayerFolders() 
●​ Added SUModelPurgeEmptyLayerFolders() 
●​ Added SUModelAddLayerFolder() 
●​ Added SUModelGetNumTopLevelLayers() 
●​ Added SUModelGetTopLevelLayers() 
●​ Added SUModelRemoveLayerFolders() 
●​ Added SUSceneGetNumLayerFolders() 
●​ Added SUSceneGetLayerFolders() 
●​ Added SUSceneAddLayerFolder() 



●​ Added SUSceneRemoveLayerFolder() 

Bug fixes / small features added 

●​ Fixed crashes related to malformed SKP files 

Ruby API Additions and Improvements 

●​ Added method signature Sketchup::Page#set_visibility(layer_group, visibility) 
●​ Added method {Sketchup::Page#layer_folders} 
●​ Added class {Sketchup::LayerFolder} 
●​ Added method {Sketchup::Layer#folder} 
●​ Added method {Sketchup::Layer#folder=} 
●​ Added method {Sketchup::Layers#add_folder} 
●​ Added method {Sketchup::Layers#count_folders} 
●​ Added method {Sketchup::Layers#count_layers} 
●​ Added method {Sketchup::Layers#each_folder} 
●​ Added method {Sketchup::Layers#each_layer} 
●​ Added method {Sketchup::Layers#folders} 
●​ Added method {Sketchup::Layers#layers} 
●​ Added method {Sketchup::Layers#purge_unused_folders} 
●​ Added method {Sketchup::Layers#remove_folder} 
●​ Added method {Sketchup::LayersObserver#onLayerFolderAdded} 
●​ Added method {Sketchup::LayersObserver#onLayerFolderChanged} 
●​ Added method {Sketchup::LayersObserver#onLayerFolderRemoved} 
●​ Added method {Sketchup::LayersObserver#onParentFolderChanged} 
●​ Added method {Sketchup.redo} 
●​ Added new method signature to {Sketchup.open_file}: 

Sketchup.open_file(filename, with_status: true) This signature will open the 
new SketchUp file format if the format is newer. 

●​ Deprecated old method signature: Sketchup.open_file(filename) Because 
opening a newer file format might lead to data missing, extension developers 
have to explicitly migrate to the new signature. This is to ensure that no 
extension inadvertently open and save a file without knowing of potential 
data loss. 



●​ Added new method signature to {Sketchup::DefinitionList#load}: 
Sketchup::DefinitionList#load(filename, allow_newer: true) 

●​ Added method Sketchup::Skp.read_guid for reading a model's guid without 
having to open it in SketchUp. 

Ruby API Bug Fixes 

●​ Multiple documentation corrections. 
●​ Fixed Sketchup::Texture#filename such that it appends a file extension 

matching the data format it was loaded from when the internal texture 
filename is missing the extension. 
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SketchUp Release Notes 

●​ Fixed a crash using the Follow Me tool manually following a path to the start 
point of an entity. 

●​ Fixed an issue where a component could not be saved and then saved again 
with a different name. 

●​ Fixed an issue that would prevent certain large files from being opened when 
saved in SketchUp 2021. 

●​ Fixed an issue where section cut planes would remain visible when the 
associated geometry was hidden via a Tag Folder. 

●​ (Mac) Fixed a crash when logged in as a non-admin then accessing the Colors 
palette. 

LayOut Release Notes 

●​ Improved performance when inferencing to SketchUp models. This included 
moving, copying and rotating entities as well as dimensioning and drawing 
on top of SketchUp model viewports. 

●​ (Win) Fixed a crash that could occur when closing LayOut. 
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What's New in 2021.1? 
In any given release, we strive to make SketchUp more reliable, efficient, and 
useful. While we sometimes shy away from changes that may disrupt your 
modeling experience, this release features changes to modeling behavior meant to 
standardize usage patterns across core SketchUp tools. Our goal is to improve the 
consistency of how modeling works from tool to tool, to improve the efficiency of 
individual tool workflows, and to improve the learnability of SketchUp's most 
nuanced behaviors. Read on to learn about the patterns we are trying to establish, 
as well as the impact on individual tools. 

Modifier toggles 
Likely the most explicit change you will notice is that more tool 'modes' behave as 
toggles that can be turned on and off by tapping a key. This means fewer 
press-and-hold modifier interactions (for tools like Scale), as well as -- we hope -- 
more predictable modeling outcomes and more efficient usage across multiple 
tools. 

Modifier persistence 
We are also persisting modifier tool states across multiple operations. This means 
being able to make multiple copies of objects with Move or being able to hide edges 
with Eraser across view changes... without repeatedly hitting modifier keys. 



Eraser's tool mode toggles let you hide edges across camera views without repeatedly 
re-triggering a modifier. 
 

Modifiers will also persist across when you hit Escape to cancel out of an operation. 
Changing tools resets a modified tool to its default state, as will toggling off a 
modifier or hitting a tool's shortcut key. 

Pre-lock inferences 
Many SketchUp tools -- like Rotate, Rectangle, Circle -- already feature the ability to 
'pre-lock' an inference direction or drawing plane. In this release, we are applying 
this pattern to other tools as appropriate. To start, you're now able pre-lock an 
inference direction before the first click with the Line, Tape Measure and Move 
tools. 

Notably, we have not changed the ability to temporarily lock an inference by 
pressing and holding the Shift key. That's one of a few examples where we think the 
existing press/hold keyboard interaction patterns are important to preserve. 

Impact on individual tools 
Line 
The Line tool is now enabled to pre-lock an inference drawing direction. 

Eraser 
Eraser modifiers can now be triggered with a toggle key press and persist across 
multiple click-drag actions. Notably, Eraser is still enabled to work by 
pressing-and-holding a modifier key. So, if you tap the Shift key, you will toggle on 
Hide in a persistent way, and if you hold down Shift, you will enable Hide only until 
you release the key. 

While we were at it, we took the opportunity to enhance the Eraser tool's optional 
modes by adding the ability to unhide geometry using the existing unsmooth mode 
– so, now it's an 'unhide/unsmooth' mode. 



To help facilitate the process of unhiding/unsmoothing stuff, SketchUp now 
automatically makes Hidden Geometry visible when unhide/unsmooth mode is 
activated, and returns to the previous setting for View Hidden Geometry upon exiting 
unhide/unsmooth mode or switching to another tool. 

Additionally, the Eraser tool cursor now provides visual feedback in the form of 
cursor add-ons that indicate the tool's current mode (hide, smooth, or 
unhide/unsmooth). 

Push-Pull 
Push/Pull's modifiers -- Create New Starting Face and Stretch -- are both toggles 
and they persist across multiple interactions. Push/Pull also has a slightly different 
cursor art across its modified states. 

If you're wondering what Push/Pull 'Stretch' is, you will not be alone. Stretch is a 
tool mode that has actually existed in SketchUp for years, but has never been 
referenced in the Status Bar or received distinct treatment in the Push/Pull cursor. 
'Stretching' a face is roughly equivalent to moving the face perpendicular to its 
drawing plane. 

Use Stretch to distort forms (a la Move) without switching tools, selecting entities, or 
locking inferences. 
 
Move 
Both Move tool modifiers -- Copy and Autofold -- now persist across multiple 
moves. This behavior applies to moving pre-selected items as well as to 
'hover-to-select' Move operation. Also, the inference direction can be locked before 
the first click of a move. 

Copy, copy, copy, copy, copy… but only toggle Move: Copy once. 
 
Scale 
Scale tool modifiers -- About Center and Toggle Uniform -- are now toggles and 
persist across multiple operations within the Scale tool. 



Rotate 
The Rotate modifier -- Copy -- now persists across multiple operations. This tool 
mode is also available without pre-selected entities. 

Protractor 
The Protractor modifier -- Toggle Create Guides -- now persists across multiple 
operations. 

Tape Measure 
The Tape Measure modifier -- Toggle Create Guides -- persists across multiple 
operations. If you were paying close attention, this is actually a change we 
introduced in SketchUp 2020.2. Similar to Line and Move, the Tape Measure tool's 
inference direction can be locked before the first click. 

Paint Bucket 
All Paint Bucket modifiers -- Sample, Paint All Matching, Paint All Connected, and 
Paint All on Same Object -- are now toggles. However, the Sample modifier still 
switches back to the Paint Bucket tool after one use. The other modifiers persist. 
Similar to the Eraser tool modifiers, the Paint Bucket modifiers will still work by 
pressing-and-holding a modifier key. 

Status Bar prompts and Instructor updates 
For each tool we've adjusted, we've also updated Status Bar prompts and Instructor 
panel content in order to standardize how we convey useful information about 
each tool. All of the Instructor panel dialogs have been reformatted, but thus far, 
we've only changed Status Bar prompts for the tools whose behaviors have 
changed. More Status Bar prompts will be updated in subsequent releases. 

'Butter-side up' faces 
Alongside improvements to Push/Pull noted above, we are also making a change to 
front face (or 'normal') orientation when drawing stuff in SketchUp. Now, SketchUp 
will always orient faces with the front side facing up, when drawing on the ground 
plane, and with the front face 'facing' the camera in other cases. If a face is drawn 
over the top of an existing face, the new face will still inherit the orientation of the 



face that it is drawn on. With these 'butter-side up' faces, double-click Push/Pull 
operations behave more predictably and push-pull copy operations result in 3D 
meshes that are much more likely to result in correctly oriented faces. Additionally, 
the Follow-me tool will now create extrusions with the front face oriented outward 
in most scenarios. 

Newly traced floor plans -- and lots of other faces -- now extrude with more 
predictable results. 

 
PolygonMesh performance improvement for extensions 
Many SketchUp extensions that either import or create large amounts of geometry 
in a given operation rely on an API class called PolygonMesh. These operations that 
use this class can be very slow depending on the import size or complexity of 
geometry created. In 2021.1, we are introducing an orders-of-magnitude 
improvement to how efficiently SketchUp's API handles PolygonMesh operations. In 
this case, the larger the operation, the bigger the improvement. The good news is 
that most extension developers do not need to do anything different to take 
advantage of this improvement. We expect you'll notice the difference in extensions 
like Artisan, SUbD, Bezier Surface, and Skimp. For more details on how to leverage 
the performance improvements refer to the API documentation. 

A persistent Extensions menu 
The Extensions menu is stepping out into the sun. From here out, this menu 
heading will always be visible, regardless of whether extensions have been installed 
there or not. We've also relocated extension management and developer tools to 
this menu. 

You may be interested to know that we recently published Extension UX Guidelines 
for SketchUp Developers. We want to help developers make extensions that 
function predictably in SketchUp and fit nicely in a user's mental map of our 
application. (That goes for the things we build too!) 

Unit-aware Live Components 



With this release, you can now download Live Component models from 3D 
Warehouse whose parameter units will respect the unit settings of your model. This 
should make it a bit faster to determine the proper parameter input for a Live 
Component while modeling. With a recent update on 3D Warehouse, all Live 
Components in our SketchUp Labs account are now enabled for unit translation. 

The parameters in the Configure Live Component panel respect the unit format of 
your model. Respect! 
We are also introducing a modest improvement to the drawtime of Live Component 
editing. We have more efforts in the works to make Live Component configuration 
more persistent and responsive when working across multiple objects. 

IFC4 Classification and Export 
SketchUp now ships with an IFC 4 schema that you may use to apply classifications 
in Entity Info or with the Classifier tagging tool. And IFC4 is now a supported export 
file type. 

PDF library upgrade for SketchUp and LayOut on Windows 
We've updated the libraries that SketchUp and LayOut use to generate PDF exports. 
Along with this update, we also tried to squash several bugs related to undesirable 
artifacts or effects in exports. 

Type-to-scale input in LayOut 
We zeroed in on a particularly unsatisfying experience in LayOut: scanning a long 
list of scales for the exact one you want, or going on a detour to Preferences to set 
a custom scale. Now, you can simply type in a scale in the Camera tab of the 
SketchUp model panel. This new type-to-input will neaty parse a number of inputs: 
type 1:50, 1” = 50”, 1/50, .02, 2%, or even 6” = 25' will all quickly apply a 1:50 scale to 
a viewport. 

SketchUp Release Notes 
Bug fixes / small features added 
Stability 



●​ Fixed a memory leak in component instance creation. 
●​ Fixed a crash that could occur during a validity check. 
●​ Fixed a crash that could occur when adjusting Live Component settings. 
●​ Fixed a crash that could occur when push/pulling a divided face where one of 

the edges contains a curve that extends past the face. 
●​ Fixed a crash that could occur when closing the Live Component dialog. 
●​ Fixed an issue where SketchUp would crash on exit when the Live 

Component Configuration dialog was open. 
●​ Fixed an issue where having very long names for materials and styles could 

prevent the model from being reopened. 
●​ Fixed an issue where some models created with older versions of the Skalp 

extension could not be saved. Added a new validity check to fix invalid tags in 
this case. 

●​ Fixed a crash that could occur after a copy and paste action in a V-Ray scene, 
if there also was an extension using EntitiesObserver. 

●​ Fixed a crash that could occur when creating a new style from an existing 
style. 

●​ (Win) Fixed a crash that could occur when working in models that have a very 
large number of connected faces - e.g., when exploding complex imported 
CAD files. 

●​ (Mac) Fixed a crash that would occur when right-clicking on a section plane if 
SketchUp was not the app that was in focus. 

●​ (Mac) Fixed a problem where materials in the app bundle that were not 
writeable would cause a crash. 

●​ (Mac) Fixed an intermittent crash that would sometimes occur after signing in 
or adding a license. 

●​ (Mac) Fixed an issue where SketchUp would sometimes intermittently crash 
on close. 

●​ (Mac) Fixed a crash that would occur when quitting Sketchup with two 
modeling windows and the tags dialogs open. 

Tools 

●​ Fixed an issue when using the Push/Pull tool where the status bar would not 
display the correct text after pressing the Esc key. 



●​ Fixed an issue when using the Push/Pull tool where entering a value in the 
Measurements Box while pushing an object would cause the object to 
extrude in the wrong direction. 

●​ Fixed an issue when using the Push/Pull tool where a pre-selected face would 
be deselected after a push/pull operation completed when geometry 
overlapped. 

●​ Modified the Push/Pull tool to always display a positive number in the 
Measurements Box regardless of push/pull direction. 

●​ Fixed an issue when using the Push/Pull tool where a face or object would 
extrude in the wrong direction after entering a value in the Measurements 
Box and double-clicking the mouse to perform multiple extrusions. 

●​ Fixed an issue with the Scale tool where the scale handles would disappear 
when zooming in extremely close on an interior face of a 3D object. 

●​ Fixed an issue where switching the mode for the Push/Pull tool (normal, 
copy, stretch) would show incorrect geometry until the next mouse 
movement. 

●​ Fixed an issue where using the Push/Pull tool in stretch mode on an isolated 
face led to unexpected behavior. 

●​ Fixed several tools whose status bar text did not update until the cursor was 
moved. 

●​ (Win) Fixed a corrupt cursor graphic for the Push/Pull tool copy mode. 

Model Error Checking 

●​ Fixed an issue where validity errors could occur when exporting a model 
using the "Export only current selection" option. 

●​ Fixed an issue where a validity error could occur due to a missing persistent 
ID when performing a push/pull operation on a face with a dividing line. 

●​ Fixed an issue where persistent ID validity errors would not be fixed after 
performing Undo Check Validity and Redo Check Validity. 

●​ Fixed an issue where creating a component containing a face with a curve as 
an edge could result in a validity error / displaced geometry. 

●​ Added a validity check to fix an issue where sketchy edges could become 
shared between the active style and another style which would cause a 
crash. 



●​ Implemented a setting in the SketchUp Preferences to enable or disable 
automatically fixing model errors, similar to the preferences setting that 
could be found prior to SketchUp 2021.0. This setting is enabled by default, 
and the option to notify when problems are fixed is not enabled by default. 
Even though validity checking will not be performed when this option is 
disabled, some models may still encounter errors while trying to save or 
auto-save. In these rare instances, the user will be presented with a dialog 
box asking if they would like SketchUp to resolve the errors and complete the 
save operation or if they would prefer to cancel the save operation without 
fixing any issues. 

Tags 

●​ Fixed an issue so that when the Untagged tag is selected, the Delete Tag item 
in the Details menu is disabled. 

●​ (Win) Fixed an issue where renaming a tag that was nested in a folder using 
the single click method on a selected tag, the rename would be rejected. 

●​ (Win) Fixed an issue where the Tag Group name was not truncated in the 
name column. 

●​ (Win) Fixed an issue in the Tags dialog where the horizontal scroll bar would 
not appear in some instances. 

●​ (Win) Fixed an issue where scrolling through a large number of tags would 
not display all available tags. 

●​ (Win) Fixed an issue in the Tag Dialog where long tag names ran into the 
color swatch. 

●​ (Win) Fixed an issue where a tagged folder could not be deleted. 
●​ (Mac) You will no longer be able to edit a Tag name in the Entity Info Tag 

dropdown. This is intended to prevent Tag names from inadvertently being 
changed when looking up a tag or invoking a tool via a keyboard input. 

●​ (Mac) 'Untagged' Tag is now located at the top of the Entity Info dialog tag 
dropdown box. 

Importing/Exporting 

●​ Fixed an issue where you could not export just your selection to our 3D 
export formats when in a component edit. 



●​ Fixed an issue where Export Selection was not working. 
●​ Fixed an issue when importing a modified component where a non-unique 

instance of the original component was created. 
●​ (Win) Fixed an issue when exporting to PDF where languages that read Right 

to Left would not display properly. 
●​ (Win) Fixed an issue where exporting a model containing Chinese characters 

to PDF would remove or distort the text. 

Installing/Upgrading 

●​ Fixed a problem with the Autoupdate dialog, where the Remind Me Later 
button remained during download. 

●​ Improved the wording of errors that occur when attempting to install 
SketchUp on a 32-bit machine or when there is insufficient disk space (less 
than 2GB) to install. 

●​ (Win) Fixed an installer problem where previously-installed languages were 
not pre-populated in the language selection window when upgrading. 

●​ (Win) Fixed an issue where the SketchUp installer would fail with an error 
saying that LayOut was still running, even though it wasn't. 

●​ (Win) Fixed a problem where a warning was not shown when attempting to 
install an older version of SketchUp on top of a newer one. 

●​ (Win) Fixed a problem where installing SketchUp Viewer on a system that did 
not have SketchUp installed failed to create file associations and thumbnails. 

●​ (Win) Fixed an issue where uninstalling SketchUp Viewer did not remove 
associated files from the Program Files folder. 

●​ (Win) Installation of SketchUp Viewer will now create a ViewerInstallShield.log 
file in the same location as the Viewer installer. 

●​ (Win) Fixed a problem where minor upgrades did not retain Recent files in 
the Startup and Taskbar right-click menus. 

Localization 

●​ Fixed a problem where some of the template units were not localized 
because they were using the singular version of length units. 

●​ Fixed an issue where truncation occurred for Scene details in Spanish. 
●​ Fixed several incorrect localized language translations. 



●​ The Swedish localized version has been re-translated. If you are a Swedish 
customer, please take a look at the new translations. 

Licensing 

●​ Addressed an issue to distinguish between Education (EDU) trial licenses and 
Commercial trial licenses in the Welcome Window licensing tab. 

●​ (Win) Updated a date reference in the error message thrown when entering 
an invalid classic license. 

Miscellaneous 

●​ We have upgraded our Chromium Embedded Framework (CEF) to version 88. 
●​ Fixed an issue where clipping could occur in large models when working at 

the edge of the model's extents. 
●​ Fixed an issue where after configuring a Live Component, the thumbnail in 

the Components Browser did not reflect its current state. 
●​ Fixed an issue where, after making a component unique, the definition name 

of the original component was suggested as the pre-filled file name in the 
Save As dialog. Now, when a component is made unique, the Save As dialog 
will suggest the unique definition name as a pre-filled file name. 

●​ Fixed an issue so that SketchUp applies the default material to objects when 
the Import Materials option is unchecked. 

●​ Fixed a problem where Outliner changed size depending on the entities 
selected. 

●​ Improved draw-time performance of Live Component configuration once the 
configuration panel has already loaded 

●​ Fixed the meaning of a label by renaming the Use Background Color 
checkbox to Override Fog Color. 

●​ Fixed an issue where an “Internal Error” dialog could pop up when using 
various Ruby plugins. 

●​ (Win) Fixed an issue where renaming a Tray by changing case failed. 
●​ (Win) Fixed an issue where duplicate templates would show in the Welcome 

Window. 
●​ (Win) Fixed an issue where the active thumbnail in the component browser 

did not update when editing a component. 



●​ (Win) Fixed a problem to ensure the removal of unused webhelper 
processes. 

●​ (Win) Fixed an issue where inserting a 3D Warehouse model into the current 
model, then choosing "no" from the options dialog, causes the model to not 
be inserted and the user is presented with the option to save the model as a 
separate .skp file. 

●​ (Win) Fixed an issue where the Classifier dialog controls did not position 
properly in high dpi. 

●​ (Win) Fixed a problem where .skp files created by SketchUp 2021 did not 
show thumbnails. 

●​ (Win) Fixed an issue where Tags and Scenes were not displayed properly 
when downloading from Trimble Connect. 

●​ (Mac) Fixed the “Make Component” button tooltip. 
●​ (Mac) Fixed an issue when dragging an image in “Customize Toolbar” where 

the cursor would display offset on BigSur. 
●​ (Mac) Fixed an issue where the Entity Info dialog could shrink when cycling 

between entity types. 
●​ (Mac) Fixed an issue to allow applying a style when changing scenes. 
●​ (Mac) Fixed an issue where the 3D Warehouse tooltip did not display 

correctly when mousing-over the icon in the 'Large Tool Set.' 

Known Issues 

●​ When doing a minor version upgrade to SketchUp 2021.1 (from 2021.0 or 
2021.0.1) you will be signed out and will need to sign in again after the 
upgrade is complete. The fix for this issue will take effect on the next minor 
release after 2021.1. 

LayOut Release Notes 
Bug fixes / small features added 
Zoom Extents 

●​ We have improved Zoom Extents so that all created or pasted geometry will 
now display. Now if you Draw, Move or Copy geometry that goes outside 
current page size, Zoom Extents will display that geometry. 



Stability 

●​ Fixed an issue where Vector or Hybrid renders could take a long time to 
render and extra lines could display when exporting to .pdf. 

●​ Fixed an issue where invalid dimensions would cause a crash when opening 
LayOut. 

●​ Fixed an issue where creating a label then Move and Copy then multiple or 
divide caused LayOut to crash. 

Miscellaneous 

●​ Fixed an issue where the scene properties would not carry over to LayOut 
when the "Properties to Save" checkboxes were unchecked in SketchUp's 
Scenes dialog. 

●​ Fixed an issue where the Tag Scale or Width would hold an edited value 
when canceled. 

●​ Fixed an issue where the scale of the viewport was not being set when 
importing a metric AutoCAD file. 

●​ Fixed an issue where the SketchUp Model viewport would not scale when the 
viewport was changed. 

●​ Fixed an issue with Export to DWG so that non-grouped text and tables both 
now show up on the layer they originated from. 

●​ Fixed an issue where the text and dimension text did not show up when 
exporting to raster images. 

●​ Added a context menu for editing a Group, Dimension, Label, Path or Table. 
●​ Fixed an issue when a Custom Scale has been assigned to a SketchUp model 

viewport, that the viewport could display the incorrect scale. 
●​ Fixed an issue where the translation to Japanese for 'Ortho' checkbox in the 

SketchUp model panel was improperly translated. 
●​ Fixed an issue where strings in the toolbar menu would not display the 

correct string for other regions with the English language. 
●​ (Win) Fixed an issue where Sketchup Viewport magnification would not retain 

changes when altering magnification settings. 
●​ (Win) Fixed an issue where the minimum size of the SketchUp Model 

Inspector would not dynamically update. 



●​ (Win) Fixed an issue so dialogs perform as expected after modifying regional 
settings. 

●​ (Win) Fixed an issue where the Sign In account in the toolbar could get out of 
sync with the Help menu. 

●​ (Win) Fixed an issue where the SketchUp Model inspector would be in the 
collapsed state upon startup. 

●​ (Win) Fixed an issue when exporting to PDF or images the correct number of 
pages was not exported. 

●​ (Win) Fixed an issue where the 'untagged' tag was not translated for 
non-english languages in LayOut. 

●​ (Mac) For speed improvements, now all imported PDF's are converted to a tiff 
file vs. constantly converting it to vector. 

●​ (Mac) Fixed an issue where when Printing or editing Page Setup would 
display the previous page size and not the document's current size. 

●​ (Mac) Fixed an issue where the model would crash when 'Tabloid template' 
ranges for max and min were out of range. 

●​ (Mac) Fixed an issue when dragging an entity from the Scrapbook, the 
preview would display upside down. 

●​ (Mac) Fixed a problem where exported PDF files were extremely large on 
Mac. 

●​ (Mac) Fixed a problem where the text in the SketchUp Model inspector 
dropdown was slightly obstructed. 

SketchUp API Release Notes 
Improvements to UV Mapping - Ruby and C API 
There has always been a gap in the API around projected materials. We've added 
new methods to make it possible to set projected textures. See the API docs for 
further information regarding how to use these new API features. 

C API Additions and Improvements 

●​ Added SUMaterialWriteToFile() 
●​ Added SUModelLoadMaterial() 
●​ Added SUFaceGetUVTileAt() 



●​ Added SUFaceIsTexturePositioned() 
●​ Added SUFaceIsTextureProjected() 
●​ Added SUFaceGetTextureProjection() 
●​ Added SUFaceClearTextureProjection() 
●​ Added SUFacePositionMaterial() 
●​ Added struct SUMaterialPositionInput 
●​ Added SUGeometryInputFaceSetFrontMaterialByPosition() 
●​ Added SUGeometryInputFaceSetBackMaterialByPosition() 
●​ Changed SUEntitiesFill such that it will apply a textured material to faces even 

if the 
●​ SUMaterialInput or SUMaterialPositionInput have no UV coordinates. In this 

case the material will be applied similar to how 
SUFaceSetFrontMaterial/SUFaceSetBackMaterial behaves. 

●​ Added SUModelGetBehavior() 
●​ Added SUModelSetBehavior() 
●​ Added SUEdgeReversedInFace() 
●​ Added SUCurveIsPolygon() 
●​ Added struct SUEntitiesParent 
●​ Added SUEntitiesGetParent() 
●​ Added SUEntitiesGetActiveSectionPlane() 
●​ Added SUEntitiesSetActiveSectionPlane() 
●​ Added SUImageGetDefinition() 
●​ Deprecated SUImageGetName() 
●​ Deprecated SUImageSetName() 

Bug fixes/ Additional Improvements 

●​ Fixed SUGroupGetDefinition() not returning SU_ERROR_OVERWRITE_VALID 
when trying to overwrite a valid reference. 

●​ Fixed SUEntityGetNumAttributeDictionaries() such that it returns a count that 
matches what SUEntityGetAttributeDictionaries() will actually return. 

●​ Fixed crash in SUImageGetImageRep() when Image lacks a texture. 

Ruby API Additions and Improvements 
Upgrade Ruby to 2.7.2 



For SketchUp 2021.1 we have upgraded the version of Ruby that we ship with 
SketchUp from 2.7.1 to 2.7.2. 

Notable bug-fix in Ruby 2.7.2 is correcting a bug that prevented profiling tools such 
as ruby-prof from reporting correct results. Now you can use SpeedUp with 
SketchUp 2021.1 to profile your extensions. 

Improvements to HtmlDialogs 

We improved the UI::HtmlDialog class by working on a number of bugs and feature 
requests reported to us in our GitHub API Issue Tracker project. We made setting 
the dialog focus to be more consistent across Window and Mac platforms, as well 
as adding the ability to set focus back to the SketchUp window. We also added 
some missing getters for window size and position, and we made it possible to set 
the window size based on the size of the HTML content, instead of the outer frame. 
This way you don't need to worry about the window padding that might be added 
by different systems, you can set the window size based on the size of your content 
and SketchUp will size the outer frame correctly. 

CEF Upgrade to Version 88 

We worked to upgrade the internal version of Chromium Embedded Framework 
that we ship. We are now using CEF 88. This affects all of the HtmlDialog class HTML 
windows. To help make it easier to check what CEF version is active inside of 
SketchUp, we also added two new Ruby constants to help quickly identify the 
embedded CEF and Chromium versions. 

PolygonMesh Speed Improvements 

Geom::PolygonMesh is now faster when looking up points in large meshes. This 
also improves performance when adding points to large meshes. Note that the 
mesh needs to be created with an estimated total number of points for this 
performance improvement to kick in. The lookup of points for large meshes are 
now O(logN) instead of O(N^2). 

Ruby Console Improvements 

●​ The Ruby Console now remembers its visibility between sessions. 



●​ The Ruby Console was moved from the Windows menu to the new Developer 
menu. 

●​ Upgraded OpenSSL to 1.1.1k 
●​ Upgraded CEF (used by UI::HtmlDialog) to version 88. 
●​ Added method UI::HtmlDialog#get_position 
●​ Added method UI::HtmlDialog#get_size 
●​ Added method UI::HtmlDialog#get_content_size 
●​ Added method UI::HtmlDialog#set_content_size 
●​ Added method Sketchup.focus 
●​ Added constant UI::HtmlDialog::CEF_VERSION 
●​ Added constant UI::HtmlDialog::CHROME_VERSION 
●​ Added method Sketchup::Face#clear_texture_projection 
●​ Added method Sketchup::Face#texture_positioned? 
●​ Added method Sketchup::Face#texture_projected? 
●​ Added method Sketchup::Face#uv_tile_at 
●​ Added method overload to Sketchup::Face#position_material allowing 

projected materials to be applied. 
●​ Added method Sketchup::DefinitionList#import 
●​ Added method Sketchup::Group#glued_to 
●​ Added method Sketchup::Group#glued_to= 
●​ Added method Sketchup::Image#glued_to 
●​ Added method Sketchup::Image#glued_to= 
●​ Added method overload to Sketchup::ComponentInstance#glued_to= 

allowing to glue to groups images, and components. 
●​ Increased display time for UI::Notification to 10 seconds. 
●​ Add a separator when a menu is added for the first time to a top level menu. 

This creates a visual distinction between built-in menus and that of 
extensions. 

●​ Added support for adding submenus to the Developer menu. 

Ruby API Bug Fixes 

●​ Fixed crash when passing invalid parameters to 
Sketchup::Model#drawing_element_visible? 



●​ Fixed UI::HtmlDialog#bring_to_front on Mac, such that calling the method 
sets focus on the HtmlDialog. This makes the behavior of the method 
consistent with that on Windows. 

●​ Fixed UI::HtmlDialog#set_size and UI::HtmlDialog#set_position on Windows, 
such that calling the methods doesn't set the focus on the HtmlDialog. This 
makes the behavior of the method consistent with that on Mac. 

●​ Fixed UI::HtmlDialog#set_can_close Mac implementation so that the callback 
provided can properly prevent the window from closing. 

●​ Fixed crash in Sketchup::Image#image_rep when the Image lacks a texture. 
●​ Add link to licensing API example in API docs. 
●​ Fixed UI.show_model_info not showing the chosen page on Mac. 
●​ Fixed UI.show_model_info not supporting English page names on localized 

build on Mac. 
●​ Prevent UI::Notification from being garbage collected for as long as it has 

notifications open. This would previously cause a crash when the notification 
was assigned to a local variable. 

●​ Fixed crash that could occur when creating multiple Layout::SketchUpModel 
objects that refer to the same underlying SketchUp file, where hidden 
entities were tracked by one or more scenes. 

●​ Leaving SketchUp::Face.set_texture_projection in for one more release. Next 
release it will be removed. This API functionality was always broken. If you 
used this method, migrate to the new API methods for projected textures. 

Bug fixes/ Additional Improvements 

●​ Update C API Documentation with better information on how to link against 
the SDK binaries. 

●​ Fixed GUID not being regenerated when component definition is edited 
●​ Fixed Crash when Sketchup::Materials#load given relative file path on 

Windows. 
●​ Removed restrictions on some deprecated C APIs to allow them to load 

models with a more recent SketchUp version than the SDK. 
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SketchUp Release Notes 

●​ Fixed a security vulnerability. 
●​ Fixed issue when double clicking on tag add button caused a crash. 
●​ Fixed issue where assigning two objects that are on different tags, to a 

non-existent tag, causes a crash. 
●​ Fixed issue where installation of extensions with submenus could cause a 

crash. 
●​ Fixed issue where using the Follow Me tool on a reversed face could cause a 

crash. 

LayOut Release Notes 

●​ (Win) Fixed an issue where indented text would result in incorrect font height 
in a PDF export. 

SketchUp API Release Notes 

●​ Fixed issue with global SketchUp object in HtmlDialogs. 
●​ Fix YARD documentation bugs. 
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What’s new in 2021.1.2? 
In this intermediate release, we are addressing important feedback from the 
SketchUp 2021.1 release and fixing issues that should not remain broken longer 
than necessary. 

The first notable change is that we are cleaning up the interference of shortcuts on 
tool mode states on Mac versions of SketchUp. Now (as on Windows), using custom 
hotkeys or default shortcuts (like Undo or Select All) should not change tool 
modifiers in a majority of cases. 

Another undesirable outcome of our 2021.1 release was the persistence of the 
Move tool’s Copy mode across multiple operations. We decided to address this pain 
point while also acting on a feature request to make the persistent Copy mode 
more efficient. For starters, after placing a Copy, the Move tool will revert to its 
default state. 

What about the persistent copy mode? Based on feedback, we have determined 
that making multiple copies is a different enough workflow to warrant a new 
modifier mode for the Move tool called Stamp Copy. When stamping, each click will 
produce a copy. Stamp Copy can be used with relative moves and also inference 
locking. To activate Stamp, press the Copy modifier key twice before the first click of 
a Move operation. Once you start moving an object, Stamp is not available. 



The other behavior change in this update is that Scale tool modifiers can now be 
operated as either persistent toggles or single-use press-and-hold modifiers. To the 
extent possible, we do feel it is important to offer tool modifiers as toggles without 
forcing people to unlearn years of SketchUp muscle memory. 

In addition to these changes, we’ve also fixed several important bugs, noted below. 

SketchUp Release Notes 
Bug fixes/ Additional Improvements 

●​ Fixed an issue where a very large model would silently fail to save. An error 
will now be displayed to help prevent data loss. A permanent fix for these 
rare failures will be included in an upcoming release. 

●​ Fixed an issue where Context Menu items would “gray out” after a period of 
time on Windows. 

●​ Fixed an issue where icons were not appropriately spaced when opening a 
model on the Mac with Big Sur OS. 

●​ Updated our infrastructure for Live Components. While the behavior of Live 
Components is not changing now, in the near future, these changes will allow 
us to improve Live Component load time and fluidity of use between 
components. If you haven’t tested Live Components recently, you can browse 
and test the new Live Components that we’ve been introducing in SketchUp 
Labs throughout this year. 

Known issues 

The following are known issues that we are currently planning to fix in later 
releases: 

●​ When stamping with raw geometry on raw geometry, there are cases where 
the originally copied geometry may deform as a result of intersecting 
geometry. We intend to fix this in an upcoming release. 

●​ In Stamp mode, Measurements Box input for distance and arrays is not yet 
enabled. If you’d like to use the Measurements Box while making a copy in 
Stamp, you may hit the copy modifier key twice to enter standard 
Move/Copy. 

https://3dwarehouse.sketchup.com/collection/b78de4f7-ec5f-4531-89df-7c016a5b9af4/Live-Components-by-SketchUp-Labs
https://3dwarehouse.sketchup.com/collection/b78de4f7-ec5f-4531-89df-7c016a5b9af4/Live-Components-by-SketchUp-Labs


●​ On Mac, shortcuts that use two keys (like Shift + Command) may still result in 
a tool mode change. On Windows, only Eraser and Paint Bucket modifiers are 
impacted by dual key shortcuts. 

LayOut Release Notes 
Bug fixes / small features added 

PDF Export 

●​ (Win) Fixed an issue where font spacing could be incorrect when using 
superscript or subscript fonts. 

●​ (Win) Fixed an issue where exported List Text was not exported correctly. 
●​ (Win) Fixed an issue where Wingding fonts would not export. 

SketchUp API Release Notes 

●​ Fixed grayed out menu entries, as mentioned above. While technically not an 
API issue, having numerous extensions installed made this more visible. 
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What's New in SketchUp 2020.0? 
We've spent a lot of time in 2019 learning more about what you, the user, wish 
SketchUp did better. We've been eyeing your comments on the forum and 
discussing ideas during our training events to see what trips up your workflow. So, 
thanks for speaking up! You helped us discover how you're using SketchUp and 
how we can improve your design process, resulting in workflow improvements 
galore! They're so good you'd think we'd been sneaking into design firms or 
something :). 

Now, let's get to the good stuff... 

SketchUp Desktop 2020: your [3D] creative space 
This year, we focused on data structures and modeling behaviors. We want to make 
sure we continue to be the more intuitive, easier to use software that boosts your 
ability to crank out those stunning design projects. 

Outliner 
This leads us to our BIG model organization change. In an effort to increase model 
performance, you no longer have to create Layers upon Layers. You can do your 
main model organization straight within Outliner. We recommend using this (and 
our friendly eyeball icon) to toggle between the major chunks of your model. 



Another bonus: Groups and components that are hidden by tag (formerly known as 
layers) now show up in the outliner. 

Grips on bounding boxes and automatic transparency 
Grab that sofa and put it in the corner! Just try it out, we need not explain more. 

Selected groups and components now display grips on the bounding box corners, 
allowing for quick and accurate placement. If you'd rather grab the midpoint, center 
or centroid of the object, press the down arrow to cycle through the available grip 
points. 

When you grab a point in an object and start to move it, your object will 
automatically go transparent as soon as something in your model interferes with 
the object you are moving. This works with both the Rotate tool and Move tool. 
Fancy, huh? This will literally ‘transform' your workflow. Don't take our word for it: 
start positioning those objects in hard to reach places to see that SketchUp magic! 

Hidden objects 
Announcing a big change to hiding objects in your models! You'll notice in your 
drop-down menu that we decoupled hiding objects from hiding geometry. How will 
this change your workflow? Well, this will give you the ability to better manage 
hidden geometry and hidden objects for an even easier modeling experience. For 
example, let's say you want to edit hidden edges in a landscape or smoothed 
surface, but you still want to be able to hide objects that are nearby (like trees, 
bushes, or a building)... yes you can do that in SketchUp! Landscape architects, 
rejoice! 

The SketchUp Universe: Nomenclatures 
After many conversations, we decided to update some of our naming conventions. 
This won't change your workflow, but we want you to know that it's not just you — 
we are talking about a few things differently now. We think they make logic a little 
more prevalent. 



Objects are now a collective term for: groups, components, dynamic components 
and Section Planes. This just means we don't have to say "groups (slash) 
components" anymore. Now you can save those syllables for words like 
"stupendous" and "dapper" (Why, thank you! We think you are too.). Also, Layers 
are now referred to as "Tags". 'Layer' has been a rather unintuitive thing to call this 
organizational utility. Most new users with experience in Photoshop (and LayOut!) 
are disadvantaged by calling them layers, since it implies a 2D stacking order. 

Don't worry these two terms are merely document naming conventions and won't 
hinder your workflow. 

What's New in LayOut 2020.0? 
It's all about taking back control...document control that is! For LayOut, we focused 
on improving the interaction between SketchUp & LayOut to save you time and 
[brain] energy. Way less going back and forth updating scenes in SketchUp to 
ensure your drawing comes out perfectly, now you have more editing ability right in 
LayOut. 

 
Model Views 
LayOut now understands a lot more about your SketchUp model and what you've 
overridden. Meaning, you can safely change a style or camera angle directly in 
LayOut without accidentally losing your changes (winning!). How do you know 
what's different in your LayOut viewport versus your SketchUp model, you ask? 
When you make changes in LayOut, parts of the menu bar will go dark gray, alerting 
you that you've made an override. Don't worry, just because you made some 
changes in LayOut, doesn't mean you're stuck with those. You can always resync 
your viewports back to your SketchUp model if you need to. 

Customization 
Take those LayOut docs to the next dimension with different models and views. If 
you have one SketchUp model that exists across several viewports, you can now 
relink just one of those viewports to another SketchUp model. Previously, you 



would need to delete that viewport, insert a new SKP model, and reset all your scale 
settings and viewport sizing. More efficient now? Yes! 

And that's not all folks! You also have the ability to toggle tag visibility — straight in 
your LayOut doc! What does this mean for your workflow? This means you don't 
have to create extra scenes just for your LayOut files, saving you a ton of time going 
back and forth between LayOut and SketchUp. 

New SketchUp Installers 
What's New? 
We are now using a different technology to install SketchUp, LayOut, Style Builder, 
Viewer, and Checkup. 

●​ If you are online when running the installer, you can now use a single 
installer file that will download selected languages at the time of installation. 

●​ If you will be offline when running the installer, you can download the 
"offline" installer which contains all supported languages. 

●​ English will be installed by default for everyone. 
●​ Rerunning the installer will allow you to add or remove languages. 
●​ To install on macOS, double-click on the large SketchUp icon in the installer 

dialog box. 

Network Administrators can also perform a "silent installation" (similar to the MSI 
option from previous versions) when adding SketchUp to multiple computers 
across the network. You can learn more about how to install here. 
SketchUp Pro 2020 Installer 

●​ All SketchUp-supported languages can now be installed using a single 
installer file, rather than a separate installer for each language. 

●​ You must be connected to the internet when running this installer for 
localized languages. Languages selected in the installation dialog will be 
automatically downloaded and installed (in addition to English). 

●​ Installation of Czech and Polish can only be done using the "offline" version 
of the installer. 



SketchUp Pro 2020 Offline Installer 

●​ An offline installer is also available. This is an installation file that contains all 
languages bundled together, and is a much larger file. After it has been 
downloaded to your system, it can be used to install, add or remove 
languages even when you are not connected to the internet. 

Known issues with the installers 

●​ (Win) The installer may fail with a message saying that the "COM Surrogate" 
application must be closed prior to installing SketchUp. Restart your system 
to resolve this problem. 

●​ (Win) Right-clicking on a .skp file may show incorrect "Open with" options if 
previous versions of SketchUp have been installed on your system. 

SketchUp Release Notes 
Bug fixes / small features added 
Performance 

●​ Improved the performance of the Components dialog. 
●​ (Win) Improved performance when opening a file, allowing model interaction 

much quicker than before. 
●​ (Win) Improved the performance of the Materials dialog. 
●​ (Win) Improved the performance of the Tags (formally the Layers dialog). 
●​ (Win) Improved the performance of the Scenes dialog. 
●​ (Win) Improved the performance of the Styles dialog. 
●​ (Win) Improved the performance when opening large models with the 

Outliner dialog open. 
●​ (Win) Improved the performance unhiding a group of tags with the Outliner 

dialog open. 
●​ (Win) Improved the performance of creating a component in a model 

containing many components. 
●​ (Win) Overall performance improvement when editing objects via the 

Outliner. 

Stability 



●​ Fixed a crash that could occur during DAE export. 
●​ Fixed an issue where the context menu would become incomplete and 

unresponsive with certain tools. 
●​ (Win) Fixed an issue where SketchUp would sometimes hang when moving 

the Tags tray after making hundreds of scene transitions. 

Tools 

●​ Fixed an issue where you could lose sight of the geometry you are orbiting 
around in a component with large extents. 

●​ Fixed an issue where zooming could be too sensitive when zooming inside of 
a component. 

●​ Fixed an issue where a concave half circle offset incorrectly. 

Outliner 

●​ Updated the Outliner user interface, adding a visibility icon and removing 
horizontal and vertical lines. 

●​ Added the ability to toggle the visibility of Objects. 
●​ Added the ability to identify the Tags visibility state on Objects. 
●​ Added the ability to "Show Hidden Tags" via a context menu. 
●​ Added the ability to rename via a double click on name. 
●​ (Mac) Changed the selected color in the Outliner hierarchy. 
●​ (Mac) Fixed an issue where the Outliner content would jump when 

performing actions via the context menu. 

Materials 

●​ (Win) Fixed an issue where imported materials were duplicated when 
copied/pasted. 

●​ (Mac) Fixed an issue where the color of a material in the material browser 
was always black. 

●​ (Mac) Fixed an issue where adding transparent material with the Paint Tool 
duplicated material. 

●​ (Mac) Fixed an issue where painting with a duplicated material incorrectly 
applied the original material. 



●​ (Mac) Fixed an issue where Materials -> Selecting a color did not set the 
material as active. 

●​ (Mac) Fixed an issue where copy/paste duplicated materials. 

Visibility 

●​ Separated View > Hidden Objects and View > Hidden Geometry options. 
●​ Subcomponent and subgroup visibility state is now saved per scene, instead 

of across all scenes. 

Miscellaneous 

●​ Added new unit types (Yards, Gallons, Liters) and Area and Volume precision 
fields in the Units section of the Model Info dialog. 

●​ Fixed an issue where the Fractional dimension unit would display an 
incorrect unit when greyed out. 

●​ Updated the colors of the Simple Style used in templates and included in the 
Default Styles library. 

●​ Fixed an issue where renaming a scene caused multiple parentheses to be 
added to the scene name. 

●​ Fixed an issue where changes to a scene name would not be retained if the 
user used a mouse-click to navigate to another scene name (instead of using 
Tab). 

●​ Changed the insertion point of a component to be more predictable - it is 
always the component origin. 

●​ Improved consistency in SketchUp's Export Options dialog titles. 
●​ Combined the Animation format menu items into one dialog. 
●​ Removed support for exporting animations in avi, webm, and ogv file 

formats. The only supported video file format is now mp4. To create lossless 
animations, export png files and utilize a 3rd party tool to assemble the 
images into a video. 

●​ Provided updates to renewal messaging. 
●​ Fixed an issue that resulted in edges being incorrectly turned off when 

clicking on a style with a hidden line face style with edges off. 
●​ Fixed an issue where guides within components could disappear when 

zooming out. 



●​ Added a new set of Inference icons. 
●​ Fixed an issue where the URL for File > Trimble Connect > Launch Trimble 

Connect was incorrect. 
●​ Removed the Photo Texture option on the Location toolbar. 
●​ Added a message to indicate when you have been automatically signed out 

of your SketchUp account. 
●​ Fixed an issue where a renamed scene tab was not updated in the Scene 

details. 
●​ Corrected a problem where changes to the Model Info Units were not 

reflected in the Entity Info window. 
●​ Enlarged the Length field label in the Model Info > Units dialog to prevent 

translated strings from being truncated. 
●​ Fixed several incorrect translations in localized languages. 
●​ (Win) Fixed an issue where a SketchUp 2018 folder was created in the 

AppData Roaming and Local folders, when SketchUp 2019 was launched. 
●​ (Win) Fixed an issue where the Line Styles' dashes dropdown was too narrow. 
●​ (Win) Fixed a SketchUp Checkup issue where it incorrectly reported the 

current. version of OpenGL when there is an OpenGL requirement error. 
●​ (Win) Fixed problems that displayed error messages related to the 

installation of Microsoft Visual C++ 2017 Redistributables. 
●​ (Mac) Fixed an issue where imported PDFs appeared as black rectangles on 

macOS Catalina. 
●​ (Mac) Updated the BugSplat library. As a result, the BugSplat dialog now 

appears when SketchUp is re-launched after a crash. 
●​ (Mac) Fixed an issue where SU was incorrectly prompting to open a 

recovered, auto-save model. 
●​ (Mac) Fixed an issue where the large and small icon toolsets did not have the 

same set of tools. 
●​ (Mac) Fixed an issue when using Color by Tag then changing the Tag color 

would invoke the Paint Tool. 
●​ (Mac) Fixed an issue where the Fonts dialog was missing the text alignment 

buttons. 

LayOut Release Notes 



Bug fixes / small features added 
Miscellaneous 

●​ Fixed an issue where a raster rendered viewport would require a re-render 
after exporting to PDF. 

●​ Fixed an issue when exploding a dimension would display the autotext 
brackets < > and not the distance value. 

●​ Added a small feature to support SketchUp's new Area and Volume unit type 
settings (Yards, Liters and Gallons) in LayOut. When these new units are used 
in SketchUp and brought over to LayOut, they are now available in the 
auto-text tag applied to Areas and Volumes. 

●​ Applied updates to the titles and strings for the LayOut Export Options 
dialog. 

●​ Fixed an issue where a black background could appear on Scrapbooks. 
●​ Added a preference to disable edit mode of a SketchUp Model Viewport. 
●​ Fixed an issue where strange lines could appear on a PDF export. 
●​ (Win) Fixed an issue where the document setup dialog could get stuck in an 

open state when adjusting the paper size or margins when using metric units 
with Russian builds. 

●​ (Mac) Fixed an issue where the Undo / Redo and Escape would become 
disabled after inserting a file in LayOut on macOS Catalina. 

SketchUp API Release Notes 
What's New? 
Improvements were made to the SketchUp C API in multiple areas 

●​ Implemented the Layers to Tags name change in the APIs 
●​ Added SUModelIsDrawingElementVisible 
●​ Added SULayerSet/GetSceneBehavior 
●​ Added SULengthFormatterGet/SetAreaPrecision 
●​ Added SULengthFormatterGet/SetVolumePrecision 
●​ Added SUModelGetEntitiesByPersistentIDs 
●​ Added SUModelGetLayersByPeristentIDs 
●​ Added the correct return codes for SUSceneAddLayer and 

SUSceneRemoveLayer 



●​ Ensure the header file for SUApplicationGetActiveModel is included in the 
SDK package 

●​ (Added SUSceneSetDrawingElementHidden and 
SUSceneGetDrawingElementHidden to adjust element visibility in scenes. 

●​ (Win) SUModelSaveToFile updated to handle saving files 2GB and above. 

Bug fixes / small features added 

●​ Fixed an issue where there was a performance bottleneck in SUEntitiesFill 
●​ Fixed an issue where UV mapping a face via the APIs could fail unexpectedly 
●​ Added AreaPrecision and VolumePrecision to the OptionsProvider Interface 
●​ Fixed SketchUpModelImporterInterface::ShowOptionsDialog to return the 

correct type for the MacOS API. This update was previous done in SketchUp 
2019.2, API 7.1 for the Windows API. 

●​ Adjust page visibility function of drawing elements to match desktop 
behavior UI in limiting nested elements. 

Ruby API Additions and Improvements 

●​ Added Geom.tesselate that takes a set of loop points and return triangle 
sets. 

●​ Added optional :normals parameter to Sketchup::View#draw allowing 
polygons to be drawn with lighting. 

●​ Added ability to draw textured polygons with Sketchup::View#draw and 
Sketchup::View#draw2d 

○​ Added optional :uvs and :texture parameters to Sketchup::View#draw 
and Sketchup::View#draw2d. 

○​ Added Sketchup::View#load_texture. 
○​ Added Sketchup::View#release_texture. 

●​ Added ability to vertically align text drawn with Sketchup::View#draw_text. 
New option parameter:vertical_align can be set to one of the following 
values: TextVerticalAlignBoundsTop, TextVerticalAlignBaseline, 
TextVerticalAlignCapHeight or TextVerticalAlignCenter. 

●​ Added Sketchup::View#text_bounds, returning the bounding box of the area 
SketchUp uses to draw text using Sketchup::View#draw_text. 



●​ Added Sketchup::Model#active_path= to allow the API to open an instance 
path for editing by the user. 

●​ Added new unit constants: 
○​ Length::SquareYard 
○​ Length::CubicYard 
○​ Length::Liter 
○​ Length::USGallon 

●​ Added AreaPrecision and VolumePrecision 
toSketchup.active_model.options["UnitsOptions"] 

●​ Additional entity types now return PIDs for Sketchup::Entity#persistent_id: 
○​ Sketchup::Layer 
○​ Sketchup::LineStyle 

●​ Added Sketchup::Layer#display_name - this will return "Untagged" for layer0 
while the old layer.name will continue to return "Layer0". 

●​ Deprecated Sketchup::ComponentDefinition#insertion_point and 
Sketchup::ComponentDefinition#insertion_point= as this feature was 
removed in SketchUp. It now returns the origin of the definition and the 
setter is now a noop. 

●​ Added an extra return code for SUSceneAddLayer() and 
SUSceneRemoveLayer(). 

●​ Added Sketchup::Page.get_drawingelement_visibility and 
Sketchup::Page.set_drawingelement_visibility to pages to adjust element 
visibility in scenes. 

Ruby API Bug Fixes 

●​ Fixed model validation where it incorrectly flagged some valid UV mapping as 
invalid and reset it. 

●​ Fixed an issue where Materials created via the Ruby API would get duplicated 
when applied 

●​ (Win) Restored the missing Racc Ruby library 
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What's New in SketchUp 2020.1? 
As we've said in the past, we take feedback from our users seriously. That's why we 
are excited to announce our 2020.1 release. For this release, we gathered some of 
your feedback and polished up existing features with exciting additions and 
improvements that will have your workflow beaming with pride. Explore all the 
greatness below. 

Freshening up SketchUp Pro 
Scenes Panel 
Now that you have better toggling visibility with hidden geometry and objects, we 
decided to take it a step further. We split up hidden geometry and objects so you 
can save them separately on a Scene-by-Scene basis. You will see a new checkbox 
in the Scenes panel that lets you save the visibility state of hidden objects. This 
gives you better visibility control per Scene. 

Section Planes & Scenes 
Keeping with the Scene theme, you can now save Section Plane visibility per Scene. 
Why? Since Section Planes are grouped with objects, we want to make sure they 
behave like objects in terms of visibility per Scene. Before this change, only top-level 
visibility for Section Planes could be saved per Scene. Again, more control in your 
Scenes — and consistency. Winning! 



Hidden Objects are now Editable 
Good news...hidden objects are now editable. What does this mean, you ask? When 
you select a hidden object in the Outliner, instead of completely disappearing when 
you try to edit your object, it will appear as a mesh so you can more easily make 
edits. So keep on keeping on without any hinders to your editing workflow. 

Improvements to Grips 
A small, but powerful feature: you can now use the Rotate tool when toggling 
through ALL Grips — just like the Move tool! This provides more consistency 
between the tools so you can stay focused on your project. 

Empty Objects 
Picture this: you are working up a new table design and quickly add a lamp to make 
it look more realistic — but you run into an issue! You did it too fast and forgot to 
group your lamp and table separately. Because of this, everything is glued together 
as one, creating editing issues galore and wasted time. Fear no more! Now, you can 
right-click on an empty space and make a grouped object or component from 
scratch. No more triple-clicking, or drawing it elsewhere just to place it where you 
want it. And, an added bonus! When you create a new object from scratch, a 
window will pop up allowing you to name it right from the start. Say hello to better 
model organization from the very start of your project. Talk about speeding up your 
workflow! 

Improvements in LayOut 
Performance Improvements 
For this release, we focused on improving LayOut's selection and deletion 
capabilities---they're now much faster! And don't worry: we're still committed to 
even more performance improvements in future releases. 

But, that's not all… we also made some slick improvements to the Select Tool. 

Improved Select Tool 



The Select Tool just got some major love. We wanted to help you make intentional - 
not accidental - moves with your crossing and window selection workflows. Now, 
when you click-drag to create a crossing or window selection, you won't mistakenly 
move anything! Previously, you may have accidentally moved an object when you 
really just wanted to change your selection. Now you're more likely to get the result 
you wanted. Also, selections and moves now occur when clicking on the actual 
object as opposed to the object's bounding box, strengthening that intentional 
workflow. 

If you're now wondering, "how do I move an object?" - no worries, we got you 
covered. Just pre-select an entity and move from there. 

SketchUp Release Notes 
Installers 

●​ To support Mac notarization requirements, the SketchUp installer is now 
being distributed as a .zip file instead of .dmg.To use this, after downloading 
the installer double-click the .zip file in Finder to extract the installer .app 
file.Next, double-click the .app file to launch the installer. 

Bug fixes / small features added 
Stability 

●​ Fixed an issue where reloading a component and then saving the reloaded 
component under a different name would cause a crash and would corrupt 
the saved component file. 

●​ Fixed a crash that could occur when changing from Share Component to 
Share Model and then uploading a model to 3D Warehouse. 

●​ Fixed an issue where StyleBuilder would sometimes crash when closing the 
EULA dialog. 

●​ Fixed an issue where the Move/Copy tool using 'From Point' or 'rotate grip' 
caused SketchUp to crash when hovering on the copied component and 
changing the distance. 



●​ (Mac) Fixed an issue where SketchUp would crash when resetting the 
workspace when the Tags or Fog dialogs were open. 

●​ (Mac) Fixed an issue where some Export Options dialogs would cause 100% 
CPU utilization. 

●​ (Mac) Fixed an issue where clicking in a blank portion of Outliner would 
sometimes cause a crash. 

●​ (Mac) Fixed an issue where the offline version of the installer would fail to 
install an L10n language when an Internet connection could not be made to 
the download server, even though the user chose to "Install Anyway." 

Grips on bounding boxes and automatic transparency 

●​ Changed the key that cycles through grip types from the Down arrow key to 
'Alt' on the PC and 'Command' on the Mac. 

●​ Fixed an issue where an obscured point on a component behind a section 
plane would unexpectedly become transparent. 

●​ Fixed an issue where geometry could display unexpected transparency on 
Move/Copy when moving copied geometry around the model. 

●​ Fixed an issue with Rotation tool when an ‘Active point' was obscured and 
transparency did not engage. 

●​ Fixed an issue where the Move tool rotate grips could not always be easily 
found due to favoring grips. 

●​ Fixed an issue where lines could disappear when moving a component via 
grips when "Use sun for shading" was turned on. 

●​ Fixed an issue where unexpected transparency could occur when hovering 
over grips with the Move and Rotate Tools in some models with Parallel 
Projection. 

●​ Fixed an issue where the Icon for an obscured grip displayed incorrectly for a 
component or group. 

●​ Fixed an issue where the origin inference did not display for some 
components. 

●​ (Mac) Fixed an issue where geometry could become unexpectedly 
transparent when inserting a library component from the Components 
browser. 



Visibility 

●​ Improved the style thumbnail to reflect that hidden objects are activated. 
●​ Fixed an issue where copying and pasting hidden subcomponents in scenes 

would cause the pasted hidden subcomponents to become visible. 
●​ Fixed an issue where deeply nested hidden subcomponents could become 

visible after importing them. 
●​ Changed the wording of Hidden Geometry menu items under the View 

menu. 
●​ Fixed a geometry visibility issue with tags and root geometry where every tag 

has visible Top-Level Geometry and the Level 0 tag is in the hide state with 
flag View>Hidden Geometry on. 

Outliner 

●​ Fixed an issue preventing a visibility change of multiple selected objects. 
●​ Fixed an issue in Outliner where clicking a visible subcomponent wouldn't 

show its hidden geometry as visible if its top parent component was hidden. 
●​ (Win) Fixed an issue preventing a multi-select in the Outliner if the Shift key 

was depressed before a selection was made. 

Miscellaneous 

●​ Fixed an issue where the Area and Volume Display Precision fields did not 
display the comma separator. 

●​ Fixed an issue on the Scenes panel where the tooltips associated with 
checkbox labels for scene update properties were inaccurate. 

●​ Fixed an issue where the "Edit > Make Component" menu was not enabled 
when a group was selected. 

●​ Fixed an issue where the Make Component button was not always enabled 
when a group was selected. 

●​ Fixed inconsistent behavior when pressing a shortcut for Make Component 
with a component selected. 

●​ Improved the Welcome Window warning message when license files are 
copied to another machine. 



●​ Fixed an issue where an intersecting line drawn through a polygon caused 
the offset tool to improperly draw the offset. 

●​ Fixed an issue on the Welcome Window where the Unit type was not 
localized. 

●​ Made a change to remove empty components when saving a model as they 
can cause crashes and other bad behaviors. 

●​ Changed a reference from Layers to Tags in the Merge With Hidden warning. 
●​ Fixed an issue where the Undo menu item was titled Undo Edit Material 

instead of Undo Tags. 
●​ Fixed an automated sign-in message box so it does not fall behind the main 

application window. 
●​ Modified the workflow of the Welcome Window to prevent the possibility of 

getting stuck on the licensing page when using the Manage License button. 
●​ Fixed an issue where the automatic sign out event would take the user to the 

browser sign in page instead of the Welcome Window sign in page. 
●​ Added a trials troubleshooting link to the Your 30-day Trial Is Over screen. 
●​ Fixed an issue where the saving a component would orient the camera in the 

saved component file to always be a top view. 
●​ Fixed several issues with incorrect or missing localized language translations. 
●​ Fixed several problems that could occur when upgrading to a new version of 

SketchUp. 
●​ Fixed an issue where the text orientation on dimensions was not correct 

when exporting to 3D DWG. 
●​ (Win) Fixed an issue where the sort order of the Visible column was incorrect 

in the Tags dialog. 
●​ (Win) Fixed an issue where the "Make Component" shortcut did not work 

when a group was selected. 
●​ (Win) Fixed an issue where the Match Photo dialog was cut off on high 

resolution displays. 
●​ (Win) Fixed an issue where the Scenes browser could not be resized in List 

view. 
●​ (Win) Fixed an issue where the text for Default Tray was not being translated. 
●​ (Win) Fixed an issue where the Tags dialog would re-populate and re-draw 

slowly. 



●​ (Win) Fixed an issue where the Tags toolbar text would become truncated 
when using High DPI monitors. 

●​ (Mac) Fixed an issue where users could not view or edit sketchy edge settings 
in the Styles browser. 

●​ (Mac) Fixed an issue where the default menu keyboard shortcuts for 'Make 
Group' and 'Make Component' behaved incorrectly when a group was 
selected. 

●​ (Mac) Fixed an issue to ensure the Options dialog at the bottom of the Import 
dialog is displayed by default. 

●​ (Mac) Fixed an issue where changes to the Tags toolbar were not being 
applied to the selected entity. 

●​ (Mac) Fixed an issue where changes made in the Tag toolbar were not 
updated in the Entity Info dialog. 

●​ (Mac) Fixed an issue where clicking the Open Source Credits button didn't 
open the credits window. 

●​ (Mac) Fixed an issue that prevented the full display of 6 digits of precision 
and the units in the Extruded field. 

●​ (Mac) Fixed an issue where installing SketchUp with localized languages 
caused the End User License Agreement dialog to be translated into the first 
of the localized languages instead of English. 

●​ (Mac) Fixed an installer problem where translated language names were not 
sorted correctly on the Selected Languages and Select Languages screens. 

●​ (Mac) Fixed an installer issue where the Selected Languages screen was not 
large enough to include all possible languages, and no scroll bar was 
provided. 

●​ (Mac) Fixed an issue in (System Preferences/Language & Regions 
setting/Advanced with Grouping and Decimal) settings did not pass settings 
appropriately to SketchUp. 

●​ (Mac) Fixed an issue where DWG Import did not have metric units listed in 
the Units drop down menu. 

●​ (Mac) Fixed an issue where Import would unexpectedly switch to Use As 
Image. 

●​ (Mac) Improved error reporting for Mac installation failures. 



Known Issues 

●​ (Win) If both SketchUp and the Checkup utility are installed on a system, 
uninstalling Checkup will prevent SketchUp from running. This problem can 
be remedied by reinstalling either SketchUp or Checkup. 

●​ (Mac) If the installer is launched while a previous version of SketchUp is still 
running, the installer will freeze, even after closing the SketchUp app that 
was running. 

●​ (Mac) When the Mac system is set to a non-English language, and some 
localized languages were previously installed, the SketchUp 2020.1 installer 
may not always pre-select the correct languages when upgrading from the 
previous version. 

LayOut Release Notes 
Bug fixes / small features added 
Performance Improvements 

●​ Selection performance has increased by only populating inspectors after a 
window or crossing selection has finished. 

●​ Performance has been increased when deleting entities. 

Miscellaneous 

●​ Fixed an issue where dimension and text arrowheads were larger than 
expected with inserted SU model on high dpi monitors. 

●​ Fixed an issue where a "\" (backslash) suffix would display in inspectors when 
using Decimal Inches on localized versions of LayOut. 

●​ Fixed an issue linking a SketchUp model to a different SketchUp model would 
not update the SketchUp model inspector. 

●​ Fixed an issue where a Raster rendered viewport would not export to .dwg if 
the viewport or layer was locked. 

●​ (Win) Fixed an issue where the document setup dialog could get stuck in an 
open state when adjusting the paper size or margins when using metric units 
with Russian builds. 



●​ (Win) Fixed an issue where Zoom to Page would zoom to some arbitrary page 
size. 

●​ (Mac) Fixed an issue where exported PDFs sometimes appeared washed out. 
●​ (Mac) Fixed an issue entering unicode characters into text boxes. 
●​ (Mac) Fixed an issue where the scale dropdown would display behind other 

dialogs on the Pattern Fill inspector. 
●​ (Mac) Fixed the strange artifacts that would show up at certain zoom levels. 
●​ (Mac) Fixed an issue where certain page numbers would get truncated in the 

Page inspector. 

SketchUp Desktop Viewer Release 

●​ We are not releasing a 2020.1 version of Viewer on either Windows or Mac. 
But don't worry! Models created by SketchUp 2020.1 can be viewed with the 
2020.0 version of Viewer. 

SketchUp/Layout API Release Notes 
What's New? 
Weld a set of continuous edges functionality was added 
This functionality was added to both the C API and the Ruby API. 

Bug fixes / small features 

●​ SketchUp crash reading a SKP file created using 
SUSceneSetUseRenderingOptions 

●​ Changed LOImageSetClipMask to allow the clip mask entity to be 
SU_INVALID, indicating that we will remove any existing clip mask from the 
image entity 

●​ Fixed LOImageSetClipMask to return SU_ERROR_UNSUPPORTED instead of 
SU_ERROR_GENERIC when attempting to use an entity other than an 
LOPathRef, LORectangleRef, or LOEllipseRef 

●​ Changed LOSketchUpModelSetClipMask to allow the clip mask entity to be 
SU_INVALID, indicating that we will remove any existing clip mask from the 
SketchUpModel entity 



●​ Added an error code SU_ERROR_NO_DATA to 
LOConnectionPointCreateFromPID if the persistent id could not be found in 
the model 

C API Additions and Improvements 

●​ Added SUEntitiesWeld 
●​ Added SULineStyleGetColor 
●​ Added SULineStyleSetColor 
●​ Added SUSceneGetUseHiddenGeometry 
●​ Added SUSceneGetUseHiddenObjects 
●​ Added SUSceneSetUseHiddenGeometry 
●​ Added SUSceneSetUseHiddenObjects 
●​ Added SULineStyleToEntity 
●​ Added LOGridSetMajorSpacing 
●​ Added LOGridSetMinorDivisions 
●​ Added LOGridSetMajorColor 
●​ Added LOGridSetMinorColor 
●​ Added LOGridSetShow 
●​ Added LOGridSetShowMajor 
●​ Added LOGridSetShowMinor 
●​ Added LOGridSetPrint 
●​ Added LOGridGetInFront 
●​ Added LOGridSetInFront 
●​ Added LOGridGetClipToMargins 
●​ Added LOGridSetClipToMargins 
●​ Fixed bug in LOLinearDimensionGetDimensionTextCopy where the display 

text of the copy returned the plain text instead 
●​ Fixed bug in LOAngularDimensionGetDimensionTextCopy where the display 

text of the copy returned the plain text instead 
●​ Added LOSketchUpModelGetCameraModified 
●​ Added LOSketchUpModelResetCamera 
●​ Added LOSketchUpModelGetEffectsModified 
●​ Added LOSketchUpModelResetEffects 
●​ Added LOSketchUpModelGetStyleModified 



●​ Added LOSketchUpModelResetStyle 
●​ Added LOSketchUpModelGetLayersModified 
●​ Added LOSketchUpModelResetLayers 
●​ Deprecated SUSceneGetUseHidden 

○​ Replaced by SUSceneGetUseHiddenGeometry and 
SUSceneGetUseHiddenObjects 

●​ Deprecated SuSceneSetUseHidden 
○​ Replaced by SUSceneSetUseHiddenGeometry and 

SUSceneSetUseHiddenObjects 

Ruby API Additions and Improvements 

●​ Added Sketchup::Entities#weld 
●​ Added Sketchup::Page#use_hidden_geometry= 
●​ Added Sketchup::Page#use_hidden_geometry? 
●​ Added Sketchup::Page#use_hidden_objects= 
●​ Added Sketchup::Page#use_hidden_objects? 
●​ Deprecated Sketchup::Page#use_hidden? 
●​ Added Layout::Grid#major_spacing= 
●​ Added Layout::Grid#minor_divisions= 
●​ Added Layout::Grid#major_color= 
●​ Added Layout::Grid#minor_color= 
●​ Added Layout::Grid#show= 
●​ Added Layout::Grid#show_major= 
●​ Added Layout::Grid#show_minor= 
●​ Added Layout::Grid#print= 
●​ Added Layout::Grid#in_front? 
●​ Added Layout::Grid#in_front= 
●​ Added Layout::Grid#clip_to_margins? 
●​ Added Layout::Grid#clip_to_margins= 
●​ Fixed bug in Layout::LinearDimension#text where the display text of the copy 

returned the plain text instead 
●​ Fixed bug in Layout::AngularDimension#text where the display text of the 

copy returned the plain text instead 
●​ Added Layout::SketchUpModel#camera_modified? 



●​ Added Layout::SketchUpModel#reset_camera 
●​ Added Layout::SketchUpModel#effects_modified? 
●​ Added Layout::SketchUpModel#reset_effects 
●​ Added Layout::SketchUpModel#style_modified? 
●​ Added Layout::SketchUpModel#reset_style 
●​ Added Layout::SketchUpModel#layers_modified? 
●​ Added Layout::SketchUpModel#reset_layers 
●​ Fixed issues with Layout::SketchUpModel#current_scene and 

Layout::SketchUpModel#current_scene_modified? Unexpectedly raising an 
assert stating that "The most recently selected scene no longer exists" 

●​ Layout::Document#export documentation fixed 
●​ Layout::SketchUpModel#render documentation fixed 
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Version​
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LayOut Release Notes 

●​ This is a Windows only update to fix a frequent crash that occurred with 
users on the positive side of the UTC time standard (for example UTC+01:00). 
This crash would occur due to an error encountered when converting some 
local times to UTC when reloading a SketchUp file then saving. 
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What's New in SketchUp 2020.2? 
In SketchUp Pro 2020.2, we are introducing some improvements based on 
longstanding user feedback. Some changes are straightforward 
enough—Weld!—while others are new concepts to explore in SketchUp and 
LayOut. 

Weld Edges 
In 2020.1, we introduced API functionality to weld edges in SketchUp. If you aren't 
aware, extension developers previously had to do some wacky stuff to perform a 
weld operation. Looking forward, we hope to see this improve the performance for 
individual extensions. In 2020.2, Weld Edges is a native capability for SketchUp 
users as well. The new command is contextual to a selection of edges, available in 
the right-click context menu, from within the Edit menu, and available as a shortcut 
as well. Learn more about the new Weld functionality. 

Linear inference toggle for the Line Tool 
You can now turn off linear inferencing while using the Line tool. To give it a go: 
activate the Line tool, start drawing a line, and hit the Alt (Windows) / Command 
(Mac) modifier key to toggle off directional inferencing. SketchUp will now ignore all 
linear—red, blue, green, magenta—inferences. Hit the toggle again and the only 
inference you'll snap to is Parallel/Perpendicular (magenta). One more tap, and you 
are back to standard inferencing. Without changing toggles, arrow key inference 



locks are still available, so you can jump from no inferences to a specific one pretty 
quickly. Learn more about the new Line Tool inference toggling. 

Line style 'overrides' for Tags in LayOut 
You can now control the edge width, scale, color, and stipple pattern for SketchUp 
tags in LayOut. This means that by applying tags in SketchUp, you can control the 
style of your linework in LayOut… without stacking multiple viewports. To get going: 
select a viewport in LayOut, open the SketchUp Model inspector dialog, and expand 
the Tags panel. Now, click on the line style of a tag to pull up styling options. For 
tags without a line style applied, click 'Default' to pull up the styling options. 

We call these changes to the styling of tags 'overrides' because they persist across 
model reference updates. Once you set line styles for various tags in a model 
viewport, you shouldn't have to repeat the exercise. Click 'Reset' to return to the 
viewport to its default styling. Learn more about the new Line Style override 
behavior in LayOut. 

LayOut selection and transformation improvements 
Good LayOut documents are an arrangement of viewports, images, vector graphics, 
labels… everything just so. As pages get more complex and documents get longer, 
operating on selections gets slower. In 2020.2, we are introducing some slight but 
significant modifications to LayOut's selection and transformation behavior that 
should improve the experience of moving, copying, and scaling selections in larger 
projects. The key difference is that LayOut now previews your transformation, 
instead of drawing it in real-time as you are manipulating a selection. Learn more 
about the new view transformations in LayOut. 

Mac Installer 
Installation of SketchUp on Mac is simpler with this release! Here are the changes 
you will see: 



●​ The installer has been reverted back to DMG format. It is no longer 
distributed as a .zip file, but rather as a .dmg file as it was prior to version 
2020.1. 

●​ The installer is launched by double-clicking the downloaded .dmg file. This 
opens a Mac installation window where you simply drag the SketchUp icon to 
the Applications folder. 

●​ That's it! You are no longer presented with language selection dialogs 
because all localized SketchUp languages are bundled in a single installer file, 
and they all will be installed automatically. 

●​ This also means we no longer have separate "Online" and "Offline" installers 
for Mac. So an internet connection is not required for installing SketchUp on 
Mac. 

●​ These changes only apply to macOS platforms, not Windows. 

  

Windows Installer 
The SketchUp installer for Windows has been modified to not allow changes to 
language selections or the destination directory when upgrading from one version 
of SketchUp 2020 to another. If such changes are needed, you will need to first 
uninstall the previous version and then run the SketchUp 2020.2 installer, 
specifying the desired languages and/or directory. 

You can download the SketchUp 2020.2 Installer here. 

SketchUp Release Notes 
Bug fixes / small features added 
Stability 

●​ Fixed a crash that could occur when copy/pasting geometry onto a midpoint. 
●​ Fixed a crash that could occur with the Offset tool when using the Select All 

shortcut. 
●​ (Win) Fixed a crash that could occur when accessing the Outliner when it has 

not been completely populated. 



●​ (Win) Fixed an issue where pressing the Escape key while the 3D Warehouse 
dialog was loading components would cause SketchUp to freeze. 

Model Display 

●​ Fixed an issue where you could see clipping when using parallel projection in 
some models. 

●​ Fixed an issue where components with dark colors did not always display as 
expected when hovering over an obscured bounding box grip with Move or 
Rotate. 

●​ Fixed an issue where opaque materials would not always appear transparent 
when hovering over obscured bounding box grips. 

●​ Fixed an issue where section planes could fail to hide when editing a 
component with 'Hide Rest of Model'. 

●​ Fixed an issue where active section planes within a component could become 
inactive in all scenes when reloading a component. 

UI 

●​ Fixed an issue where the UI of some extensions sometimes drew with a 
hatched pattern when View > Hidden Objects was on in models with faster 
transparency. 

●​ Improved the phrasing in the dialog that appears when removing a Tag. 
●​ Updated the copyright symbol in the SketchUp and Viewer Help > About 

dialogs. 
●​ (Win) Fixed an issue that occurred when selecting a new sort column in the 

Tags dialog, where the Tag sort order was not sorting according to the 
previous sort order. 

●​ (Mac) Fixed an issue where the Options text box would not fully display the 
translated text. 

●​ (Mac) Fixed an issue where the “Please don't show this again” checkbox was 
rendered behind text in the Name Section Plane dialog. 

●​ (Mac) Fixed an issue where localized text was truncated in the Preferences 
dialog. 

Install 



●​ Fixed problems with upgrading SketchUp Viewer from a previous version. 
●​ (Win) Fixed an issue that occurred when both SketchUp and the Checkup 

utility were installed on a system, and an uninstall of Checkup was done. This 
prevented SketchUp from running. 

●​ (Win) Fixed an issue where uninstalling the Checkup utility would corrupt 
SketchUp. 

●​ (Win) Fixed an issue where uninstalling SketchUp would also uninstall 
Checkup. 

●​ (Win) Fixed an issue where a custom installation directory was not retained 
when upgrading. 

●​ (Mac) Fixed a problem where the SU 2020.1 installer would freeze if a 
previous version of SketchUp was running at the same time. 

●​ (Mac) Fixed an issue that occurred when the Mac system was set to a 
non-English language, and some localized languages were previously 
installed, but the SketchUp 2020.1 installer did not always pre-select the 
correct languages when upgrading. 

Miscellaneous 

●​ Improved the Measure tool when using the Control (Win) and Option (Mac) 
modifier keys to persist the modifier key behavior until selecting another 
tool. 

●​ Fixed a performance lag that could occur when turning on shadows in some 
models. 

●​ Fixed an issue where Outliner would not populate when doing a Rotate / 
Copy of a Component or Group. 

●​ Fixed an issue to make sure the "preserve origin" option works correctly 
when importing a DWG file from the User Interface and with the Ruby 
Console. 

●​ Improved the “Check models for problems” behavior to find more issues, 
especially related to persistent IDs. 

●​ Fixed issues with incorrect or missing JA and zh-CN language translations. 
●​ (Win) Fixed an issue where the ALT key function would interrupt the workflow 

of the Rotate tool when cycling through component grips. 



●​ (Win) Addressed a performance problem where the Entity tag listing was slow 
to change tag names with a large amount of tags. 

●​ (Mac) Fixed an issue where the user could not update components' advanced 
attributes. 

LayOut Release Notes 
Bug fixes / small features added 
Stability 

●​ (Win) Fixed an issue where the active view could appear frozen when 
attempting a middle mouse pan with the Pan tool active. 

●​ (Win) Fixed a crash that would occur when exiting the “Welcome to SketchUp” 
window via the task bar. 

●​ (Mac) Fixed an issue where the active view could appear frozen when using a 
combination of a trackpad zoom and mouse pan. This would require 
zooming out to refresh the window. 

●​ (Mac) Fixed a crash on launch when a users region setting is set differently 
then their actual location. 

●​ (Mac) Fixed a crash that could occur when launching LayOut. 
●​ (Mac) Fixed a crash when rendering certain Fonts. 

Performance Improvements 

●​ (Win) Fixed an issue where the SketchUp model panel could 'jump' when 
modifying the visibility of a Tag or multiple Tags. 

●​ (Win) Improved performance when toggling the visibility of many tags at 
once. 

Miscellaneous 

●​ Addressed an issue preventing you from editing a clipping mask object 
without first 'releasing the clipping mask'. 

●​ Fixed the SketchUp Model Inspector so that it updates correctly when making 
a Group or Ungrouping entities. 

●​ Addressed an issue when multiple viewports, where the Line Scale from one 
of the viewports would be applied to all. 



●​ Fixed an issue when joining lines in a certain order would create random 
shapes. 

●​ Fixed an issue where exporting to PDF would fail with certain geometry. 
●​ Fixed an issue where the correct cursor would not display during a path 

manipulation. 
●​ Fixed an issue where the original Tag state would be retained when copying a 

SketchUp model viewport. 
●​ Fixed an issue where the tab key could not be used to navigate Tag line style 

options. 
●​ (Mac) Corrected the tooltips for Dashes Scale and Stroke Width as they were 

backwards. 
●​ (Mac) Improved the Shape Style Inspector dash pattern rendering. 

SketchUp/LayOut API Release Notes 
Ruby API Additions and Improvements 

●​ Added scope filter to Sketchup::Model#find_entity_by_persistent_id 

API Exchange Interface 
To allow better interoperability of the Ruby API and C API within the SketchUp 
application we introduced the ability to exchange entities and image reps between 
the APIs. 

Entities because it's a key type and ImageRep because it can be an expensive object 
to copy. 

●​ Added SUEntityToRuby 
●​ Added SUEntityFromRuby 
●​ Added SUImageRepToRuby 
●​ Added SUImageRepFromRuby 

C API Additions and Improvements 

●​ Added SUSelectionRef 
○​ Added SUModelGetSelection 



○​ Added SUModelGetActiveEntities 
○​ Added SUModelGetActivePath 
○​ Added SUSelectionAdd 
○​ Added SUSelectionRemove 
○​ Added SUSelectionToggle 
○​ Added SUSelectionClear 
○​ Added SUSelectionInvert 
○​ Added SUSelectionGetNumElements 
○​ Added SUSelectionGetEntityList 
○​ Added SUSelectionIsType 
○​ Added SUModelGetEntitiesOfTypeByPersistentIDs 
○​ Deprecated SUModelGetLayersByPersistentIDs 
○​ Deprecated SUModelGetEntitiesByPersistentIDs 

Bug fixes 
Ruby API Bug fixes 

●​ Fixed Unicode characters not displaying correctly in the Ruby Console. 
●​ Fixed DWG import option, ":preserve_origin" being ignored. 
●​ Fixed crash on UI::HtmlDialog#dialog.close directly after 

UI::HtmlDialog#dialog.show 

●​ Multiple documentation corrections. 

C API Bug fixes 

●​ Changed the behavior of SULineStyleSetLengthMultiplier to accept 
negative multiplier values. The previous behavior was to reject all values less 
than or equal to zero. Negative values will now trigger "auto" stipple scaling 
which is described in the documentation. Zero is still an invalid input. 

●​ Changed the behavior of SULineStyleSetWidthPixels to accept line 
widths less than one. The previous behavior was to reject widths less than 
one as invalid input. Input widths less than or equal to zero are still invalid. 

●​ Multiple documentation corrections. 
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SketchUp Pro 2019 Release Notes 
A New Way to SketchUp 
Subscriptions and Classic Licenses 

Users now have the choice to buy a SketchUp subscription or a classic license of 
SketchUp Pro for desktop. Learn more about our subscription offerings in this Help 
Center article. 

Trimble ID 

A Trimble ID (TID) will be the gateway to access any SketchUp products. A TID will 
allow you to download a trial, buy a classic license or subscribe. You can sign up 
using an existing Gmail account or you can create a TID using a valid email address. 

Launch Experience 

We’ve refreshed the launch experience on SketchUp’s desktop 
applications—SketchUp Pro for Desktop, LayOut, and Style Builder. To access these 
applications, just sign in with a Trimble ID or enter an active classic license. 

30 day Trials 

There are a number of products you can explore during your 30-day trial of 
SketchUp Studio. The free trial currently includes: 

●​ SketchUp for Web 



●​ SketchUp desktop applications: SketchUp Pro for Desktop, LayOut, Style 
Builder. 

●​ Trimble Connect Personal (5 collaborators, 2 projects, and up to 10 GB of 
cloud storage) 

●​ Sefaira (building performance analysis software). 
●​ Augmented reality viewing on SketchUp Viewer for iOS and Android 
●​ Viewing on XR applications: HTC Vive, Oculus Rift, Hololens, and HP Windows 

Mixed Reality 

Note: We’ve updated the terms of our subscription trial. Please see Plans and 
Pricing for more information on available subscription options. 

What’s New in SketchUp Pro for Desktop? 
Welcome Panel (SketchUp Pro for Desktop + LayOut) 

We’ve made some updates to our Files, Learn, and Licensing tabs to make it easier 
to manage projects and licenses. While we were at it, we added links to learning 
resources directly into SketchUp and LayOut. 

Files tab: When you launch SketchUp or LayOut, you’ll see a Files panel where you 
can manage default templates and access new, recent and recovered files. To 
change to a different template when opening a new file, select the “New From 
Template” option in the File pulldown menu. 

Learn tab: We are introducing a new portal for training content, appropriately 
named, the SketchUp Campus. This is the hub for both beginner and advanced 
learning through video courses that will eventually cover the entire SketchUp family 
and many professional industry work flows. 

Licensing tab: You can still easily access your licensing information from within 
SketchUp and LayOut. When you select the licensing tab, you can choose to view 
either your classic license or subscription information. 

Default Toolbar Changes 



We’ve made some new updates to the toolbars in SketchUp Pro and LayOut. You’ll 
notice a “My Account” icon in the top upper-right hand side of the screen. Here, you 
can access your licensing information, sign in and sign out. 

Dashes 

Solid lines don’t always tell the full story. Sometimes you need a dash pattern to 
convey your design idea. Whether you need to demarcate a property boundary, 
identify what is proposed, or identify walls for demolition, adding a stipple might be 
your best solution. 

 
​
Supported Dashes in SketchUp (imperial and metric equivalents 

That’s why we’ve incorporated dashed lines into SketchUp Pro 2019. These dashes 
are properties of Layers and can be controlled from the Layers panel. Even better, 



components on layers will inherit the dash pattern. In LayOut, your dashes will 
show in the viewport at any screen scale and in all render modes with the ability to 
edit the dash width and scale. 

When you’re ready to export, SketchUp can convert your dashed pattern into a 
bunch of file formats: PDF, EPS (vector), images (raster), and DWG/DXF. 

SketchUp Tape Measure Tool 

Upgrades to the Tape Measure tool mean less time you’ll spend opening up Entity 
Info or looking at the Measurements box. Now, you can get the length of edges, 
area of faces, and coordinates of midpoints and intersections straight from an 
inference tip. 

Compatibility Mode for Windows 10 

It is no longer necessary to run SketchUp in compatibility mode. Compatibility 
mode was employed for several SketchUp releases as a workaround for problems 
with older Intel HD 2000 and HD 3000 GPUs on Windows 10. These GPUs have been 
deprecated by Intel on Windows 10 and because this workaround introduced 
problems of its own, it has been removed. As a result SketchUp, LayOut, and Style 
Builder will no longer run with Intel HD 2000 and HD 3000 GPUs on Windows 10. 

Support for macOS Mojave 

Our QA team has smashed and banged on Apple’s newest operating system, 
macOS Mojave, enough to say that SketchUp 2019 is fully compatible. 

What’s New in LayOut? 
LayOut File Locking 

We’ve made it harder to overwrite your LayOut files with unintentional edits. If you 
have multiple people working in the same file or if you’ve opened a file in two 
separate LayOut instances, we’ll temporarily lock your file and let you know it’s 
“read only.” Simple. 

SketchUp Dashes Control 



With the introduction of Dashes in SketchUp, LayOut now has the ability to modify 
how those lines styles are displayed. With the SketchUp model viewport selected, 
the SketchUp Model inspector will allow for modification. 

 
​
LayOut’s SketchUp Model inspector 

Export for SketchUp feature 

SketchUp has always played nice with others. We’ve been hard at work making it 
even easier for you to move between the software you need. In LayOut we have 
added a ‘Export for SketchUp’ feature to the DWG/DXF exporter that places all 
LayOut entities into the Model Space so that SketchUp can now ‘play’ with all 



LayOut data. As part of this feature Groups are sent over as SketchUp Components, 
Fills and Patterns are sent over as SketchUp faces for easy Push/Pull’n. 

 
​
LayOut’s DWG/DXF Export Options dialog 



 
​
Plan and Elevation created in LayOut 



 
​
Plan and Elevation imported into SketchUp via the new “Export to SketchUp 

With the 2019 release, you can now import and export AutoCAD 2018 DWG files in 
SketchUp Pro and LayOut. In LayOut, we’ve made it easier to export to DWG, and 
added the ability to adjust the Model Space Units when you import a DWG. 



 
​
LayOut’s DWG/DXF Import dialog 

Mouse Scroll Speed Controller 

We now provide users the ability set their mouse scroll speed within LayOut. With 
so many variances in systems, this is a helpful way to improve your LayOut 
experience. 



 
​
LayOut’s Mouse Scroll Speed Dialog 

Bug Fixes/Small Improvements in SketchUp 
In addition to the above, we’ve been heads down fixing bugs and adding some 
smaller features: 

Stability 

●​ Fixed a crash that could occur when exporting models with section planes to 
PDF. 

●​ Fixed an issue where deleting lines could cause invalid text entities that 
corrupted the camera view / made the model unusable. 



●​ Improved the overall stability of 2D and 3D DWG importing and exporting. 
●​ (Win) Fixed a crash that occurred when importing shortcuts with certain key 

combinations (including arrow keys, Ctrl -, Ctrl =). 
●​ (Mac) Fixed a very frequent crash that could occur when working with 

multiple documents, one of which has shadows on. 
●​ (Mac) Fixed a frequent crash that could occur when doing certain actions 

during scene transitions. 
●​ (Mac) Fixed a frequent crash that could occur when cancelling out of certain 

tools and switching documents. 
●​ (Mac) Fixed a crash that could occur when painting a face after closing a 

document. 
●​ (Mac) Fixed a crash that occurred on exit if a material was added to a 

material list created outside of SketchUp. 
●​ (Mac) Fixed a crash that occurred when exporting to IFC in JA. 
●​ (Mac) Fixed a crash that occurred when adding a new texture to a newly 

created materials list in Materials dialog. 
●​ (Mac) Fixed a crash when deleting the values in the Style Browser. 

Model Display 

●​ Improved the rendering of stipple patterns when there is rotation so that the 
stipple pattern is always perpendicular to the line. 

●​ Added anti-aliasing to stipple patterns. 
●​ Changed the alpha value for back edges. 
●​ Improved filled section cut rendering, allowing a section to be filled when one 

hidden face surrounded by two visible faces is cut. 
●​ Added the ability to allow soft profiles to be displayed as back edges. 
●​ Added a space between a number and metric units when formatting lengths 

displayed in SketchUp - e.g. 10 mm. 
●​ Fixed an issue where diagonal lines did not display well with faster 

transparency + 0x MSAA. 
●​ Fixed an issue where lines could be clipped/disappear when zooming in with 

a section cut. 

Tools/Inferencing 



●​ Enhanced the Measure tool to show the length of an edge and area of a face 
in the “On edge” and “On face” tooltips. 

●​ Enhanced the Measure tool to show the coordinates of vertices in the 
Measurements toolbar (VCB) and a tooltip. 

●​ Fixed an issue where Offset could give unexpected results when offsetting 
shapes with rounded corners. 

●​ Fixed an issue where selection was slow on some Windows 10 machines. 
●​ Fixed an issue where you could not enter Imperial inches units into the 

Measurements toolbar (VCB) when model units were set to metric. 
●​ Fixed an issue where you would sometimes get an unwanted component 

origin inference. 
●​ Fixed an issue where you could pick up an unexpected "On Section" 

inference with a hidden section plane. 
●​ Fixed an issue where zooming could lag on some machines with Intel GPUs at 

higher MSAA settings. 
●​ Fixed an issue where zooming could be very slow when the mouse is not 

over any geometry. 
●​ Fixed an issue with the Rectangle tool where midpoints could not always be 

inferred when using locking. 
●​ Fixed an issue with the Rectangle tool where the alignment preview icon was 

incorrect when inside a rotated component. 
●​ Fixed an issue where the Offset tool sometimes based its offset on vertices 

and not edges. 
●​ Fixed an issue with the Measure tool where lines did not always turn bold 

when Shift or the arrow keys were used to constrain lines. 
●​ Fixed an issue with the Move tool where lines did not turn bold when the 

cursor was directly in front of the dashed lines when the arrow keys were 
used to move an object in one of the x,y,z axis directions. 

●​ Fixed an issue where the picking order was incorrect for a rectangle on top of 
an image, resulting in unexpected behavior when using the Text tool on the 
rectangle. 

●​ (Win) Fixed an issue where some of our standard shortcuts unexpectedly 
changed the drawing mode for the Rectangle tool to “Draw about center”. 



●​ (Win) Fixed an issue where 3D Text dialog checkboxes were difficult to use 
when scaling was greater than 100%. 

●​ (Mac) Fixed an issue in which the default extrusion value changed each time 
3D Text was placed if not using units of Inches. 

DWG Import 

In SketchUp you now have the ability to Import and Export Materials improving 
interoperability for CAD and BIM workflows. 

●​ Fixed an issue where polylines with arcs would import with extraneous 
geometry. 

●​ We now import entities on frozen layers as non-visible. 
●​ We revised the precision of our importer to better allow for import of small 

entities, faces and solids. 
●​ We revised our importer to adaptively calculate the scale factor on imported 

geometry. 

DWG Export 

●​ We fixed an issue where geometry could get lost at a very small scale. 
●​ We improved the precision of Arcs and Circles so that they would be more 

accurate and created for most conditions. 
●​ (Mac) We fixed an issue where wide polylines were not being created when 

exporting 2D DWG with automatic width checked. 

Vector Output (PDF export, Vector printing, Vector and Hybrid rendering modes in LayOut) 

●​ Fixed an issue where extra lines were seen when a section cut is coincident 
with a face. 

●​ Fixed an issue where extra lines were seen when extruded circles are cut 
along their center. 

●​ Fixed an issue where hidden divided edges on top of faces drew as if they 
were visible. 

●​ Fixed an issue where images incorrectly showed a border around them. 
●​ Fixed an issue where lines were missing with some plan view models. 



●​ (Win) Fixed an issue with .PDF Export where the actual line widths were not 
exporting correctly. 

●​ (Win) Simplified the .PDF and .EPS dialogs and added control over the Line 
Scale. 

●​ (Mac) Wording with Export to .PDF and the Print dialog has changed from 
‘Line Weight’ to ‘Line Scale’. 

Layers Dialog 

●​ Updated the active layer and visible icons in the Layers dialog to align across 
LayOut & SketchUp. 

●​ Adjusted layer panel column ordering to address issues where the active 
layer may be changed unintentionally for new users, and to reduce the 
prominence of the active layer controls. 

●​ Layer Name sorting logic has changed - 
○​ For context, this would occur when sorting by name previously:​

Layer1​
Layer10​
Layer11​
Layer2​
Layer22​
Layer3​
Now this will occur:​
Layer1​
Layer2​
Layer3​
Layer10​
Layer11​
Layer22​
  

Miscellaneous 

●​ Fixed an issue where SketchUp models performed slowly in some models 
with a section plane. 



●​ Fixed an issue where the Entity Info "Toggles" icons did not update visually 
when tab was pressed. 

●​ Added the ability to edit a selected component by pressing Enter. 
●​ Fixed an issue where text/dimensions set with the “height” property scaled 

incorrectly on high DPI machines. 
●​ Fixed an issue where models with lots of construction points performed very 

poorly. 
●​ Fixed an issue where exploding a classified component instance produced an 

extra hidden classified entity. 
●​ Fixed an issue where Entity Info did not report area for surfaces. 
●​ Fixed a strange jump that could occur when editing component instances far 

from the origin. 
●​ Fixed an issue where Component Definitions in Model Info > Statistics were 

not updating properly when adding or deleting a component. 
●​ Fixed an issue where the shadows date and time controls do not scale 

properly on high DPI displays. 
●​ Fixed an issue where SketchUp would take focus during start up preventing 

work in other apps. 
●​ Fixed an issue where Add location terrain failed to import for some locations. 
●​ Fixed an issue where a "SketchUp Make" dialog was appearing in SketchUp 

Pro. 
●​ Fixed an Add Location issue where terrain import failed when a location has 

gaps in terrain coverage. 
●​ Added the ability to see a full shortcut description in the Preferences dialog. 
●​ Improved sorting of layers to be more intuitive. 
●​ Fixed an issue where Activating Shadows via the View menu would not 

require that the model be saved. 
●​ Upgraded the version of Chromium that SketchUp uses. 
●​ Updated error messages to refer to component definition instead of 

component name for consistency with Entity Info terminology. 
●​ Updated template names to reduce redundancy with Units specifications. 
●​ Fixed an issue where the "Enable length snapping" option could not be 

disabled when using the Architectural units format. 



●​ Fixed an issue where whole numbers were not displayed consistently when 
using the Engineering units format. 

●​ Fixed an issue where validity checking did not occur when saving/opening a 
SU 2015 or newer model in some cases. 

●​ Fixed an issue where you could have unexpected results when changing the 
number of segments of a polygon or arc. 

●​ Removed the ability to sign out from the 3D Warehouse and Extension 
Warehouse pages within SketchUp to avoid signing users out of SketchUp 
and thus losing access to their subscription. 

●​ Fixed miscellaneous language translation and truncation issues in localized 
builds. 

●​ Fixed an issue to provide dynamic block support for DWG imports. 
●​ Fixed an issue where certain .STL files would fail to load. 
●​ (Win) Fixed an issue where the Scene tab’s Rename item context menu was 

missing. 
●​ (Win) Fixed an issue where SketchUp did not display area for curved surfaces. 
●​ (Win) Fixed an issue in which a Tray context menu would appear when 

clicking within a context menu that was outside of the drawing window. 
●​ (Win) Fixed an issue in which tray dialogs would flicker when resized. 
●​ (Win) Fixed an issue in which 3D Warehouse and Extension Warehouse 

dialogs would flicker when resized. 
●​ (Win) Fixed an issue where the user was not alerted that autosave files 

existed when opening files via double-clicking. 
●​ (Win) Changed the “Length” label in Entity Info when circles, polygons and 

arcs are selected. 
●​ (Win) Changed the error message you see when running the CheckUp 

application and the RAM can’t be determined to be more accurate. 
●​ (Win) Updated the File > 3D Warehouse menu to show Share Component 

instead of Get Models. 
●​ (Mac) Fixed an issue where autosave files were not deleted after reopening 

SketchUp after a crash and taking actions. 
●​ (Mac) Fixed an issue in Image Export where the Resolution set by the user 

would not persist on Mac. 



●​ (Mac) Fixed an issue where the user was not prompted to save an autosaved 
file after a crash. 

●​ (Mac) Fixed an issue with the default file name supplied when downloading 
Unicode models outside of SketchUp. 

●​ (Mac) Fixed an issue where files saved to folder names containing special 
characters would cause autosave to fail. 

●​ (Mac) Fixed an issue in which materials were temporarily displayed in 3d 
Printing library when a materials list was removed. 

●​ (Mac) Fixed an issue in which user could overwrite their entire Templates 
folder. 

●​ (Mac) Fixed an issue in which the Soften/Smooth Edges dialog initially 
displayed angle of 360 degrees instead of 36 degrees. 

●​ (Mac) Fixed an issue where templates saved with names containing unicode 
characters displayed an incorrect template name. 

●​ (Mac) Fixed an issue where exported animation used the incorrect size. 
●​ (Mac) Fixed an issue where the icon for the Section Fill button was missing in 

SketchUp Viewer. 
●​ (Mac) We changed ‘Line Weight’ to ‘Line Scale’ in the Print and Export to 2D 

Graphic… dialogs. 
●​ (Mac) We now allow assign entities color ‘Bylayer’ on 2D Section Slice. 
●​ (Mac) Fixed an issue in which the Aspect Ratio for Animation export wasn’t 

saving. 
●​ (Mac) Changed SketchUp to not reopen crashed models on re-launch. 
●​ (Mac) Fixed an issue where the paint bucket cursor changed back to OS 

cursor after painting a face. 
●​ (Mac) Fixed issue in which 3D Warehouse window would show up blank when 

trying to access while offline. Now a message appears indicating you are 
offline. 

Bug Fixes/Small Improvements in LayOut and Style Builder 
In addition to the above, we’ve been heads down fixing bugs and adding some 
smaller features: 

Stability 



●​ Fixed a crash that could occur when rendering or re-rendering a SketchUp 
viewport in LayOut using Vector or Hybrid mode. 

●​ We had an issue where LayOut could lose the association to file references 
(SketchUp models and images). We found this to be related to the users 
temp folder being removed or over written possibly by an anti-virus utility or 
disk clean up process. This seemed to be most obvious when a copy paste 
was used to import files. To remedy this we have moved the active working 
file outside of your system temp folder.​
​
Your working LayOut files will now exist in the following location:​
​
Windows: c:\Users\<username>\AppData\local\SketchUp\SketchUp 
2019\LayOut\working​
​
Mac: /Users/<username>/Library/Application Support/SketchUp 
2019/LayOut/working​
​
  

●​ We fixed a crash when opening a document with the units set to Points. 
●​ We fixed an issue where Path entities could get corrupt. 
●​ (Win) We fixed a crash when exporting to .PDF if the file type extension was 

removed. 
●​ (Mac) We fixed a crash if you would enter an empty value in the ‘Line Width’ 

field of the SketchUp Model inspector. 
●​ (Mac) We fixed a crash when purging file references. 
●​ (Mac) We fixed an issue where a crash would occur when accessing ‘Other’ on 

the Text Styles pulldown when rulers are active. We are preventing the 
accessory view from coming up and now Text edits can only be done from 
the Fonts panel. 

●​ (Mac) We fixed a crash in the Label editor flyout. 

SketchUp Model View 

●​ We fixed an issue where the SketchUp actual font height would display at the 
LayOut Paper Space height. 



●​ We fixed the Hotspot on SketchUp models to better correspond with the 
cursor location. 

●​ Fixed an issue where internal lines would disappear when Vector rendering 
with the ‘Wireframe’ style. 

●​ (Win) Vector and Hybrid render has been improved to fix a number of issues 
where either the background color or the section fill color would ‘flood’ 
beyond the SketchUp Model view. 

●​ (Win) We fixed an issue where Raster rendered viewports would not display 
line weights correctly especially on high resolution monitors. 

●​ (Mac) We fixed an issue when exporting to .PDF where lightened images 
would be produced with Mac OS 10.13.4 and higher. 

Table Tool 

●​ You can now copy and paste a pattern fill within a Table. 
●​ Copy and pasting Table data is now text and not an image. 

DWG Import 

●​ We fixed an issue where Dimensions could get misaligned on import. 
●​ We fixed an issue where an import would fail if the Viewport layer was not 

visible in AutoCAD (off or frozen). 
●​ We improved our importer to better support non-rectangular viewports. 
●​ We fixed a bug where an import would fail with certain non-uniform scaled 

blocks. 
●​ We have improved our precision with small objects so that the import would 

not fail or produce strange artifacts. 
●​ We fixed how underlined text is imported. 
●​ We now respect the visibility state of a Dynamic View Block. 
●​ Fixed an issue where LayOut text with fill was not being converted to 

AutoCAD filled text. 

DWG Export 

●​ Fixed an issue where text fill was not being exported on Text, Labels and 
Dimensions. 

●​ Fixed an issue where text was being exported too large. 



●​ We had a bug where text size was lost on user modified dimensions. 
●​ Fixed an issue where the text style and height within a Table would lost on 

export. 
●​ We had an issue where exported arcs could be drawn inside out. 
●​ (Mac) Fixed a crash when exporting with an attached .PDF. 

Vector and Hybrid rendering in LayOut 

●​ Fixed an issue where extra lines were seen when a section cut is coincident 
with a face when using Vector/Hybrid rendering in LayOut. 

●​ Fixed an issue where extra lines were seen when extruded circles are cut 
along their center when using Vector/Hybrid rendering in LayOut. 

●​ Fixed an issue where hidden divided edges on top of faces drew as if they 
were visible when using Vector/Hybrid rendering in LayOut. 

●​ Fixed an issue where images incorrectly showed a border around them when 
using Vector/Hybrid rendering in LayOut. 

●​ Fixed an issue where lines were missing when Vector rendering some plan 
view models in LayOut. 

●​ Fixed an issue where extension lines were not drawn when using 
Vector/Hybrid rendering in LayOut. 

Scaled Drawing 

●​ We fixed an issue where the paper space dimension was being used with 
certain arc types. 

Miscellaneous 

●​ We now allow users to convert the leader type on multiple selected 
dimensions from the rt. click context menu. 

●​ We fixed a bug where labels would not align text correctly. 
●​ An issue has been fixed with dimensions where the manual set scale would 

always default to Auto Scale. 
●​ We added a new ‘Hidden’ style dash pattern to be consistent with SketchUp’s 

dash patterns. 
●​ We fixed an issue where click dragging would pick up the transform gizmo. 



●​ An issue with the Path tool has been fixed where inferences would be lost if 
esc or undo was performed during input. 

●​ We fixed an issue where manipulating a copied Rectangle would give 
disproportionate results. 

●​ We fixed an issue where Rounded rectangles would not scale proportionally. 
●​ We fixed an issue where ‘Sample’ would go away during with the Style tool 

when the cursor was moved. 
●​ The text tool has been fixed to allow highlighted text to be underlined 

individually. 
●​ Fixed an issue where the Align vertical icon was not aligned vertically. 
●​ Fixed an issue where Run of Dimensions would display the wrong value with 

entities that are off axis. 
●​ (Win) We fixed an issue with the Text tool so that the Anchor point and 

Alignment correspond with start location and mouse sweep direction. 
●​ (Win) Fixed an issue in presentation mode when changing pages would cause 

the display to zoom in when your resolution was set to anything but 100%. 
●​ (Win) A crash has been fixed when switching between inspectors. 
●​ (Mac) We fixed an issue where the Format option will not be visible on the 

exporter dialog when dialog is maximized on macOS High Sierra. 
●​ (Mac) We fixed an issue with Dimensions where editing the text color settings 

from the font panel would not take effect. 

SketchUp and LayOut API Release Notes 
Upgrade to Ruby 2.5.1 

We have upgraded from Ruby 2.2.4 to Ruby 2.5.1. These upgrades tend to 
introduce subtle changes to the Ruby language that sometimes are difficult for us 
to find in our internal testing. Our testing has not found any major compatibility 
issues between Ruby 2.2.4 and the new 2.5.1 and we expect the upgrade for most 
developers should be relatively straightforward. 

Dashes 

Stipples and dots and dotted stipples, oh my! SketchUp has added a Dashes feature 
that allows for unique line styles to be applied and controlled at the Layer level. We 
have exposed this new feature in the Ruby and C APIs. See the Improvements and 
Fixes sections of each API for a list of classes and methods we’ve added. See the 



documentation for each API for complete documentation on how to use these 
features. 

Materials Bug Fixes and Improvements 

The Extensibility team has done some code refactoring around how materials are 
named, created, and duplicated in both the UI and in the core SketchUp code. The 
main change that will be visible to developers is that we fixed a bug that was 
introduced in SketchUp 2018 where if Ruby tried to name a material to its current 
name ie: material.name = material.name it would fail, which was unexpected and 
unnecessary. There was also a bug where fetching a material by using its string 
name could fail due to a syncing error in the internally cached list of materials. We 
improved it so that scenario no longer fails. We also did some other code cleanup 
around disallowing duplicate material names via the UI which should not affect the 
Ruby API. 

InstancePath Support for Dimensions and Text 

In SketchUp 2019 we have added InstancePath support to our existing 
DimensionLinear and Text classes. Now when creating a Linear Dimension, or an 
attached Text object, you can attach it to a nested entity by providing a valid 
InstancePath object, or an array version of an instance path. This will allow you to 
create a dimension in model space, but attach it to a valid nested entity. The linear 
dimension or text will then be attached to that entity, exactly how it is when linear 
dimensions and text are created via the UI. 

Ruby API Breaking Changes 

●​ SketchUp changed how it presents units. Now it adds a space between the 
number and the unit indicator. If your extension uses a method of your own 
creation to interpret strings formatted by SketchUp you might find it doesn't 
work anymore if you don't account for the extra space. For example: 

○​ Before 2019: "2.5mm" 
○​ Now in 2019: "2.5 mm" 

●​ Ruby Version Upgrade - Ruby 2.5 removed the method: 
Dir::Tmpname.make_tmpname If you were using that method, you will need 
to find an alternative 



●​ Entity.delete_attribute no longer returns “true” when attempting to delete a 
non-existing dictionary key 

Ruby API Additions and Improvements 

●​ Update Ruby on Windows to use the right location for cacert.pem 
●​ Ensure Ruby uses a recent OpenSSL version 
●​ Fixed a regression on the Mac where renaming a material via the API will 

create duplicate materials 
●​ Upgraded ruby version from 2.2.4 to 2.5.1 for both mac and windows 
●​ Added Sketchup::Tools#active_tool that returns the active Ruby tool 
●​ Added import_materials option to Sketchup::Model#import for dwg importer 
●​ Added instance path support for Sketchup::Entities#add_text 
●​ Added instance path support for Sketchup::Entities#add_dimension_linear 
●​ Added Sketchup::LineStyles class 
●​ Added Sketchup::LineStyle class 
●​ Added Sketchup::Layer#line_style= 
●​ Added Sketchup::Model#line_styles 
●​ Improved String.to_l which parses a String into a Length is now able to parse 

strings that have a space between the number and unit. It can parse both 
"2.5mm" and "2.5 mm" 

●​ Improved Sketchup::InstancePath.new now accepts a path that includes a 
Sketchup::Image object 

Ruby API Bug Fixes 

●​ Fixed a crash upon exit on Mac when a FrameChangeObserver is active 
●​ Fixed an issue where Sketchup::Model could become unusable after calling 

.singleton_class. 
●​ Fixed Ruby-created dimensions don't highlight when non-associated 
●​ Fixed Ruby-created dimensions don’t hide correctly when “Hide 

Foreshortened” is enabled 
●​ Fixed SketchUp crash when constructing Geom::PolygonMesh with negative 

values 
●​ Fixed Ruby DWG Importer units were not working correctly 
●​ Fixed Geom::PolygonMesh will not accept negative numbers as parameter 



●​ Fixed Extensions are loaded in a non-deterministic order on High Sierra 
●​ Fixed SketchUp crashes when attempting to load component made in newer 

version 
●​ Fixed typo concerning merge_coplanar_faces in the Importer Options 

documentation 
●​ Fixed regression in SU 2018 when renaming a material with the same name 
●​ This used to throw an error when it should have been a no-op 
●​ Fixed regression in SU 2018 were model.materials["MaterialName"] might fail 
●​ Fixed a crash when loading a component made in a newer version of 

Sketchup 
●​ Fixed an issue where the Ruby Console would fail with some ascii characters 
●​ Fixed UI::HtmlDialog such that non-resizable dialog doesn't use width and 

height from preferences. 
●​ View.write_image should throw an error if there are more than 5 params 

passed in. 

Miscellaneous 

●​ Fixed: Advanced Camera Tools - Subsequent Frustums are additive and can 
get quite large. 

●​ (Mac) Fixed Extension Warehouse Icons appearing on web dialogs on Mac 
Mojave. 

SketchUp C API Additions and Improvements 

●​ Added SUDimensionGetFont() 
●​ Added SUDimensionSetFont() 
●​ Added SUDimensionLinearGetAlignment() 
●​ Added SUDimensionLinearGetTextPosition() 
●​ Added SUFontFromEntity() 
●​ Added SUFontToEntity() 
●​ Added SULayerGetLineStyle() 
●​ Added SULayerSetLineStyle() 
●​ Added SULengthFormatterGetForceInchDisplay() 
●​ Added SULengthFormatterSetForceInchDisplay() 
●​ Added SULineStyleGetName() 



●​ Added SULineStylesGetLineStyleByName() 
●​ Added SULineStylesGetLineStyleNames() 
●​ Added SULineStylesGetNumLineStyles() 
●​ Added SUModelGetImageDefinitions() 
●​ Added SUModelGetLineStyles() 
●​ Added SUModelGetNumImageDefinitions() 
●​ Added SUTransformationIsMirrored() 
●​ Added Return value SU_ERROR_SERIALIZATION for method 

SUStylesAddStyle() 
●​ Fixed SUDimensionLinear bug with setting a hidden property 
●​ Fixed SUDimensionRadiaul bug with setting a hidden property 
●​ Fixed SUTypedValueGetArray bug where the 'out' param wasn't being set. 
●​ Fixed SUTypedValueGetArray memory leak. 

DWG Importers and Exporters 

●​ Upgraded to TEIGHA 4.3.2 

Layout Ruby API for SketchUp 

●​ Document.save will now throw an error if the file is already open in LayOut 
●​ Added Layout::Path#winding to get the current winding direction of the path. 

Returns one of the new constants Layout::Path::PATH_WINDING_NONE, 
Layout::Path::PATH_WINDING_CLOCKWISE, or 

●​ Layout::Path::PATH_WINDING_COUNTER_CLOCKWISE. 
●​ Added Layout::SketchUpModel#dash_scale to get the current scale value of 

stipples in a SketchUp Model Ref. A value of 0.0 indicates the dash scale is 
automatically determined based on the line weight. 

●​ Added Layout::SketchUpModel#dash_scale= to set the scale value of stipples 
for the SketchUp Model Ref. A value at or below 0.0 will cause the scale to 
automatically be determined by the line weight. 

●​ Fix documentation of Layout::Path#append_point. When appending a bezier 
path segment, the params should have been (control_1, control_2, point) and 
not (point, control_1, control_2). 

LayOut C API Additions and Improvements 



●​ LODocumentSaveToFile will now return an SU_ERROR_SERIALIZATION when 
trying to save a .layout file that is currently open in LayOut. 

●​ Added LOPathGetWindingType 
●​ Added LOSketchUpModelGetDashScale 
●​ Added LOSketchUpModelSetDashScale 

Chromium (CEF) 

Chromium Version: 

2019: Chrome/64.0.3282.119​
2018: Chrome/56.0.2924.76 
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SketchUp Release Notes 
Fixes: 

●​ Fixed an issue where the classic and trial licensing information displayed to 
the user in the Welcome Window could be confusing. Specifically: 

○​ When a user enters a classic license alongside an active SketchUp trial, 
they are still be eligible to try other products in the Studio bundle. 

○​ The licensing panel now defaults to the Classic tab if the user has 
entered a Classic license. 

○​ If the user has entered a Classic license, we no longer show trial 
expiration text in the upper right corner of the Files panel. 

●​ Fixed an issue where exporting using AutoCAD 2018 file format would create 
a "Student Version" plot stamp for both SketchUp and LayOut when the file 
was opened in AutoCAD 2019. 

●​ Fixed an issue where text would not export with a 2D DWG/DXF export. 
●​ Fixed an issue where auto-save files did not persist on the Mac after a reboot 

or shutdown. 
○​ On Windows, recovered files are now saved here: 

C:\Users\YourUserName\AppData\Local\SketchUp\SketchUp 
2019\SketchUp\working\SKETCHUP\RecoveredFiles 

○​ On the Mac, recovered files are now saved here: 
~/Library/Application Support/SketchUp 
2019/working/SKETCHUP/Recovered Files 



●​ (Win) Fixed an issue where models would open slowly with the Materials 
dialog expanded. 

●​ (Win) Fixed an issue where the Add License button was not working for 
Windows OS usernames having an apostrophe. 

LayOut Release Notes 
Fixes: 

●​ Fixed an issue where LayOut could crash when opening a file. This was 
caused by corrupt paths not being removed when they were detected. 

SketchUp API Release Notes 
Fixes: 

●​ Fixed the accepted types for the "point" in entities.add_text 
●​ Fixed Model.save for VERSION_2019 
●​ Fixed crash when rendering_options["RenderMode"] = 4 
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Enhancing your professional workflow—it's the small things that count! 
We are excited to announce our second desktop product update since releasing 
SketchUp 2019. We've been hanging out on the forum and researching at 3D 
Basecamp to get some insight into your workflows. With your feedback, we've 
worked hard to update some top features in SketchUp Pro 2019 and LayOut. Try 
out these new updates, and see how they impact your professional outputs and 
workflows. 

What's new in SketchUp 2019.2 
The name of the game (update) is ease of use. This release has made SketchUp 
more intuitive — and more fun to use. With more focus on improvements to 
imagery exports, usability, and a seamless LayOut connection — your professional 
workflow will greatly benefit. Check out the top features below. 

Professional output enhancements 
Exporting images. Exporting 2D graphics, raster files, and animations just got 
better. You can now control the overall line thicknesses of exported images with 
our new line scale multiplier, found in the export options dialogs. Before this 
change, line weights stayed the same as the viewport which could make the line 
weight too small or too large. So, if you are experiencing line weights that are too 
thick, you can make those line weights thinner. Also, .png images now export with 
transparency so you can see what is behind the material while compositing. 



Customizable unit settings. Have you ever needed to use different unit 
measurements for a model? Now your model can be customized to show different 
unit measurements for area and volume. For example, in a model of a room, you 
can use inches for the wall and feet for volume. Available unit types: inches, feet, 
millimeters, centimeters, and meters. 

 
Workflow improvements 
Invert Selection. Just like the title suggests, it's the small things that help your 
workflow! This new feature will allow you to select anything, then invert the 
selection of objects. This makes it simple to select items and then perform actions 
on their inverse. The keyboard shortcut for this will be: CTRL + SHIFT + I (Windows) 
or CMD + SHIFT + I (Mac). 

 
Importing files. The days of picking out your import file format from a long list are 
over. You can now drag and drop ALL supported file types directly into your 
modeling window. By default, you'll now see all supported file types available for 
import. Additionally, the DWG and DXF importers now bring in fewer duplicate and 
messy edges. 

Eraser Tool. Have you ever accidentally erased too much in your model? To make 
your detailing workflow a little smoother and seamless, we added alt & cmd as 
modifier keys to remove any unnecessarily highlighted lines that you might have 
accidentally captured during your modeling efforts. 

Section Planes. Cutting a model along a plane so that you can peer inside the 
model? We just made this way smoother. Section planes now ask the user to name 
them after placing them in the model. Simply place, then name. 

Send to LayOut. Clearly, we want to make LayOut even better to use! You can now 
send your models directly to LayOut from the large toolset in the left-hand toolbar. 
If you haven't used LayOut before, you should check it out now! 



Large Area Imports for Add Location. You can now easily import large sites at full 
resolution. How can you take advantage of this new feature? Simply zoom out a bit, 
then select the level from which you want to import. Be aware that, importing very 
large areas with lots of imagery can adversely affect performance in your SketchUp 
model. Check out our help center to be sure you're aware of how to best handle 
lots of data in your models. Note that this feature is only available to SketchUp Pro 
and Studio subscription holders. 

What's new in LayOut 2019.2 
The overall changes for LayOut can be summed up in a few words: improved 
overall interaction for construction documentation. We focused on making the 
usability of LayOut more natural and consistent with that of SketchUp. Check out 
these life-changing updates. 

Professional output enhancements 
Isometric dimensioning. It is now possible to make linear dimensions align with an 
isometric viewpoint. This one is huge! Since an isometric drawing is a primary type 
of drawing in LayOut, we wanted to make it smoother and more straightforward. 
You can now control extension lines, gap distance, and align dimensions with 
isometric angles. 

 
Auto-text. Similar to “smart labels”, you can now add text to dimensions without 
breaking the automatic measurement. For example, let's say you create a wall 
dimension. You can dimension a wall, add the word “height”, and the dimension 
measurement will still update if the measurement changes. Pro tip: make sure your 
string has <> in it. For example, Height <>' will turn into 'Height 132in'. 

 
Workflow enhancements 
Rotating dimensions. Now, when your dimensions are off-axis, the bounding box 
will remain aligned with the object so you can continue to scale it in the right 
orientation. 



Scaling dimensions. All connected dimensions will move and scale with the parent 
object. Just select the SketchUp model or Scaled Drawing or anything a dimension is 
attached to and connected dimensions will come along for the ride. 

Quicker editing. Staying consistent with SketchUp usability, you can now hit the 
return key to edit SketchUp model views, groups, dimensions, or labels! Just select, 
press return, and start typing! 

SketchUp Release Notes 
Bug fixes/small features added 
We have fixed a good deal of bugs with this release and added some small features, 
including: 

Stability 

●​ Fixed a crash that could occur when offsetting a chain of edges that resulted 
in a smaller number of edges. 

●​ Fixed a crash that could occur when fixing validity errors in a model where 
the length in a dynamic component is set to infinity. 

●​ Fixed a crash that could occur when copy/pasting certain section planes and 
saving the model. 

●​ Fixed a crash that could occur when deleting a line with the Dimension, 
Rotate or Protractor tools active. 

●​ Fixed a crash that could occur when offsetting open arcs so that they almost 
disappear. 

●​ [Win] Fixed a crash that sometimes occurred when changing scenes. 

Model Display 

●​ Fixed an issue where guides that are coincident with a section plane were not 
drawing. 

●​ Fixed an issue where profile lines for softened back edges were displaying as 
solid vs with the dashed back edge stipple pattern. 



●​ [Win] Fixed an issue where SU could open with a blank workspace when 
using Intel graphics cards with certain Intel drivers. 

●​ [Mac] Fixed an issue where line weight thickness was sometimes rendered 
incorrectly on systems with two monitors. 

●​ [Mac] Fixed an issue where arrowheads incorrectly resized when clicking 
between low-res and Retina displays. 

Tools/Inferencing 

●​ Fixed an issue where zoom could be too sensitive when zooming into a filled 
section plane. 

●​ Removed the display of radial lines and centers when offsetting arcs, circles 
and polygons to make interactions cleaner. 

●​ Fixed an issue where inferencing could not find an endpoint of a recently 
created edge. 

●​ Fixed an issue where, when offsetting a single painted face outward, the 
newly created faces did not inherit the material of the original face. 

●​ Fixed an issue where the offset could be larger than expected when 
offsetting a circle using the “allow overlap” modifier key. 

●​ Fixed an issue where, when offsetting a three pointed star, the offset could 
shift incorrectly. 

●​ Fixed an issue where drawing small rectangles on small faces could cause the 
loss of materials and/or faces. 

●​ Improved how the offset tool works with certain arcs to ensure arcs are 
retained in more situations after an offset operation. 

●​ Fixed an issue where the Measure tool still showed the units of a face's area 
when the display of units was turned off in Model Info. 

Image export 

●​ Fixed an issue where sketchy edges in an image exported using the 
transparent background option could display with a white halo. 

●​ Fixed an issue where transparent faces in an image exported with the 
transparent background option displayed without transparency in other 
applications. 



●​ Fixed an issue where the width and height values in the Options dialog for 
image export would not update when edited. 

●​ Changed image export to give consistent results for text and dimensions 
regardless of the DPI of the display from which the export occurs. 

●​ [Mac] Fixed an issue where setting certain format-specific image export 
options had no effect. 

Miscellaneous 

●​ Fixed an issue where extensions licenses could not be obtained for users 
with a SketchUp Subscription license. Extension licenses should be correctly 
obtained during extension installation in all cases now. 

●​ Added a warning message when SU launches and is not using an available 
AMD or NVIDIA graphics card. 

●​ Fixed an issue where guide points made by typing a length of 0 couldn't be 
selected. 

●​ Fixed an issue where sampling with the Material Browser's eye dropper 
picked the default material vs the sampled material when picking through a 
section plane. 

●​ Fixed an issue where the user could not import the JPEG file format. 
●​ Added timestamp and path name tool tip text to the Welcome Window's 

Recent Files tab. 
●​ Changed the messaging in the "Oops...That didn't look like valid licensing 

info..." error message for Classic licensing, to provide more precise 
instructions for resolution. 

●​ Updated the Trimble Connect extension to utilize a newer Connect API 
version. 

●​ Fixed an issue where the Help Center for errors on startup did not go to a 
language specific link. 

●​ Fixed an issue where the Unit combo boxes were editable in Model Info. 
●​ Improved formatting of file location tool tip text in the Welcome Window. 
●​ [Win] Fixed an issue where recovered files were sometimes deleted during a 

revert operation. 



●​ [Win] Fixed an issue where the SketchUp 'Send to LayOut' command did not 
work if LayOut was already open with certain configurations. 

●​ [Win] SketchUp now displays backup (.skb) files when the user selects File > 
Open. 

●​ [Win] Fixed an issue where the STL Import Option choices for units did not 
persist when closing and re-opening the Options dialog. 

●​ [Mac] Added the ability to save as older versions for Save A Copy As. 
●​ [Mac] Changed the "Length" label in Entity info to be more accurate 

depending on which entity type is selected. 
●​ [Mac] Fixed an incorrect Japanese translation in the Styles tray. 

Known Issues 
Certain extensions are not yet compatible with SketchUp 2019.2. We are not able to 
know every extension that is affected, but we don’t believe that the number of 
extensions affected is large. 

We know that Thea is not yet compatible with SketchUp 2019.2. If you require Thea 
Renderer, we recommend that you not upgrade at this time, until they are able to 
release a compatible version. 

Please see this SketchUp Forum post for more information. 

LayOut Release Notes 
Bug fixes/small features added 
We have fixed a good deal of bugs with this release and added some small features, 
including: 

Stability 

●​ Improved the way we handle selection and multiple select. 

SketchUp Model View 



●​ Render Mode and Scene can no longer be changed when selecting multiple 
Locked SU model viewports. 

DWG Export 

●​ Fixed an issue where a SketchUp model view that was grouped would export 
at 1:1 PaperSpace scale. 

Miscellaneous 

●​ Addressed a problem where auto-render could cause an infinite loop or 
latency in the application when a model failed to render. 

●​ Fixed a problem where LayOut and Style Builder did not display offline Action 
Manager notifications. 

●​ Fixed an issue where the clipping mask would be lost after editing. 
●​ Improved Welcome Window load time. 
●​ Changed the warning message when a model fails to render to provide 

instructions on how to resolve the rendering failure. 
●​ [Win] Fixed an issue where the Welcome Window would not scroll. 
●​ [Win] Fixed an issue where the LayOut window would lose focus when using 

the label tool and multi component component names. 
●​ [Win] Corrected an inconsistency where the list of available versions in Save 

As were in a different order from the way they were displayed on the Mac or 
in SketchUp. 

●​ [Win] Removed the "All Files(*.*)" entry from the File > Save and File > Save As 
file picker dialogs. 

●​ [Mac] We have restored the “Space” and “List” functionality for text editing. 

SketchUp API Release Notes 
What's New? 
Ruby Version Upgrade 

The SketchUp application and the SDK have been updated to Ruby version 2.5.5. 
This was done to address an optimization bug in 'if' and 'jump' and to improve 
security. 



Mouse Wheel in the Ruby API! 

In addition to exposing new functionality in SketchUp we exposed the mouse wheel 
event to custom Ruby tools. This opens up new possibilities for interacting with the 
viewport and UI and could make for some exciting new Ruby extensions. 

Textures - Export Performance and other Improvements 

Exporting texture data and performance was a theme across both APIs. For anyone 
exporting textures, we fixed two specific issues. 

1.​ In the C API, previously we were re-writing all images, even if SketchUp itself 
was not altering the image (ie. with a colorization effect). This significantly 
increased export times. We've changed it to now just dump the original file. 

2.​ In the Ruby and the C API, we've made a change to how we export colorized 
png's. Previously we were using the highest (and slowest) compression 
setting. We've adjusted this setting to a more moderate compression. Our 4k 
x 4k image export test reduced from ~50 seconds to only ~6 seconds. 

A number of missing "Remove" functions were added to the C API, further 
improving the feature parity with the Ruby API. 

Ruby API Additions and Improvements 

●​ Added onMouseWheel event to the Tool interface. 
●​ Added Sketchup::Selection#invert 
●​ Added :scale_factor to view.write_image to allow the API user to control the 

scaling factor of viewport dependent elements such as line weights. 
●​ Added the new area and volume unit settings to Sketchup::OptionsProvider. 

○​ Added Sketchup.format_volume. 
○​ Added constants to the Length class for area and volume units to be 

used with the OptionsProvider. 



●​ Documented :source => :framebuffer option in Sketchup::View#write_image 
that dumps the current frame as drawn in viewport. This has existed since 
SketchUp 7. 

Ruby API Bug Fixes 

●​ Update Ruby Version to 2.5.5 to fix optimization bug in Ruby 2.5.1. 
●​ Fixed possible crash in Sketchup::Entities#clear. 
●​ Added checks to prevent Image materials from being assigned to normal 

drawing elements. Doing so will now throw an ArgumentError. 
●​ It is no longer possible to assign Sketchup::Image materials to entities. 
●​ onViewChanged now triggers when the viewport changes size. 
●​ Dynamic Component no longer throws an error on deleted entity. 

SketchUp C API Additions and Improvements 

●​ Added SUApplicationGetActiveModel 
●​ Added SULengthFormatterGetAreaUnits 
●​ Added SULengthFormatterSetAreaUnits 
●​ Added SULengthFormatterGetVolumeUnits 
●​ Added SULengthFormatterSetVolumeUnits 
●​ Added SUMaterialGetColorizeDeltas 
●​ Added SUMaterialGetColorizeType 
●​ Added SUMaterialSetColorizeType 
●​ Added SUMaterialGetOwnerType 
●​ Added SUModelGetAllMaterials 
●​ Added SUModelGetNumAllMaterials 
●​ Added SUModelGetGuid 
●​ Added SUModelLoadDefinition 
●​ Added SUModelRemoveComponentDefinitions 
●​ Added SUModelRemoveLayers 
●​ Added SUModelRemoveMaterials 
●​ Added SUModelRemoveScenes 
●​ Added SUStylesRemoveStyle 
●​ Added SUStylesSetSelectedStyle 



●​ Added SUTextureWriteOriginalToFile 
●​ Removed Deprecated C++ Com Interface. 
●​ Updated SDK docs on VC++ runtime versions. 
●​ It is now possible to use the C API to get the active model using 

SUApplicationGetActiveModel. This is for Read Only access to the model. Mac 
builds were missing the symbols for Live C API. They are now included in this 
build. 

●​ For more information about the Read Only Live C API, how to link correctly - 
read this forum post. 

SketchUp C API Bug Fixes 

●​ Fixed a bug where SUModelSaveToFileWithVersion and SUModelSaveToFile 
weren't updating the model's GUID. 

●​ Fixed SUStylesAddStyle where it would fail to load some .style files. 
●​ SUComponentInstanceFromEntity returns NULL if underlying entity is a 

Group 
●​ Fixed a performance regressions where SUTextureWriteToFile would 

rasterize non-colorized texture instead of just dumping the original file data. 
●​ It is no longer possible to assign Sketchup::Image materials to entities 

Ruby API and C API 

●​ Increased performance of PNG image export for colorized materials. 
Previously, it used to use max compression. Now we use a more balanced 
compression setting. This affects 
SUTextureWriteToFile/Sketchup::Texture#write as well as the texture writer. 
We also added some general optimizations for 
SUTextureWriteToFile/Sketchup::Texture#write. On a 4Kx4K texture we saw 
the processing time drop from ~50 seconds to ~6 seconds. 

C++ API (SkpReader) Removal 
We recently announced that we had done the work to remove the C++ API from the 
SketchUp SDK. This is our first release that does not support the C++ API. See this 
forum post for more information.​



https://forums.sketchup.com/t/developer-announcement-c-api-removal/94943" 
target="_blank">https://forums.sketchup.com/t/developer-announcement-c-api-re
moval/94943 

Who does this affect? 

This change should not affect most people, as most people are using our C API. 
However, anyone that is still using the C++ API which has been included in the 
“deprecated” folder in the SDK since SketchUp 2013 will need to migrate their code 
to the C API. You will still be able to read and write SketchUp 2019 and earlier .skp 
files using the C++ API that we released with previous versions of SketchUp 2019. 
But you will not be able to add a custom exporter that uses the C++ API to 
SketchUp. The bridge that connects the C++ exporters to the SketchUp exporter 
interface has been completely removed in this and all future versions of SketchUp. 
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Sign In Workflow Changes 
What has changed?​
  

Users will now sign into our desktop applications via an external web browser, 
instead of an embedded web browser. This change impacts both subscription and 
classic license users. 

The change in 2019.3 that will impact classic license users: Users need to be signed 
in before accessing the 3D Warehouse, Extension Warehouse and Add Location, 
which they didn't need to do in previous builds. Accessing these features will go 
through the new sign-in workflow, which means classic license users need Trimble 
IDs (or Google IDs) to access them. 

Why? ​
  

This past April, Google announced that it will no longer support Google Sign In 
through embedded browser frameworks. In order to continue supporting Google 
Sign In, we’re following one of Google’s recommended solutions: to have users sign 
in through their default web browsers and capture the sign in information via a web 
server on their local machine (127.0.0.1). 

What does this mean from a user’s point of view?​
  



●​ All users need to be signed in to access the 3D Warehouse, Extension 
Warehouse, Trimble Connect and Add Location from within the desktop 
apps. 

●​ When a user selects a ‘Sign In’ command from within a desktop app, the 
user’s default web browser will open a new tab in order for them to sign in. 

If you're using either Microsoft Internet Explorer or Microsoft Edge as your default 
browser then you may run into some issues with this new workflow. You can read 
about this issue along with some workarounds in our article titled Support for 
Microsoft Internet Explorer or Edge Browser in SketchUp 2019.3 , please visit this 
article for more information. 

 
SketchUp Release Notes 
Fixes 
macOS Catalina Support​
  

Added support for macOS Catalina, which included the following updates: 

●​ Implemented the notarization process that will be required for macOS 
Catalina. 

●​ Fixed an issue where the Welcome Window’s templates panel sometimes 
loaded slowly. 

●​ Fixed an issue where text was displayed with a black background on some 
configurations. 

Other​
  

●​ Changed our internet connection tests to work more robustly across the 
globe. 

●​ (Win) Updated libcrypto and libssl dlls to 1.1.1c. 

 



November 14, 2017 
Version: ​
18.0.16975 (Win 64-bit) ​
18.0.16976 (Mac 64-bit) 

Table of Contents 
​​ SketchUp Release Notes 
​​ LayOut Release Notes 
​​ SketchUp API Release Notes 

SketchUp Release Notes 
What’s New? ​
Advanced Attributes 

Advanced Attributes allow you to embed useful information into your model when 
creating and managing components. You can now define the Price, Size and URL 
attributes when creating or editing components, as well as defining Owner and 
Status attributes for each component instance via the Entity Info dialog. 

Aggregation in Generate Report 

We want to make the information in SketchUp models as useful as possible. In this 
release, we’re improving Generate Report to allow users to aggregate component 
data so you can extract and organize information contained in your models. That 
means you can configure Generate Report to sum parts and quantities for 
schedules and cutlists, or create detailed pricing estimates by listing prices by layer. 

IFC Export Improvements 

BIM doesn’t really work if information can’t move freely between applications. 
We’ve dialed in our IFC exporter to ensure that the attributes you bring in from 
other applications or manipulate in SketchUp stay with your work when it leaves 
SketchUp. 



Named Section Planes 

It seems simple, but naming something is the first step towards making it easier to 
find, organize, and edit that something. Now, even when your section planes are 
hidden, they’re right at your fingertips. Here’s how it works… 

Create a new section plane and choose a name for it and a short symbol that will 
display in your modeling window. Your section plane is now a unique SketchUp 
entity that can be found in Outliner and manipulated in Entity Info. Use Outliner to 
quickly find, select and edit specific planes. Use Entity Info to edit naming 
conventions and organize section cuts into layers, then control the visibility of your 
section planes, cuts and fills via Styles. 

Filled, Styled Section Cuts 

We have added Filled Section Cuts to SketchUp 2018. To access, open Styles > Edit > 
Modeling and toggle ‘Section Fills’ on or off, and set your desired fill color. When 
section fills are toggled on, SketchUp will render a fill on top of cleanly modeled 
sections. We’ll even help you troubleshoot geometry problems that are preventing 
SketchUp from recognizing the section you want to fill. Access troubleshoot mode 
through the section plane context menu when Section Fills are on. 

Section Plane Performance 

While we were at it, we improved performance for models that use section planes 
to hide large amounts of geometry. Basically, the more geometry you section off, 
the more you’ll benefit! 

Other Notable Improvements and Changes Outliner 

While adding support for Section Planes, we also improved Outliner’s performance. 
Outliner no longer refreshes on many transactions that don’t need it. Additionally, 
we improved the sort order in Outliner. Changes include: 



●​ Sorting based on Component Instance and then Definition instead of sorting 
based on one long string. This also applies to Section Planes - it will sort first 
based on the Section Name and then the Symbol. 

●​ Sorting numbers in a more intuitive way. 
●​ Sorting is now case insensitive, which means a mixture of capitalized and 

lowercase words sorts in a more intuitive way. 

  

Drawing Improvements 

We made some small, smart changes that help you draw exactly what you want. 
Including: 

●​ Draw a rectangle about its center using modifier keys (Ctrl on Win and Option 
on Mac). 

●​ Employ quicker control for rotated rectangles. We switched the order of 
entry in the VCB so you can quickly enter a dimension with no angle. 

●​ Improved workflow with Tape Measure Tool. Edge length and face area are 
now instantly displayed in VCB as soon as user gets “On Edge” on “On Face” 
inferences. 

●​ Added color coding to Freehand tool. While drawing, it is colored the same as 
the axis it is perpendicular to. 

●​ Reduced display of arc/circle inferences after second click of any drawing 
tool. 

  

STL Import/Export 

The SketchUp STL extension is by far the most popular download from Extension 
Warehouse. Going forward it might not be, because now SketchUp natively 
supports the import and export of STL files (on both desktop and web). 



Anti-aliasing on the Mac 

For Mac users, we’ve added anti-aliasing settings. Go to SketchUp > Preferences > 
OpenGL to control the anti-aliasing sample count, which controls the smoothness 
of your geometry. 

Preferences Location 

The majority of preferences are now stored in two json files. There are still some OS 
controlled preferences that remain in the registry (Win) or plist (Mac). The json files 
are saved in the following locations: 

On Win: ​
PrivatePreferences.json is saved to C:\Users\[user 
name]\AppData\Local\SketchUp\SketchUp 2018\SketchUp 
SharedPreferences.json is saved to C:\Users\[user 
name]\AppData\Roaming\SketchUp\SketchUp 2018\SketchUp 

On Mac: ​
Both PrivatePreferences.json and SharedPreferences.json are saved to /Users/[user 
name]/Library/Application Support/SketchUp 2018/SketchUp 

DWG Importer 

The DWG Importer has been rewritten using our own C API. The goal is that the new 
dwg importer will work exactly the same as the 2017 version (improvements can 
come at a later time, now that we have code we can update and maintain more 
easily!). Ideally all files that imported previously will continue to import in 2018 and 
hopefully some files that used to fail on import will now import correctly. 

Support for macOS High Sierra 



Our QA team has smashed and banged on Apple’s newest operating system, 
macOS High Sierra, enough to say that SketchUp 2018 is fully compatible. 

Bug Fixes/Small Improvements 

In addition to the above, we’ve been heads down fixing bugs and adding some 
smaller features: 

Stability 

●​ Fixed a very frequent crash that could occur when drawing lines. 
●​ Fixed a crash that occurred on startup if launching SketchUp on a machine 

with an old version of OpenGL. 
●​ Fixed a crash that could occur when healing two faces. 
●​ Fixed a crash that could occur when using Solid Tools on certain types of 

geometry. 
●​ Fixed a crash when offsetting a face on an imported DAE file. 
●​ Fixed a crash that could occur when selecting Intersect Faces with two 

section planes selected. 
●​ Fixed an issue where SketchUp would crash on quit if the 3D Warehouse 

window was open. 
●​ Fixed a crash that could occur when using Outliner after importing a corrupt 

IFC file. 
●​ (Win) Fixed a very frequent crash that would occur on startup with older Intel 

drivers. 
●​ (Win) Fixed a crash that occurred when setting profiles > 2 on some ATI 

graphics cards. 
●​ (Win) Fixed a crash that could occur on startup if the default tray was docked 

with the Components dialog open and a floating tray had the second tab 
active. 

●​ (Win) Fixed a hang that could occur when cancelling the download of a 
component via the Components browser. 

●​ (Win) Fixed a crash that occurred if you entered Ctrl-N while in print preview. 



●​ (Win) Fixed a crash that occurred when you entered random values into the 
Print Preview units. 

●​ (Win) Fixed a hang that could occur when cancelling the download of a 
component via the Component Browser. 

●​ (Mac) Fixed a crash that occurred when closing the message dialog that pops 
up after searching for a component in the Components dialog with invalid 
characters or while offline. 

●​ (Mac) Fixed a crash that occurred if clicking Reset Workspace in the 
Preferences dialog with Instructor open. 

●​ (Mac) Fixed a crash that could occur on exit when closing SketchUp with the 
Styles and Instructor dialogs open and multiple models with unsaved 
changes. 

●​ (Mac - High Sierra) Fixed a crash that could occur after resizing the Colors 
dialog on High Sierra. After the initial crash, users would continue to crash on 
launch. 

Model Display  

●​ Changed nicer transparency to allow the display of anti-aliased edges. 
●​ Changed faster transparency to display a model in a predictable way 

(previously, a model could display differently each time it was opened). 
●​ Improved model visibility by changing SketchUp to no longer fade entities 

behind a section plane when editing a component. 
●​ Fixed an issue where hidden profile edges, with View > Hidden geometry 

turned on, displayed differently depending on how they were hidden. 
●​ Fixed an issue where softened sketchy edges were not visible during a copy. 
●​ Fixed an issue where, when using nicer transparency sort, edges behind 

multiple layers of transparent faces displayed when they should have been 
hidden. 

●​ Fixed an issue where a single selected section plane was not visible during a 
copy/paste action. 

●​ Fixed an issue where Color By Axis would not update colors if you changed 
the RGB colors in the Accessibility preferences. 



●​ Fixed an issue where non-profile lines hidden at the entity level incorrectly 
displayed with the dashed hidden pattern when edges were turned off and 
profiles were turned on. 

●​ Fixed an issue where setting profile thickness to 1 forced edges to be 
displayed. 

●​ Fixed an issue in which negative axes could render incorrectly on some Intel 
machines when orbiting with back edges on. 

●​ Fixed an issue in which negative axes could render incorrectly on some Intel 
machines when using certain tools. 

Section Planes 

●​ Made a change to be able to select a section plane by clicking on the section 
plane arrow (symbol). 

●​ Fixed an issue in which section cut lines were temporarily visible after turning 
off hidden geometry. 

●​ Fixed an issue in which section cut lines didn’t dynamically update with 
multiple active cuts when either moving a plane or switching between 
scenes. 

●​ Made change to selection highlighting so now when a section plane is 
selected the section cut lines are also highlighted as part of the selection. If 
section fills are on, the fill is also highlighted. 

●​ Fixed an issue in which leader text was incorrectly positioned at origin when 
placed at intersection with a section plane. 

●​ Fixed an issue in which zoom extents zoomed to the full model with an active 
section cut instead of just the visible geometry. 

●​ Fixed an issue in which the export of a model in wireframe with section cuts 
did not match what was displayed within SketchUp. 

●​ (Mac) Fixed an issue in which the section plane toolbar buttons showed 
opposite toggle state. Dark gray background now appears when button is on 
similar to Shadows toolbar button. 

●​ (Mac) Fixed an issue in which the section plane toolbar buttons didn’t toggle 
state when changing the state in the Styles dialog or the View menu. 

Outliner 



●​ (Mac) Fixed an issue in which the component definition disappeared if 
attempting to rename a component in Outliner but not making any changes. 

●​ (Mac) Fixed an issue in which the image for a component/group in Outliner 
could switch to an incorrect image when either double clicking on the entity 
or right clicking and selecting to Rename. 

●​ (Mac) Fixed an issue in which an entity in Outliner could remain highlighted 
blue after having double clicked to edit it and then clicking in Outliner to 
deselect it. 

●​ (Mac) Fixed an issue in which you couldn’t directly single click in Outliner 
without Outliner first being active. 

●​ (Mac) Fixed an issue in which the entity in Outliner wasn’t highlighted in blue 
after double clicking on an entity to edit it without Outliner first being active. 

Tools 

●​ Updated cursors for the Circle and Polygon tools. 
●​ Improved ease of editing of component with transparent faces. 
●​ Fixed an issue in which an offset polygon became a curve. It is now 

maintained as a polygon. 
●​ Fixed an issue in which a line could incorrectly reset from an endpoint while 

using continuous line drawing and crossing over other geometry. 
●​ Fixed an issue in which an offset could show some z-fighting. 
●​ Fixed an issue in which the Protractor and Rotate tools could remain 

constrained to a plane after releasing shift with tool locked using arrow keys. 
●​ Fixed an issue where automatic edge and area measurements were incorrect 

for scaled component instances. 
●​ Fixed an issue in which you couldn’t just enter an angle in the VCB 

(Measurements Toolbar) if baseline was reset after second click. 
●​ Fixed an issue where dimensions attached to the center point of a 

circle/polygons within a group could become detached when moving them. 
●​ Fixed an issue where an incorrect inference to the origin could be seen when 

adding a dimension the first time in a model. 
●​ Improved scaling of tool cursors on high-DPI monitors. 

Component/Group Origin 



●​ Updated tooltip to include more detail when hovering over a component 
origin that is on geometry. 

●​ Fixed an issue in which leader text attached to a component/group origin 
could temporarily point to model origin when double clicking to edit the 
component. 

●​ Fixed an issue in which the default text was displaying as “Enter text” instead 
of either the component definition or position within a group when adding 
leader text to a component/group origin. 

●​ Fixed an issue in which leader text pointing to a component/group origin 
could unexpectedly remain in place when moving geometry within the 
component/group. 

Miscellaneous 

●​ Added a preference to workaround an issue in which selection could be very 
slow on some Win 10 systems. To set this preference open Command 
Prompt and enter: ​
"C:\Program Files\SketchUp\SketchUp 2018\jsonpatcheditor" Preferences 
WorkaroundDrawXorRectUseGLFlushNotFlushDraw b true ​
Note: If you installed SketchUp in a non-default location you will have to 
update the location above. 

●​ Fixed an issue in which letterbox bars render incorrectly during large image 
exports. 

●​ Improved terrain resolution for Add Location. Previously the grid for terrain 
was smaller than expected. It should now work the way it did which allowed 
up to 2500 points in the terrain mesh. 

●​ Implemented a cross-platform library for logging into 3D Warehouse and 
Extension Warehouse. 

●​ Added persistent IDs to scenes allowing LayOut or extension developers to 
reference scenes. 

●​ Added component definition name to the tooltip when hovering over 
component inferences. 

●​ Improved performance of models that contain hidden guides. 
●​ Improved performance when using color by axis. 



●​ Implemented a minimal face shader that improved performance on Intel 
GPUs with older drivers. 

●​ Fixed an issue where textures couldn’t be combined on vertical faces. 
●​ Added a new warning if a user tries to set a shortcut that uses a tool modifier 

key (e.g. arrow keys). 
●​ Fixed an issue where selecting vector printing would change zoom. 
●​ Upgraded the version of Chromium that SketchUp uses. 
●​ Fixed an issue where exporting as IFC removed Custom Property Sets. 
●​ Updated terminology from “Knowledge Center” to “Help Center” throughout 

application. 
●​ Fixed an issue where changing the number of segments of a polygon or arc 

could create a bad face. 
●​ Fixed an issue where a face was not created when drawing a rectangle that 

intersects two lines. 
●​ Fixed an issue where style thumbnails were incorrect when using hidden line 

mode with regular edges and no profiles. 
●​ Improved text cursor tracking when scaling is > 100%. 
●​ Fixed an issue where the X-ray opacity did not select the correct value until 

clicked on. 
●​ Fixed an issue where the wrong layer would be deleted when user was in edit 

mode. 
●​ Fixed an issue where models would sometimes contain two NULL (model 

marker) watermarks. 
●​ Fixed an issue in which you could get duplicate persistent IDs after push 

pulling a face that included an arc or placing 3D Text. Also, expanded validity 
check to catch these additional cases in which duplicate persistent IDs were 
created. 

●​ Fixed an issue where a duplicate section plane PIDs could be created that 
could not be fixed. 

●​ Fixed an issue where creating a component would not retain nested 
attributes. 

●​ Fixed an issue where a warning could pop up that a component name 
already exists after performing a Solid Tools operation and making the group 
a component. 



●​ Improved the Solid Tools ability to work properly on disconnected manifold 
bodies. 

●​ Fixed an issue where faces would not close on faces with dangling interior 
edges. 

●​ Fixed an issue in which inconsistent results could be seen when exporting an 
image with and without anti-aliasing. 

●​ Fixed an issue where thick profiles did not export correctly to an image 
format with some graphics cards (e.g. NVIDIA) which clamped their width. 

●​ Changed SketchUp to no longer allow the reloading of a locked component 
instance via the in model Components Browser context menu. 

●​ Added the capability to copy SketchUp version numbers directly from the 
About SketchUp dialog. On Win, open the Help > About dialog, click on it to 
give it focus, Ctrl + C and Ctrl + V. On Mac, open the Help > About dialog, 
select version number, Command + C and Command + V. 

●​ Fixed an issue where a more general error message was displayed on launch 
if hardware acceleration was unsupported. 

●​ Improved Midpoint inferencing for cases in which multiple Midpoints are in 
very close proximity. 

●​ Fixed a number of translation and truncation errors in localized builds. 
●​ Fixed a non fixable validity error that could occur when importing a 

geo-located component into a non geo-located model. 
●​ Fixed an issue where scenes excluded from animations were not indicated 

correctly. 
●​ Fixed an issue where the axes plane for glued components was incorrect. 
●​ (Win) Changed our default multisample anti-aliasing setting for Intel graphics 

cards from 0x to 4x. 
●​ Fixed an issue where material thumbnails were displayed incorrectly. 
●​ Improved tool tip text for Entity Info icons. 
●​ Improved size and alignment of elements in Entity Info dialog. 
●​ Fixed several issues where the Styles browser and editor were not displayed 

correctly on high-DPI monitors. 
●​ Updated validity check to catch an additional case in which duplicate 

persistent ID’s could get assigned. 



●​ (Win) Fixed an issue where the swatch in the Material browser could fail to 
update after using the "Match color on the screen" functionality. 

●​ (Win) Updated the error message when selecting multisample anti-aliasing 
and fast feedback settings that your graphics card didn’t support and only 
reset these settings. Also, made Preferences dialog remain open after 
clicking OK to acknowledge the message. 

●​ (Win) Fixed an issue where after a failed autosave, autosave wouldn’t kick off 
again until another change was made. 

●​ (Win) Updated the message you see if you delete a component definition 
directly in the Components dialog. 

●​ (Win) Fixed an issue in which preferences weren’t carried forward if you 
skipped a version of SketchUp. 

●​ (Win) Fixed an issue where the wireframe rendering button in the Styles 
browser was incorrectly disabled when x-ray mode was selected. 

●​ (Win) Fixed an issue where ground transparency settings in the Styles 
browser failed to immediately update when switching between scenes. 

●​ (Win) Fixed a formatting bug in the Toolbars dialog and updated the 
appearance of various dialogs. 

●​ (Win) Fixed an issue where the print preview image was distorted when 
resizing the window. 

●​ (Win) Fixed an issue where SketchUp would allow non-numeric page sizes in 
print dialog. 

●​ (Win) Fixed a non fixable validity error that occurred if you selected a color or 
material from a library and didn’t paint with it. 

●​ (Win) Improved Entity Info toggle icon states and highlighting on hover. 
●​ (Win) Fixed an issue where SketchUp would crash when attempting to save to 

Google Drive File Stream. 
●​ (Win) Fixed an issue where models saved using the Save As… component 

context menu did not respect a folder's sharing permissions. 
●​ (Mac) Fixed an issue where the Select tool didn’t work after selecting to "Set 

Component Axes" when creating a component. 
●​ (Mac) Added functionality to remember the last visited location when 

relaunching the 3D Warehouse. 



●​ (Mac) Fixed an issue in which resetting all shortcuts cleared all shortcuts 
including the defaults and all prior shortcuts could return after relaunching 
SketchUp. 

●​ (Mac) Fixed an issue in which shortcuts weren’t carried forward if you 
skipped a version of SketchUp. 

●​ (Mac) Fixed an issue in which Entity Info didn’t initially snap to Instructor 
when opening Entity Info on first launch. 

●​ (Mac) Fixed an issue in which File > Save became enabled after cancelling out 
of the Save As dialog on a locked file. 

●​ (Mac) Fixed an issue in which you were not notified that an autosave file 
exists when launching SketchUp after a crash. 

●​ (Mac) Improved the display of file paths in the Preferences > Files dialog. 
●​ (Mac) Updated the Scenes and Styles warning dialog to only enable “Please 

don’t show this again” when “Do nothing to save changes” is selected. This is 
consistent with Windows. 

●​ (Mac) Fixed a typo in the “Glue to” drop down of the Components Browser. 
●​ (Mac) Removed the “resolution” option for image export dialog because all 

images are exported as 72-dpi. 
●​ (Mac) Fixed an issue where changes made to print settings persisted after 

clicking cancel. 
●​ (Mac) Added a "save the changes?" message when closing a modified file 

after "Save A Copy As". 
●​ (Mac) Fixed an issue where SketchUp thumbnail previews were not always 

visible when saving models with File > Save and File > Save as. 
●​ (Mac) Fixed an issue where revert was incorrectly enabled for 

unsaved/unchanged models. 
●​ (Mac) Fixed an issue in which snappy dialogs could break apart when a dialog 

was closed and SketchUp relaunched. 
●​ (Mac) Fixed an issue in which reloading a component pointed to the incorrect 

directory. 
●​ (Mac - High Sierra) Fixed an issue where components, materials, styles, and 

templates sorted incorrectly on macOS High Sierra. 

LayOut and Style Builder Release Notes 



What"s New? Better LayOut, Much Better Drawings 

LayOut is where people harvest their 3D work in SketchUp to produce excellent 
drawings. Without apology, our commitment in LayOut is to help professionals 
make much better drawings, much quicker, and with as much control as they need. 

Preferences 

●​ Your existing user preferences will now migrate when upgrading. 

Scaled Vector Drawing 

Now you can use LayOut"s vector illustration tools to draw in 2D at scale. Use your 
SketchUp model as a scale basis to create blocking details. Or create your own 
scaled illustration to add details not necessary in your 3D model: dashed lines or 
blocking, for instance. Re-set scales as you wish and your work will resize as 
necessary. As you would expect, your scaled drawings are fully supported by 
LayOut"s Dimension and Label tools. 

●​ Create from scratch via the Scaled Drawing Inspector 
○​ Enter Make Scaled Drawing, select a scale entities will be displayed at 

and then begin drawing at full size 1:1. 
○​ User can also select existing entities then enter Make Scaled Drawing 

and the selected entities will be placed in the Scaled Drawing. ​
 

●​ Create via existing group 
○​ Select an existing group, context click and select the Scale. ​

 

DWG Imports One reason that drawing in 2D at scale is important is that a lot of 
LayOut users are trying to work with imported AutoCAD geometry via the DWG 
format. So in this release, we"re introducing LayOut"s ability to import DWG files as 
native LayOut entities. DWG projects import at scale and support the pages, 



titleblocks, and blocks that your partners have created. Even better, LayOut users 
can now help themselves to the vast world of free DWG libraries. 

●​ Paper Space 
○​ Paper Space is the default setting on the importer that will bring in 

AutoCAD Paper Space data 1:1 and Model viewport data (if available) 
at the predefined scale. If the incoming AutoCAD drawing has multiple 
Paper Space options, the user has the ability to select a different one 
via the dropdown menu. 

●​ Model Space (Only) 
○​ Checking the Model Space (Only) option will bring in only the Model 

Space data at full size 1:1, place it in a scaled group that is then fit to 
the current paper size. This is an arbitrary scale and can be changed to 
whatever scale you choose. 

●​ SketchUp model reference 
○​ Checking the SketchUp model reference option will bring in the viewport 

and the Model Space (Only) data as a scaled SketchUp model 
reference. 

All imported data is brought in at the scale and units based on the AutoCAD file. 
AutoCAD files that contain a perspective view either in the Model Space or within a 
Viewport are brought in as a SketchUp model reference by default. 

Group Edit 

To support scaled drawings, we made a juicy change we think LayOut regulars will 
notice right away: Editing grouped entities in LayOut now works just like it does in 
SketchUp including single entity groups. That means it"s wayyyy easier to draw and 
manipulate grouped entities. LayOut users can also control “rest of document” 
visibility when editing within a group. Does anyone else smell a new custom 
keyboard shortcut? 

Drawing Tool Improvements 



In this release, we have made a number of improvements to how you are able to 
draw. To keep track of them all we have listed them out. 

●​ Selection Improvements 
○​ New Add and Subtract Selection Modifiers that match SketchUp"s 
○​ ESC key now will cancel a Move, Scale or Rotate operation 
○​ With a revised Move to Layer rt. click context UI, you can now move 

entities to a locked layer ​
 

●​ We now allow for Array operations in the Offset Tool 
○​ Define offset distance (imperial or metric) or offset quantity, including 

whether to insert additional offset paths in between the original entity 
(#/) or not (#x). 

●​ "Centerpoint" snaps are now available for all un-joined Arcs 
●​ We defined a separate "Object Center" snap 
●​ 2pt Arc Tool improvements: 

○​ "A" now defaults to the 2pt Arc Tool 
○​ A "Tangent" snap is available  
○​ Ability to add a "Fillet" - Define a fillet radius at the 3rd point 
○​ Able to add a "Chamfer" - By entering a radius of 0 at the 3rd point 

●​ Refined our Inferencing to make them more intelligent 
●​ Path Manipulator improvements: 

○​ Ability to select and move multiple points or line segments - taking 
advantage of the new selection improvements. 

○​ Ability to numerically move points or line segments 
○​ New vertex and segment highlighting 
○​ New "Add Vertex" icon 
○​ Delete key will now remove selected points or line segments  

●​ Path Tool improvements: 
○​ Option to disable Auto Join Lines via a rt. click context menu  
○​ You are now less likely to accidentally add a Bezier segment when 

using the path tool to create straight lines. 

Multi Viewport Dimensioning 



What sounds like an enabling physics concept for teleportation is actually a pretty 
simple LayOut idea. You should be able to draw dimensions across SketchUp 
viewports in order to create an excellent section detail like this…  

Precise Dimensions 

You can set the same level of dimension precision in the LayOut Dimension Style 
panel as you can in SketchUp. You can now be as precise as SketchUp dimensions. 
That"s up to 0.000001 inches. Do the math: that means LayOut can show the 
decimal equivalent of 1/64” (0.015625”). 

Advanced Attribute Labels 

Like all of the information in your model, SketchUp"s new advanced attributes are 
available when you draw LayOut labels. 

Other LayOut Improvements Entity Locking 

Similar to group editing, locking entities is fundamental to how many people 
organize and navigate projects (both models and documents). Now you can easily 
lock individual LayOut entities to cut down on accidental edits or selections. We 
can"t guarantee you"ll be less awkward at parties. ​
 

Bug Fixes/Small Improvements 

In addition to the above, we’ve been heads down fixing bugs and adding some 
smaller features: 

Stability 

●​ Fixed an issue with RTF Text objects would cause a crash with certain files. 
●​ Fixed a crash when pasting certain images not containing size information. 



●​ Fixed a crash in the Offset tool with certain complex shapes. 
●​ Improved overall selection performance. 
●​ Style Builder would crash changing width from 16 to 8. 
●​ We have improved the ability to successfully open certain damaged files. 
●​ (Win) A crash could occur setting certain font types, Modern, Romans or 

Script. 
●​ (Win) Fixed an issue where Style Builder would create two file folders on 

system. 
●​ (Win) Fixed a file save error when doing multiple document saves. 
●​ (Win) Fixed a crash when deleting text within a dimension. 
●​ (Win) We fixed a crash with the Table Manipulator. 
●​ (Mac) Improved the way we handle pdf import. 
●​ (Mac) Fixed an issue related to moving an inspector dialog would cause a 

crash. 
●​ (Mac) Fixed a crash when using text edit on the new MacBook Pro touchpad. 
●​ We fixed a crash when text was inserted over Label Text. 
●​ Users could experience a crash when updating a SketchUp model reference. 
●​ We made a performance improvement when transforming dimensions. 
●​ We fixed a crash when changing from Raster to Vector or Hybrid rendering. 
●​ We had a crash exporting to .dwg if Ignore Fills was unchecked. 
●​ (Win) Fixed an issue where our File Open dialog could get lost when user 

navigated to a different application then back to LayOut. 
●​ (Win) We fixed a crash when changing the file units from Meter to Millimeter. 

SketchUp Model View 

●​ Active SketchUp scene is displayed in the inspector on import 
●​ Renaming a SketchUp scene will retain the previous scene and not revert to 

‘Last Saved SketchUp View’. 
●​ Fixed an issue where resizing a viewport would prevent accurate snapping. 
●​ Down saved SketchUp file would display Autotext incorrectly. 
●​ Moving a Labeled SketchUp model will now move the labels correctly. 
●​ Fixed an issue where user would not be able to snap to a SketchUp model 

viewport edge, if viewport was clipping any part of the model. 



●​ Labels and Dimensions can now connect to LayOut entities on top of 
SketchUp models. 

●​ We inference section cuts much better. 
●​ Fixed an issue where Dimensions would be incorrect when a SketchUp model 

view was rotated orthogonal but a non standard view. 
●​ Hovering over a SketchUp model will produce “Model” inference points 

indicating you are connecting to the model. LayOut entities will continue to 
display the standard inference points. 

Offset Tool 

●​ Fixed an issue where the offset tool would flip the direction of an entity. 
●​ Offset display improvements. 

DWG Export 

●​ We now provide the option to export raster-rendered SketchUp models as 
hybrid-rendered. 

●​ We now place exported images on an ‘Images’ layer. 
●​ We now place viewport borders on a no-plot and off ‘Viewport’ layer. 
●​ We now place exported fills on a ‘Hatch’ layer 
●​ Fixed an issue where locked layers were exported as un-locked. 
●​ Suppressed units are no longer being exported. 
●​ Fixed an issue where perpendicular aligned Dimensions were being flipped. 
●​ Fixed an issue where fills were being applied when ‘Ignore Fills’. 
●​ (Mac) Previously defined export values now persist. 
●​ (Mac) Exported page range was not being respected. 

Table Tool 

●​ Fixed a text alignment issue preventing certain .xls files from being inserted. 
●​ Fixed an issue where cell fill on one sheet of an imported .xls file would show 

up on another. 
●​ Fixed an inconsistency between inserting data into an existing table and a 

new table. 



●​ We fixed an issue where the cell fill would be off if the text was rotated. 
●​ Fixed a focus issue when inserting data in Table Manipulator. 
●​ Fixed an issue with imported EXCEL decimal point formatting error. 
●​ We fixed an issue where alignment would be off with imported EXCEL files 

with merged cells. 

Miscellaneous 

●​ Fixed an issue where it was too easy to create a bezier curve during line 
input. 

●​ Style Builder is now capturing BugSplat data. 
●​ Fixed an issue where the layer created in Presentation Mode was displayed 

incorrectly. 
●​ Better support for some extended character sets when exporting to PDF. 
●​ Fixed an issue where LayOut text would shift when exporting to PDF 
●​ Fixed an issue where line spacing was too big on SketchUp text when 

exported to PDF. 
●​ Fixed an issue where a hidden layer would become active by changing pages. 
●​ Fixed an issue when object snap was on during precise move than grid snap 

wouldn't work. 
●​ A number of Localization and truncation issues have been fixed. 
●​ Inferencing an Arc center on a SketchUp model would cause a soft 

disconnect. 
●​ (Win) Fixed an issue where user was not prompted to save when a file ‘Sent 

to LayOut’ was closed. 
●​ (Mac) Updated the Preferences window so that the content fills all the 

available space. 
●​ (Mac) Fixed an issue where selection would be lost when switching focus to 

another application and then back to LayOut. 
●​ (Mac) Fixed the ctrl+lt mouse functionality within the SketchUp model editor. 
●​ We fixed an issue where filled ellipses would either export unfilled or not at 

all in our PDF exporter. 
●​ A number of translation truncation improvements. 

SketchUp and LayOut API Release Notes 



What’s New? LayOut Ruby API for SketchUp 

This is a new Ruby based API for SketchUp that allows developers to read and write 
LayOut files using the regular SketchUp Ruby API. We’ve taken the existing LayOut C 
API and wrapped it with a Ruby layer and then included that inside SketchUp. This is 
proving to be a great working model for how to expose API functionality to our base 
C API and then expose that exact functionality to a ruby layer without duplicating 
code. 

Sketchup.send_to_layout 

Along with the LayOut Ruby API for SketchUp we added the ability to open LayOut 
files with the LayOut application. This gives developers the ability to write a 
SketchUp extension purely in ruby that parses the SketchUp model, writes a LayOut 
file and opens the LayOut file in LayOut in one smooth motion. This helps create a 
stronger connection between SketchUp and LayOut and can improve user 
workflows through the use of developer created extensions. 

ImageRep 

Hello Ruby API developers, meet Sketchup::ImageRep. This new class exposes a 
data structure internal to SketchUp called an ImageRep. ImageRep is an in-memory 
representation of an image (as opposed to a reference to an image inside the 
SketchUp model). This class exposes a number of image reading and manipulation 
tools to the Ruby API. Now you can get the color of a pixel at a specified uv 
coordinate from an ImageRep, get an array of all pixel data from an ImageRep, set 
pixel data in an ImageRep, save an ImageRep out to disk, and more. Of course 
we’ve also included utilities to convert an in-model texture to an ImageRep, and 
assign an ImageRep object directly to a material as the material’s texture. This new 
class opens up a lot of opportunities to read and manipulate images in the model. 
Check out the ImageRep class in Ruby API docs for more information. 

Exposed Importer/Exporter Options to Ruby API 



We have exposed all the options for our native importers and exporters to Ruby. 
See the Ruby API documentation on Sketchup::Model.import and 
Sketchup::Model.export. 

New SketchUp Features in the API 

A big round of applause for the SketchUp Core team for the improvements they 
have added to the SketchUp application. Well, we also wanted to make sure that 
these new features were accessible to our developer community. We have 
introduced new API features for Named Section Planes and Filled Section Cuts. 
Awesome! 

Ruby Documentation 

You’ve probably already seen this feature in action at ruby.sketchup.com. We have 
been working to improve our Ruby API documents and the publication process. At 
the beginning of the year, we switched from an internally tweaked and maintained 
version of RDoc to YARD for our documentation generation. In the process we had 
to make many alterations to our documentation in the source code. We made a 
specialized YARD template to suit our needs. The Ruby documentation will be 
available to Beta testers within the Resources section of CenterCode. If you are 
especially interested in helping with our Ruby Docs, you can even fork our 
repository, make changes, and submit them to us via a pull request and we can 
incorporate those changes back into our source code and they will go live the next 
time we update the online docs. 

Ruby Handling of Advanced Attributes 

SketchUp core added a feature called Advanced Attributes. This adds some new 
attribute dictionaries and attributes to Component Instances and Definitions by 
default on every model. It should be noted that we have blocked the ability to 
delete the dictionaries via ruby. This should not be possible, please let us know if 



you find a scenario where you are able to do so. You can however delete the 
key/value pairs. The UI will recreate those key value pairs if they do not exist. 

Ruby Improvements and Fixes 

●​ Added method: UI.refresh_toolbars 
●​ Added constants to Geom::PolygonMesh: 

○​ Geom::PolygonMesh::MESH_NORMALS 
○​ Geom::PolygonMesh::MESH_POINTS 
○​ Geom::PolygonMesh::MESH_UVQ_BACK 
○​ Geom::PolygonMesh::MESH_UVQ_FRONT 

●​ Added method: SketchupDefinitionList.remove 
●​ Added Sketchup::Page methods: 

○​ include_in_animation? 
○​ include_in_animation= 

●​ Added Sketchup::SectionPlane methods: 
○​ name 
○​ name= 
○​ symbol 
○​ symbol= 

●​ Added SketchUp::ImageRep class: 
○​ load_file 
○​ save_file 
○​ initialize 
○​ bits_per_pixel 
○​ size 
○​ data 
○​ width 
○​ height 
○​ row_padding 
○​ colors 
○​ color_at_uv 
○​ set_data 

●​ Added Sketchup::Materials.unique_name 



●​ Added Sketchup::Texture.image_rep 
●​ Added Sketchup::Image.image_rep 
●​ Added Sketchup::Material.texture= to accept Sketchup::ImageRep object as 

one of the data types it uses. 
●​ Added rendering options support for filled section cuts: 

○​ RenderingOptions keys added: 
■​ SectionCutFilled 
■​ SectionDefaultFillColor 

○​ RenderingOptionsObserver constants: 
■​ ROPSetSectionCutFilled 
■​ ROPSetSectionDefaultFillColor 

●​ Added Sketchup.send_to_layout 
●​ Added options for all 3D exporters and imports 

Bug Fixes 

●​ Breaking Change - Fixed a bug in Sketchup::Material.name= which allowed 
the API to create materials with duplicate names. Now it will raise 
ArgumentError if it's not unique to the model. 

●​ Breaking Change - Changed Sketchup::Color class to be common between 
LayOut and SketchUp. The potentially breaking change is that 
Sketchup::Color changed to now compare RGBA values instead of the ruby 
objects. 

●​ Breaking Change - Changed Geom::Transformation.identity? So that it now 
properly returns true in all cases where the transformation matrix match the 
values for the identity transformation. 

●​ Fixed Geom::Transformation.scale(float) and 
Geom::Transformation.new(float) to not set the 15th component of the 
matrix, but instead adjust the other fields. 

●​ Fixed a crash when trying to call Sketchup::View.animation from 
Animation.stop 

●​ Fixed a crash when calling UI.menu with empty string. 
●​ Sketchup::Page.erase_page will now correctly delete the Scene tab, like the UI 

does. 



●​ Fixed a bug in Sketchup::ArcCurve.end_angle where it sometimes added 360 
degrees to the returned value. 

●​ Fixed an issue where a Ruby Importer could cause the Import file dialog to 
render the drop-down items incorrectly under Windows due to pipe 
characters in the description. 

●​ Fixed a crash when using -RubyStartup command line argument with a file 
that raises errors while loading. 

●​ Fixed a crash in UI.create_cursor that would happen if the length was less 
than 4 characters. 

●​ Fixed a rare crash in MaterialsObserver. 
●​ Removed the Break Edges option in Windows for DWG importer 

Documentation Note: When an HtmlDialog is closed, all callbacks to that instance 
are cleared. Re-attach them if you need to open the dialog again. 

SketchUp C API Additions and Improvements 

We added new classes and functions to the SketchUp C API in 2017 to provide 
greater benefit to our developers and as part of our continued effort to fully 
deprecate and remove the old C++ API. We are continuing to add more until we 
gain enough coverage to consider the C API at feature parity with the deprecated 
C++ API. Reference the versions.txt file within the SDK to see the new additions. The 
preferences dll in the SDK is now required to use the C API. A change from previous 
versions. 

Additions with a * indicate that there were multiple functions added in that class. 

●​ Added SUAttributeDictionary* 
●​ Added SUBoundingBox3DGetMidPoint 
●​ Added SUComponentInstance* 
●​ Added SUColor* 
●​ Added SUEntities* 
●​ Added SUEntity* 
●​ Added SUImageRepGetColorAtUV 



●​ Added SUImageRepGetDataAsColors 
●​ Added SULengthFormatter* 
●​ Added SULengthFormatRef 
●​ Added SULengthFormatType 
●​ Added SULengthUnitType 
●​ Added SULoopInputRef 
●​ Added SUMaterialIsDrawnTransparent 
●​ Added SUModel* 
●​ Added SUPlane3D* 
●​ Added SUPoint2D* 
●​ Added SUPoint3D* 
●​ Added SUScene* 
●​ Added SUSectionPlane* 
●​ Added SUText* 
●​ Added SUTextureGetAverageColor 
●​ Added SUTransformation* 
●​ Added SUVector2D* 
●​ Added SUVector3D* 

Fixed SUMaterialSetName: now returns SU_ERROR_INVALID_ARGUMENT if the 
material is owned by a model and the name is not unique 

LayOut C API Additions and Improvements 

●​ Added SU_ERROR_ENTITY_LOCKED error codes to applicable LO*Set* 
methods to support LayOut’s new Entity Locking feature 

●​ Changed LO*SetName methods to return SU_ERROR_UNSUPPORTED if the 
name string is an empty string 

●​ Added documentation for an undocumented return possibility 
(SU_ERROR_SERIALIZATION) in LOImageRepSaveAs 

●​ Added documentation for an undocumented return possibility 
(SU_ERROR_NO_DATA) in LODocumentCreateFromTemplate 

●​ Added documentation for an undocumented return possibility 
(SU_ERROR_NO_DATA) in LOStyleGetDimensionUnits 



●​ Added documentation for an undocumented return possibility 
(SU_ERROR_OUT_OF_RANGE) in LOStyleSetStartArrowType 

●​ Added documentation for an undocumented return possibility 
(SU_ERROR_OUT_OF_RANGE) in LOStyleSetEndArrowType 

●​ Added documentation for an undocumented return possibility 
(SU_ERROR_OUT_OF_RANGE) in LOStyleIsArrowTypeFilled 

●​ Added documentation for an undocumented return possibility 
(SU_ERROR_OUT_OF_RANGE) in LOStyleSetSubEntityStyle 

●​ Added documentation for an undocumented return possibility 
(SU_ERROR_OUT_OF_RANGE) in LOStyleGetSubEntityStyle 

●​ Added documentation for an undocumented return possibility 
(SU_ERROR_UNSUPPORTED) in LODocumentRemoveAutoTextDefinition 

●​ Added LOAutoTextDefinitionListRef, which is an object that can be used to 
iterate over all of the LOAutoTextDefinitionRef objects belonging to a 
LODocumentRef 

●​ Added LOAutoTextDefinitionGetMandatory 
●​ Added LOAutoTextDefinitionGetIndex 
●​ Added LOAutoTextGetDocument 
●​ Added LODictionaryClear 
●​ Added LODictionaryGetNumberOfKeys 
●​ Added LODictionaryGetKeys 
●​ Added LODictionaryRemoveEntry 
●​ Added LODocumentAddReference 
●​ Added LODocumentGetAutoTextDefinitionByName 
●​ Added LODocumentGetAutoTextDefinitions 
●​ Added LODocumentGetActiveLayer 
●​ Added LODocumentSetActiveLayer 
●​ Added LODocumentGetInitialPage 
●​ Added LODocumentSetInitialPage 
●​ Added LODocumentGetLengthFormatter 
●​ Added LOEntityGetLocked 
●​ Added LOEntitySetLocked 
●​ Added LOFormattedTextGetDisplayText 
●​ Added LOGroupGetScaleFactor 



●​ Added LOGroupSetScaleFactor 
●​ Added LOGroupGetScaleUnits 
●​ Added LOGroupSetScaleUnits 
●​ Added LOGroupRemoveScaleFactor 
●​ Added LOImageRepGetDPI 
●​ Added LOLayerGetDocument 
●​ Added LOLayerInstanceGetIndexOfEntity 
●​ Added LOPageGetDocument 
●​ Added LOPathAppendPathTo 
●​ Added LOTableGetBorderStyle 
●​ Added LOTableSetBorderStyle 
●​ Added LOTypedValueGetString 
●​ Added LOTypedValueSetString 

Modified LOLinearDimensionCreate to set the initial leader line type to 
LOLinearDimensionLeaderLineType_Bezier instead of 
LOLinearDimensionLeaderLineType_Hidden. 

Breaking change to LOFormattedTextGetStyleRunAtCharacter. This was previously 
mis-implemented. It now takes in a starting character index and a length, and 
returns a LOStyleRef object with style attributes for the specified run of characters. 

Breaking change to LOSketchupModelGetExplodedEntities - an exploded 
raster-rendered model will now wrap the LOImageRef in a LOGroupRef. 

Modified behavior of LORectangle and LOEllipse after ApplyTransform - previously 
these entities would incorporate the given transform by adjusting their intrinsic 
position to match the transform. As a result, invoking GetTransform after a 
SetTransform would return a recalculated transform matrix. With the new behavior, 
these entities will preserve the transformation matrix sent to SetTransform. 

Known Issues:  



Sketchup::Material.name= has a regression bug where setting the name to the 
existing name will also raise an error. (unintended). And that renaming the material 
via the UI might prevent the API from reusing the name until the model is 
reopened. 

Recommended new pattern for setting material name: 

material.name = materials.unique_name('Hello World') 
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SketchUp/LayOut Release Notes 
Fixes for macOS Mojave: 

●​ Fixed a crash that could occur on startup of SketchUp. 
●​ Fixed an issue in LayOut in which the Export Options button overlapped the 

Format drop down preventing selection of a Format. 
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SketchUp Release Notes 
What's New? ​
Graphics Pipeline ​
  

With SketchUp 2017, we have completely reworked our graphics pipeline - i.e., the 
way we display SketchUp models. This was a massive change that will allow us to 
innovate far beyond what we have been able to do in the past. 

This new graphics pipeline has stricter hardware and software requirements than 
in previous versions of SketchUp. To run SketchUp, you will need: 

●​ A 64-bit operating system. 
●​ A graphics card that supports OpenGL 3.0 or above. 
●​ A graphics card that supports Hardware Acceleration. We will no longer 

support software rendering! 
●​ A graphics card that passes a series of tests that are run by SketchUp 2017 to 

assure that your card is capable of rendering SketchUp models. These tests 
include checks like compilation of SketchUp's GLSL shaders and support for 
OpenGL framebuffer objects. 

  



If your machine does not meet these requirements, you will see an error dialog 
when launching SketchUp, LayOut, Style Builder, and Viewer that lets you know 
which requirement you did not meet and which will prevent you from running 
SketchUp until you fix the error. If you see this error dialog, try upgrading your 
graphics card driver - upgrading your driver is a good first troubleshooting step and 
often solves the error. 

High DPI Support for the Modeling Window 

The SketchUp 2017 modeling window is now “DPI aware”. In SketchUp 2016, we 
scaled the User Interface (toolbars, cursors, etc). In SketchUp 2017, we are now 
scaling content in the modeling window so that you can better see the 
masterpieces you are creating! This work includes larger, scaled inference graphics 
and linework and updates to our inference icons. 

Extension Manager 

The Extension Manager is the new way to manage how extensions interact with 
SketchUp. Users will be able to install, uninstall, enable, disable and update 
extensions from this new dialog. In addition, users can set their extension loading 
policy through this same dialog. This is a complete replacement for the extension 
and extension loading policy areas previously found within the System Preferences 
dialog. The Extension Manager can be found within the Window menu on both 
Windows and Mac. 

Tool and Inference Improvements 

As always, we are looking at ways to improve our core modeling tools and 
inferencing. This release is no different. Here's a brief description of what's new: 

Improved Offset tool: Previously the Offset tool would create overlapping or 
self-intersecting geometry. We've changed the tool to automatically trim these 



overlaps to create clean boundaries with no overlaps. The old functionality is still 
available via a modifier key. 

Rectangle tool plane and shape locking: The Rectangle tool now works with arrow 
keys to lock the plane normal to an axis or surface. This includes the ability to lock 
off-axis planes using the down arrow key. Now the Rectangle tool matches the 
inferencing capabilities of the circle and polygon tools. Additionally, pressing shift 
can now lock the proportions of a square or golden section. 

Rotated Rectangle tool plane locking improvement: The Rotated Rectangle tool now 
respects a locked plane across all steps for the tool. If you chose a surface to lock 
the tool to at the beginning, this orientation will persist throughout creating your 
rectangle. 

Perpendicular to Face inference: We added the ability to hover over any surface and 
then find an inference for the direction perpendicular to the face. The drawing line 
and reference surface will be highlighted in magenta and a new “Perpendicular to 
Face” tooltip will be displayed. Note it is not possible to force this inference using 
the down arrow key but it can be locked once it appears by holding shift. 

Component Origin inference: We added a new “Origin in Component” inference point 
which now provides the ability to find and snap to a component's origin. This 
inference shows up whether there is geometry on the origin or not and has higher 
priority over other inferences. It shows up automatically when you hover over a 
selected component or group with a drawing tool. 

Persistent IDs 

Persistent IDs for entities have been added to SketchUp 2017. This feature is useful 
to developers and allows us to improve interoperability between LayOut and other 
products. A unique, persistent ID number is now internally assigned to geometry 
when it is added to a model. This includes unique IDs for edges, vertices, faces, and 
more that will be maintained even if the geometry is moved, rotated, or scaled. 



Colorblind Accessibility 

It is now possible to customize SketchUp's red, green, blue, magenta, and cyan 
inference colors. If you have trouble distinguishing red from green or would simply 
like to customize your SketchUp colors, it is now possible under SketchUp 
Preferences > Accessibility. If you change these settings, you may notice that the 
axis colors will get brighter to match your selected direction colors exactly. In 
SketchUp 2016 and earlier versions, the axis colors were slightly muted relative to 
the inference colors. Also note that if you adjust your colors, SketchUp will continue 
to refer to red, green, and blue axis directions in tool tips, the status bar and the 
Instructor. Inference Icons (end-points, mid-points, on edge, etc... ) are also 
unaffected by this feature and will remain their original colors but we have updated 
the shapes to improve visibility. 

Additionally, a new “Color Blind Style” has been added to the “Color Sets” styles 
library. Use this style as a base for dialing in your custom colors and shades. It is 
intended to help maximize people's ability to see when inferences appear. Since 
there are many different types of colorblindness, you may need to edit this style to 
best fit with the colors that work for you. Once you are done, don't forget to set up 
a template with your new style. 

Smarter Graphics Card Settings 

When you launch SketchUp, we are now much smarter about choosing the ideal 
graphics card settings (i.e., the ideal “Pixel Format”) to make SketchUp run the best 
it can. Previously, we sometimes selected settings that didn't allow models to 
display as well as they could have and which had a negative impact on 
performance. 

As part of this work, we have made it easier for you to change your multisample 
anti-aliasing settings in Preferences > OpenGL on Windows. Note though that we 
have chosen the setting that we think is ideal for your graphics card and that if you 
choose too high of a setting, performance and possibly stability may be affected. 



We have added a “Warning“ section to Preferences > OpenGL > Graphics Card 
Details to show any potentially negative conditions related to your graphics card so 
that you can take actions to improve your situation. Note that if your graphics card 

shows warnings, you will see a big warning icon  on the Preferences > 
OpenGL dialog with some text that explains you need to click the Graphics Card 
Details button for more information. 

Standardized Product Content Locations 

We have standardized where product content, stuff like collections of components, 
materials and styles are stored on the file system. 

On Windows, we moved the default content that comes with SketchUp 
(Components, Materials and Styles) out of the Program Files directory and placed 
them in the ProgramData directory. And on both Windows and Mac, we created 
Components, Materials, Styles and Templates folders for your user related content. 
By default, these folders are in the following locations: 

Windows: C:\Users\<username>\AppData\Roaming\SketchUp\SketchUp 
2017\SketchUp ​
Mac: Users/<username>/Library/Application Support/SketchUp 
2017/SketchUp/ ​
  

Note that if you store your content in these folders, it will show up in the 
Components, Materials and Styles browsers without you having to do anything and 
your templates will show up on the Templates pane as well. Additionally, users no 
longer require special privileges in order to modify the contents of these folders. 

We have made it easier for you to access your content by adding new functionality 
to the Preferences > Files pane on Windows and we added this Preferences pane 



on the Mac. Simply click the Open in Explorer/Finder buttons to access your content 
vs. having to remember the folder locations listed above. 

Improved Group to Component workflow & Component handling with Solid Tools 

We now present the create component dialog when converting a group to a 
component. This allows users to set the full range of component attributes when 
converting instead of having to go back and edit the resulting component in Entity 
Info or the Components dialog. This workflow helps a great deal when using the 
Solid Tools on components. The Solid Tools still create groups but it's quick to use 
the create component option to redefine your desired component definitions. 

Support for macOS Sierra 

Our QA team has smashed and banged on Apple's newest operating system, 
macOS Sierra, enough to say that SketchUp 2017 is fully compatible. 

Trimble Connect Extension 

The Trimble Connect Extension has been rewritten to utilize changes to the Trimble 
Connect and SketchUp Ruby APIs. Updates and new features include: 

●​ Sign in: You can now use a Trimble ID or a Google account to sign in. 
●​ Improved File Management: We've reworked the Open and Publish dialogs to 

make it faster to browse through your projects on Connect. 
●​ Collaboration Manager: A new dialog which allows you to create and manage 

ToDos, manage reference models and add comments about a model. The 
buttons across the top allow you to see the various panes: ToDos, 
Comments, Reference Models and Launch Trimble Connect 

○​ ToDos - Create and Manage ToDos from the Collaboration Manager. 
Note that in order to view ToDos they must be associated with the 
model you are working on in SketchUp. If you want to view all the 
ToDos in a project use the full Connect web interface by Connect Icon 



in the upper right of the collaboration manager or accessing Connect 
in a web browser. 

○​ Comments - Click the icon showing two speech bubbles to view the 
comments pane. There you can view the comments for a model and 
add new comments. 

○​ Improved Model Referencing - Click the chain link icon to view the 
Reference Model pane. At the bottom of the Reference pane there are 
buttons for importing a new reference model as well as deleting or 
updating all existing reference models. Click the arrow next to a 
specific reference model to edit its alignment and save that 
adjustment back to a project. You can also individually update a 
reference model by clicking the Cloud + arrow icon next to the 
reference model's name. 

Bug Fixes/Small Improvements 

In addition to the above, we've been heads down fixing bugs and adding some 
smaller features: 

Stability 

●​ Fixed several crashes that could occur when opening or working in models 
that had a texture with no associated texture image. 

●​ Fixed a crash that could occur when printing a model with sketchy edges. 
●​ Fixed a crash that could occur when printing large models with textures. 
●​ Fixed a crash that could occur when exporting an animation that has 

watermarks and scenes with different edge styles. 
●​ (Win) Fixed a very frequent crash that could occur when modeling in 

SketchUp on machines with an Integrated Intel HD Graphics 5500 graphics 
card. 

●​ (Win) Fixed a crash that could occur when exporting animation as .webm or 
.ogv with a specified custom frame size. 

●​ (Mac) Fixed a frequent crash when opening models which have the sun 
direction nearly perpendicular to the eye direction. 



●​ (Mac) Fixed a frequent crash that could occur when importing a wide image 
or when opening a model that has a wide image. 

●​ (Mac) Fixed a crash that could occur when uploading a model after canceling 
the upload of a component to 3D Warehouse. 

●​ (Mac) Fixed a crash that occurred when closing a file with either the 
Dimensions tool or Texture Position tool active. 

●​ (Mac) Fixed an issue where SketchUp would sometimes crash after adding a 
location to a new model. 

●​ (Mac - Sierra) Fixed an intermittent crash that could occur when quitting and 
discarding changes with multiple documents open. 

●​ (Mac) Fixed a crash that could occur when closing a document after switching 
between documents. 

Model Display / Image Export 

●​ Re-wrote how we display transparency, including making the following 
changes: 

○​ Improved performance significantly. 
○​ Improved the accuracy of the appearance of the model. 
○​ Removed “Medium” transparency from the Transparency Quality 

dropdown. Pre SU 2017 models which use “Medium” transparency will 
now default to “Faster” transparency. 

○​ Added an “X-ray opacity” slider which applies when x-ray mode and 
nicer transparency are selected (defaulting to 65% for nicer 
transparency and remaining at 50% for faster transparency). 

○​ Improved the enable/disable behavior on the Face tab of the Styles 
dialog so that the controls are enabled only when they will actually 
change the model. 

●​ Fixed an issue where shadows on face me component flashed in exported 
animations. 

●​ Fixed an issue where, when using color by axis, lines could incorrectly display 
as if they were on axis when they were not. 

●​ Fixed an issue where the selection highlight for a nested section plane looked 
wrong. 



●​ Fixed an issue where alpha images did not display when using the wireframe 
face style (when other images did display). 

●​ Fixed an issue where the leader for view-based text drawn close to faces 
drew incorrectly. 

●​ Fixed an issue where sketchy edges could appear blurry when using the 
Maximum Texture size option. 

●​ Fixed an issue where the face selection highlight did not display correctly 
when using the Fade Similar Components option. 

●​ Fixed an issue where nested section planes did not always cut geometry as 
expected. 

●​ Fixed an issue where components in large models degraded to bounding 
boxes / other display elements dropped out of the model faster on AMD 
cards than other graphics cards. 

●​ Fixed an issue where materials incorrectly displayed as transparent when 
material transparency was off and x-ray was on. 

●​ Fixed an issue where the ground plane could z-fight with faces when in top 
view. 

●​ Fixed an issue where, when turning off section cuts, the foreground image of 
a matched photo was not always displayed. 

High DPI / Cursors 

●​ Elements in the modeling window (e.g., edges/edges effects, inference 
icons/linework, selection highlight, the matched photo/texture position grids, 
the model/component axes, guides, text/dimensions and the component 
bounding box) are now scaled and should look better on high DPI monitors 

●​ Select region for edges and general “snapping” is now scaled and should 
improve selection on high DPI monitors. This will change the way SketchUp 
“feels” on larger resolution screens or when the display has been scaled in 
the OS preferences. 

●​ Updated inference icons graphics including new “Origin” inference icon. 
●​ Updated Position Texture tool icons. 
●​ (Win) Fixed issue where tool cursors would not show up when using 

shortcuts until the mouse was moved with Instructor dialog open. 



Tools and Inferencing 

●​ Added the ability to create guidelines from “On Face” inferences with the 
Tape Measure Tool. 

●​ Fixed an issue with the Rectangle tool in which dimensions displayed in the 
VCB (Measurements toolbar) did not always match the actual dimensions. 

●​ Fixed an issue with the Rectangle tool where a square or golden section 
could not be found when there was an active From Point inference. 

●​ Fixed an issue with the Rotated Rectangle tool where the protractor 
remained visible when moving the cursor out of the drawing window. 

●​ Fixed an issue with the Rotated Rectangle tool where an invalid input 
message was not received when entering invalid input in the VCB 
(Measurements toolbar) in some specific cases. 

●​ Fixed an issue with the Rotated Rectangle tool where an invalid input 
message was displayed when entering the same dimensions in the VCB 
(Measurements toolbar) after rectangle was drawn. 

●​ Added Instructor content for Rotated Rectangle to reference click and drag 
functionality. 

●​ Fixed an issue with the Circle/Polygon tools in which they could snap to axis 
inferences that didn't exist when off axis. 

●​ Fixed an issue with the Circle/Polygon tools in which they seemed to 
disappear during drawing and couldn't be completed when the radius was 
aligned with the axis normal to the circle/polygon. 

●​ Added error checking when entering number of segments in the VCB 
(Measurements toolbar) for Arcs/Circles/Polygons. 

●​ Removed the visual cues (endpoints and center) for Arcs/Circles/Polygons at 
small pixel views. Zoom in to see the cues if they are not visible. 

●​ Fixed an issue where an arrow key axis constraint was not released as 
expected if the last visited edge was outside the locked plan for protractor 
based tools. 

●​ Fixed an issue with protractor based tools where the locked/unlocked plane 
tooltip would continue to show and highlighting would not reset after 
pressing escape. 



●​ Fixed an issue where a parallel inference was lost after escaping out of Arc, 
Pie, and Move tools. 

●​ Fixed an issue where the Line, Tape Measure, and Move tools would lock a 
direction using arrow keys before first click. 

●​ Fixed an issue with the Move tool in which the angle value in the VCB 
(Measurements toolbar) did not always update appropriately when rotating 
with the Move tool while on an inference. 

●​ Added ability to inference original selection set when using rotate/copy. 
●​ Fixed an issue where an inference remained locked when panning followed 

by orbiting after having released shift. 
●​ Fixed an issue with the Scale tool in which Reset Scale did not redraw the 

scale boundaries correctly. 
●​ Fixed a cosmetic issue with the 2 Point Arc in which it would incorrectly 

highlight magenta when constrained with an axis arrow key after second 
click. 

●​ Fixed a cosmetic issue with the 3 Point Arc in which the line connecting the 
endpoints would lose axis coloring if the arc was a quarter, half, or three 
quarter circle. 

●​ Updated the VCB (Measurements toolbar) label for the Move tool from 
“Length” to “Distance” to more accurately describe the action. 

●​ Standardized references to shift in Instructor content for protractor/plane 
based tools. 

●​ (Mac) Fixed an issue with Rotated Rectangle in which it could snap to an 
angle that was one degree off of what was expected. 

Groups, Components and Solid Tools 

●​ Updated labels for Components/Groups in Entity Info (“Name” changed to 
“Instance”) and Create Component Dialog (“Name” changed to “Definition”) 
for added clarity. 

●​ Group Instance name is populated as the Component Definition in the create 
component dialog when converting a group to a component. 

●​ Revised message when editing or reloading a component with locked 
instances to clarify what will occur. 



●​ Fixed an issue in which the file name could be truncated when trying to 
reload a component that was previously imported or downloaded from 3D 
Warehouse. 

●​ Added ability to modify one instance of a component with Solid Tools and 
have all instances reflect that change by leveraging the updated group to 
component workflow. After modifying with a Solid Tool, right click and select 
Make Component, choose the definition name to be overwritten and this will 
then replace all instances of the component. 

Add Location 

●​ Fixed an issue where Add Location buttons could overlap each other. 
●​ Fixed an issue where the Add Location dialog could display poorly at high 

DPI. 
●​ Fixed the Add Location window from resizing when grabbing consecutive 

locations. 

Licensing 

●​ Fixed the error message that was displayed for expired private network 
licenses. 

●​ Fixed an issue in which a license was unable to be activated if there was an ë 
character in the username. 

●​ Updated the message seen when launching SketchUp with all of the network 
license seats in use. 

●​ Updated the message seen when launching SketchUp while offline with a 
network license. 

●​ Updated the message seen when an offline checked out network license has 
expired. 

●​ Updated the message seen when trying to check out a network license that 
has no checkout days associated with the license. 

●​ (Win) Fixed an issue in which some SketchUp Make users could not run 
SketchUp Make due to a licensing error. 

Mac Improvements 



●​ (Mac) Added the ability to toggle the scroll direction for zooming. This option 
is available under the new “Compatibility” pane in SketchUp Preferences. 

●​ (Mac) Added the ability to show model previews in Finder. 
●​ (Mac) Added ⌘, shortcut to display SketchUp Preferences. 

Miscellaneous 

●​ Improved performance of move/copy operation with multiple copies of a 
component. 

●​ Made a change in which a modified style that has not yet been updated will 
revert to the original style when switching scenes or clicking on the same 
scene. 

●​ Changed the default value in the warning message you see when adding a 
new style to “Save as a new style”. 

●​ Fixed an issue with the Components and Scenes dialog in which the list views 
did not resize properly when the dialogs were resized. 

●​ Fixed an issue where long layer names did not display when in the Layers 
toolbar. 

●​ Added a Persistent ID validation to the validity check to check for duplicate or 
missing Persistent IDs. 

●​ Potentially fixed an issue where, on a few configurations, saving a model 
caused a hang which could only be fixed by running a special registry script. 

●​ Darkened the Instructor text to make it easier to read. 
●​ Fixed an issue where non-Administrator users could not save templates. 
●​ Improved error message when trying to import a model into itself. 
●​ Added an error message when attempting to reload a higher version 

component and revised the message when attempting to import a higher 
version file. 

●​ Fixed an issue where file paths with Unicode characters could not be 
exported/imported via Preferences > Files. 

●​ Fixed an issue in which animation exports were skipping section plane 
animations. 

●​ Fixed an issue in which the length of an ellipse or a copied ellipse was 
reported incorrectly. 



●​ Removed Endpoints and Extension edge settings from the Architectural 
Design Style. 

●​ Fixed a typo in the Interior and Production Design template descriptions. 
●​ Removed an unused “Material1” from the 3D Printing templates. 
●​ Updated our Welcome dialog and product images. 
●​ Improved an issue where SketchUp would incorrectly display offline Learn 

tab content when online. 
●​ Added a Polish build. 
●​ Fixed a number of translation and truncation errors in localized builds. 
●​ (Win) Added the ability to view .skm and .style thumbnails. 
●​ (Win) Fixed an issue where the File Locations folder would open to the wrong 

directory in SketchUp Preferences after importing new Preferences. 
●​ (Win) Fixed issue in which the Section Plane icon on the Section toolbar was 

missing text. 
●​ (Win) Updated “System Preferences” dialog title to “SketchUp Preferences”. 
●​ (Win) Removed Cancel button from delete tray warning dialog since it is 

redundant with the No button. 
●​ (Win) Removed commas from the invalid tray name message to improve 

clarity on what characters are invalid. 
●​ (Win) Fixed an issue where a SketchUp model could be deleted when opening 

it as read only and saving it with the same name. 
●​ (Win) Optimized the size and position of some of SketchUp's web dialogs. 
●​ (Win) Updated the rendering mode used for the Dynamic Components 

extension. 
●​ (Mac) Fixed an issue where snappy dialog containing Entity Info could break 

apart when selecting entities or could show a gap when switching between 
documents. 

●​ (Mac) Fixed an issue where the desktop would switch unexpectedly when 
using multiple desktops. 

●​ (Mac) Moved the “Component/Group Highlighting” bounding box option to 
the new “Compatibility” pane in SketchUp Preferences for consistency with 
Windows. 

●​ (Mac) Fixed issue in which SketchUp would overwrite a read only file on save. 
A warning message now appears when attempting to save a read only file. 



●​ (Mac) Added file locking so that if a file is open and then an attempt is made 
to open it in a separate session or version of SketchUp on the same machine, 
a message will pop up indicating it will open as Read Only. 

●​ (Mac) Fixed an inconsistency in the Choose Watermark dialog text. 
●​ (Mac) Fixed an issue where SketchUp did not show user created material 

folder if they were named the same as our standard material folders. 
●​ (Mac) Fixed an issue in which a material could be replaced unexpectedly 

when in edit mode and selecting a different In Model material. 
●​ (Mac) Fixed an issue where the icon for the Trim tool was incorrect. 
●​ (Mac) Fixed an issue where SketchUp could get confused when moving your 

cursor between two open models while drawing. 
●​ (Mac) Fixed an issue where fonts printed larger when Vector Printing was 

selected. 
●​ (Mac) Fixed an issue where a material's HSB values were not refreshed to 

show the values for the material being edited. 
●​ (Mac) Fixed an issue where the Preferences dialog could disappear behind 

the SketchUp drawing window when clicking in the drawing window. 
●​ (Mac - Sierra) Fixed an issue in which a crash message appeared when 

toggling section planes or section cuts from the View menu. 
●​ (Mac - Sierra) Fixed an issue in which you could see duplicate icons in the 

dock when launching SU and File > Send to Layout was grayed out. 

LayOut and Style Builder Release Notes 
What's New? ​
Native Tables 

Create a table: For LO 2017 we have added the much requested and necessary 
Table tool. You can now create a multiple row and column table that is easily 
customized to fit your needs. So, if you need to create a schedule, cutlist or legend 
look no further than the new Table tool. 

Table Editor: Double click to enter the table manipulator where you will be able to 
enter text, merge cells, add/delete rows or columns, change the size/spacing, rotate 
text or split the entire table. You can further customize your table by editing the 



Shape Style settings for lines and cell fills. These styles can be applied to other 
tables with the Styles Tool. 

Insert Table Data 

You can now import .csv, .tsv and .xslx spreadsheet files into LayOut as… you 
guessed it: Tables! Spreadsheets imported to LayOut are dynamically referenced 
just like SketchUp models and image files. If your linked file changes, you can 
update the reference to display the new data or re-link to an updated spreadsheet. 
From XSLX files, you can import any sheet you like and also formatting you've 
already dialed in. An intentional bonus: it's now pretty easy to create beautiful 
tables from the data in your SketchUp model. Use Generate Report (or an 
extension like Cutlist) to generate a .csv for your LayOut document. 

If your tables typically use a certain style, you can save a styled table in a scrapbook. 
When you're ready to create a new table, bring in your sample from the scrapbook. 
You can then enter data in LayOut or insert data into the table from an external file. 

When inserting .xlsx files, you can import and update just the data, or the data and 
the formatting. 

High DPI Support for the Drawing Window 

LayOut's drawing window is now DPI aware by scaling the inference graphics 
appropriately. 

Persistent IDs 

As stated in the SketchUp portion, Persistent IDs will benefit LayOut by providing a 
unique, persistent ID to keep dimensions and labels attached to the desired 
geometry even when the model changes. When an existing file that had been 
labeled and dimensioned prior to our implementation of PID's is opened, LayOut 
will attempt to connect to the object directly below. 



Soft Disconnect: When attempting to connect a dimension or Label cannot be 
achieved automatically, LayOut will display what is called a “Soft Disconnect”. These 
disconnects will be shown with a non printable red box around the text. 
“Reconnecting” dimensions or labels can be done by either selecting the object(s), 
rt. click and select “Reconnect to Model” or entering the “Dimension Editor” (a 
double click on the dimension), and moving the disconnected endpoint(s) so that it 
reconnects to an object. These highlighted “Soft Disconnects” can also be 
suppressed by navigating to the View pulldown, Warning Symbols and unchecking 
Disconnected Annotations. 

Dimension Improvements 

We have updated dimensioning to be more fluid with ‘Flexible Dimensions'. Now 
you can drag the dimension line without affecting the dimension's offsets or 
connections. 

 
Offset Tool 



What started as a fun ‘hackathon' project is now being released to the public. The 
long awaited and often requested feature is now in your hands. Offset away on 
lines, arcs, rectangles, circles, polygons and objects with boundaries. 

DWG/DXF Exporter improvements 

We have heard the complaints and felt your pain with our previous DWG/DXF 
exporter so we have done some major rework on it. 

One DWG file: You can now export your multiple page document and it will be 
contained in one DWG file. LayOut objects will be contained in paperspace while 
non-perspective SketchUp objects will be placed in a scaled modelspace viewport. 
Perspective views will be hidden line drawings contained in the paperspace. 

Native DWG Objects: Circles, Arcs and Dimensions, (Linear and Angular along with 
Labels) will now export as native DWG objects, so your dimensions will not be 
exploded, and circles and arcs will no longer be segmented splines by default. Our 
new Table entity is also exported as a native DWG table. You can always uncheck 
this option if not desired. 

Color by layer: We now support Export Entities as Color by Layer. If the user checks 
the color by layer option, we disregard all LayOut's color information and assign an 
index color to each LayOut layer. All entities on a layer are exported as one color. 

If the option is unchecked, black is exported as index 7. Other colors are exported 
as true colors. 

Linetypes: Defined linetype scales are now being respected. 

Clipping Masks: Clipping masks over images and SketchUp viewports are now 
exported instead of being ignored. 



Annotation: Text and how it is exported has been revised to be the correct font, 
location and scale. 

Progress Bar: We added a progress bar during export 

Select Tool Modifier Key 

In previous versions of LayOut, it's been easy to inadvertently move things when 
attempting to do a click-drag selection. We've added a modifier key (Cmd on Mac, 
Alt on Win) to allow you to click-drag without moving anything! 

Graphics Pipeline 

LayOut has been updated to take full advantage of the new Graphics Pipeline work 
completed within SketchUp. In order for us to do this we had to do some major 
work under our hood. As a result, we will also have the same restrictions 
mentioned in the SketchUp Graphics Pipeline section. The original COM based 
viewing library has been torn out and replaced with a new version built on top of 
the SketchUp C API. 

Colorblind Accessibility 

LayOut will pick up SketchUp's colorblind preferences. The colors you set in 
SketchUp will show up as inference colors in LayOut. 

Standardized Product Content Location 

LayOut uses SketchUp's new Standardized Product Content Location for our Styles 
files but everything should work as it has. 

View Settings for Warning Symbols 



We added commands in the View menu to hide or display the warning symbols for 
clipped text (red overflow arrows), unrendered skps (yellow caution triangles), and 
disconnected dimensions + labels (highlighted red text). These view settings should 
be saved with the LayOut file. 

Bug Fixes/Small Improvements 

In addition to the above, we've been heads down fixing bugs and adding some 
smaller features: 

Stability 

●​ (Win) Fixed a crash if not online and user had scrapbooks contained on a 
network drive. 

●​ (Win) Fixed an issue where Style Builder would experience an unhandled 
exception error when saving a file twice. 

●​ (Win) Fixed various crashes when shutting down StyleBuilder. 
●​ (Mac) Fixed an issue with the Scrapbook where if you had a stamp active and 

then accessed a different scrapbook you could crash. 

DWG/DXF Export 

●​ Fixed an issue where a file exported to DWG would move the position of text 
and require a lot of post export work. 

●​ Fixed an issue where custom rtf indentations were lost when exported to 
DWG/DXF. 

●​ Fixed the issue where exporting hybrid viewports, would export the image 
with 'edit' quality setting. 

●​ (Mac) Certain common fonts not exported to .dwg. 
●​ (Mac) Certain text attributes (bold, italic, underline, etc.) could have been lost 

when exported to .dwg. 

High DPI / Cursors 



●​ Updated the inference hints to be High DPI aware. 
●​ (Win) The about LayOut… dialog has been updated for High DPI monitors so 

that the background image is no longer distorted. 

Miscellaneous 

●​ Fixed a bug where transparent faces would change hues if the background 
was toggled off. 

●​ Fixed an issue where opening a file that was created on Windows in Mac 
would add a blank space at the end of a text string. 

●​ Fixed an issue when creating a tray that an incorrect message was displayed. 
●​ Fixed an issue where you will lose the ability to open an inserted .rtf in an 

external text editor if you have given the .rtf box a fill or stroke. 
●​ Fixed a signing issue with the SDK. 
●​ Standardized the Shape Style tray on localized builds to use the “pt” label. 
●​ We have reworked the default size of our warning dialogs so they do not 

appear so small when viewed on HiDPI monitors. 
●​ We have fully implemented ‘Suppress Move' by adding the modifier key Alt+ 

on the PC and Cmd+ on the Mac. 
●​ Fixed an issue when using the Shift key to extend a selection. 
●​ Fixed an issue where dimension units were being translated incorrectly on JA 

builds. 
●​ We revised the Endpoint and Midpoint inference icons to better match 

SketchUp's new icons. 
●​ Fixed an issue where the group manipulator would remain active when 

adding/changing pages. 
●​ Fixed an issue where changing the page when after entering skp edit for a 

model within a group, the group's bounding box can be seen on the other 
page. 

●​ We have improved the behavior when double-clicking to exit SketchUp edit. 
●​ We have fixed "Check for updates". 
●​ We have made a number of translation and truncation fixes for our localized 

builds. 



●​ (Win) Revised the PT-BR Style Builder truncation issue in the header of the 
Sets panel. 

●​ (Win) LayOut now supports 4x Multisample Anti-Aliasing by default during 
Edit 3D View. 

●​ (Win) Fixed the 'Styles' folder icons so that they are not small and have black 
backgrounds. 

●​ (Win) Open Source Credits have been added to the About LayOut… dialog. 
●​ (Win) Fixed an issue that caused us to get incomplete BugSplat data for 

LayOut crashes. 
●​ (Mac) We fixed a bug where viewing a SketchUp model in x-ray mode would 

display incorrectly. 
●​ (Mac) We have removed the built in Mac specific rtf table tool from the Text 

-> Table…. menu. The new LayOut Table tool should be used instead. 
●​ (Mac) Retina Mac Only: Fixed an issue with zooming while in Edit 3D View on 

a external monitor would not zoom at the mouse cursor location. 
●​ (Mac) We have fixed some misaligned text on Export PDF dialog. 

SketchUp API Release Notes 
What's New? 

For a complete list of all new features and bug fixes, see the Release Notes page 
that we maintain for developers here: 
http://ruby.sketchup.com/file.ReleaseNotes.html. 

Ruby 2.2 

Yes, its that time again - time to update our Ruby Interpreter. We have upgraded to 
Ruby version 2.2.4. We're hopeful that extensions that use pure ruby will be able to 
upgrade to Ruby 2.2 with little difficulty. Please note that any compiled C extensions 
will need to be rebuilt. 

Embedded Web Framework 



One of the developer features we are most excited about for SketchUp 2017 is a 
new Web Dialog framework. For SketchUp 2017 we are bundling the Chromium 
Web Browser with the SketchUp installer. What?! Yes, now SketchUp comes 
pre-packaged with a single web browser for both Mac and Windows clients. No 
more trauma from banging your head against the wall while trying to make your 
web pages compatible with Internet Explorer 8-11 and Safari. 

In order to maintain backwards compatibility, we have implemented a new 
HtmlDialog class in the Ruby API and we have not altered the existing WebDialog 
class. Extensions that use WebDialogs should continue to work with no changes 
required. 

New Ruby API Documentation 

We have been working to improve our Ruby API documents and the publication 
process. We switched from an internally tweaked and maintained version of RDoc 
to YARD for our documentation generation. In the process we had to make many 
alterations to our documentation in the source code, we made a specialized YARD 
template to suit our needs. What we have now is a simple way to regenerate the 
documents in a matter of seconds, and we can push them to a git repo, where they 
are immediately available publicly. A process that used to take hours of manual 
html editing and special access to our Sketchup.com webserver, has been reduced 
to about a 10 minute process to generate and publish the documentation. 

SketchUp C API Parity - continued 

We have focused on adding features to the SketchUp C API in 2017 to provide 
greater benefit to our developers and as part of our continued effort to fully 
deprecate and remove the old C++ API in the future. A complete list of functions 
that we have added for 2017 can be found under the developer release notes here: 
http://ruby.sketchup.com/file.ReleaseNotes.html. We are continuing to add more 
until we gain enough coverage to consider the C API at feature parity with the 
deprecated C++ API. 



Updated Compilers 

We updated our compilers for Windows and MacOs. On Windows we are now using 
Visual Studio 2015 SP1 (targeting Windows 7). On MacOs we are using XCode 7.2.1 
(with deployment target 10.10). 

 



November 17, 2016 
Version:​
17.1.174 (Win 64-bit)​
17.1.173 (Mac 64-bit) 

Table of Contents 
​​ SketchUp Release Notes 
​​ LayOut Release Notes 

SketchUp Release Notes 
Fixes/Improvements 

●​ (Win) Fixed a crash that could occur on startup on some machines. 
●​ (Win) Fixed an issue in which UI::Notifications didn’t appear within localized 

builds of SketchUp. 
●​ (Win) Added Chromium Developer Tools. 
●​ (Mac) Fixed an issue in which SketchUp could not be launched due to an 

OpenGL error on some machines. 
●​ (Mac) Fixed an issue in which layers were not sorting correctly when sorting 

by visibility in the Layers dialog. 

LayOut Release Notes 
Fixes/Improvements 

●​ (Win) Fixed an issue when inserting an Excel file containing unicode 
characters on the sheet tab title the file would fail to load. 
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Version:​
17.2.2555 (Win 64-bit)​
17.2.2554 (Mac 64-bit) 
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​​ SketchUp API Release Notes 

SketchUp Release Notes 
Fixes/Improvements Stability 

●​ Fixed a frequent crash that could occur when inserting components and 
doing other actions (e.g., renaming a component, deleting entities, changing 
component properties). 

●​ Fixed a frequent crash that could occur when copy/pasting geometry that 
needs to be merged with hidden geometry. 

●​ Fixed a frequent crash that could occur when doing a copy/rotate after 
having cancelled out of a previous copy/rotate by activating another tool. 

●​ Fixed a frequent crash that could occur on some systems with AMD/ATI 
graphics cards. 

●​ Fixed a crash that could occur when opening/working in some models with 
unfixed validity errors. 

●​ Added a fix for a non-reproducible crash that could occur when using the 
Rectangle tool. 

●​ (Mac) Fixed an issue where simultaneous Component Browser searches led 
to SketchUp crashing. 

Tools and Inferencing 

●​ Made updates to Measurements toolbar entries for tools: 



○​ A closing bracket is now added automatically when an opening bracket 
is entered for both square and angle brackets related to point and 
delta input such as [nn,nn,nn] and (in US locale). 

○​ (Win) SketchUp now recognizes both the decimal and list separators 
that are set within the Windows OS. 

●​ Fixed an issue with the Rotated Rectangle tool where entries in the VCB 
(Measurements toolbar) were not working as expected after the second click. 

●​ Fixed an issue in which Dimensions or Text would snap to a sub-component 
origin instead of the component origin. 

●​ Fixed an issue with the Tape Measure tool in which a model would not 
rescale when measuring two points on a face and entering in a value in the 
VCB (Measurements toolbar). 

●​ Fixed an issue with the Tape Measure tool in which you could not infer from 
a face to create a guideline along another face. 

●​ (Win) Fixed an issue with the Tape Measure tool where guides would toggle 
off when using Ctrl + Z to undo a previous operation. 

Miscellaneous 

●​ Fixed an issue where materials on faces could be lost or faces could be 
flipped after modifying geometry in certain cases. 

●​ Fixed an issue where an offset of an ellipse would sometimes offset as a 
circle. 

●​ Fixed an issue where color swapping/pixelation would occur on very small 
textures. 

●​ Improved Checkup’s messaging for graphics cards that report inaccurate 
memory information. 

●​ Improved our ability to get diagnostic data on startup crashes. 
●​ Fixed an issue where the letterbox bars were displayed incorrectly when the 

Advanced Camera Tools’ aspect ratio did not match the current window. 
●​ Fixed an issue where Advanced Camera Tools did not correctly export 2D 

images. 
●​ (Mac) Fixed an issue where users on certain iMacs were not able to export to 

2D graphic containing transparent backgrounds. 



●​ (Mac) Fixed an issue where exporting a 2D graphic with a transparent 
background would produce jagged edges on certain iMacs. These artifacts 
could also be seen in LayOut. 

LayOut Release Notes 
Fixes/Improvements Stability 

●​ Fixed a Raster and Hybrid Rendering crash that would show up during DWG 
export. 

●​ Fixed a crash related to the Text Edit. 
●​ (Win) Fixed a crash with DWG export when the file being exported was in use 

or the user does not have write permission. 
●​ (Mac) Fixed a Style Builder crash on quit. 

DWG Export 

●​ (Win) Fixed an issue where exporting an individual page would export the 
following page. 

Tables 

●​ Fixed an issue where inserting certain Excel files would fail, we have 
expanded the ability to insert a wider range of Excel formatting. 

●​ Fixed an issue where the user would not be able to update a table when the 
external file was lost. 

●​ Fixed an issue where Excel formatting was used when the ‘Use Excel 
Formatting’ was unchecked. 

PID’s/Dimensioning 

●​ Fixed an issue where entering a new dimension after exiting Edit 3D View 
would produce a wrong measurement. 

Miscellaneous 

●​ Fixed an issue where current camera position would be lost when switching 
to a scene with no camera properties. 



●​ Fixed an issue where Classification attributes were not showing up in the 
Label auto-text dropdown. 

●​ (Win) Fixed an issue where the SketchUp model text can appear too big 
within LayOut. 

●​ (Mac) LayOut now uses SketchUp’s mouse scroll direction. An issue has been 
fixed where the paperspace and modelspace zoom directions were reversed 
when set to mac’s ‘Natural’ scroll direction. 

SketchUp API Release Notes 
Fixes/Improvements General 

●​ (Mac) Fixed issue where SKM files lost attribute dictionaries when saved from 
‘In Model’ to local library. 

Ruby API 

●​ Fixed an issue with HtmlDialogs where SketchUp would crash when the 
dialog was closed before all callbacks were processed. 

●​ Fixed an issue where extensions with multiple periods in filenames would 
not load. 

C API 

●​ Fixed an issue where BSTRToUTF8() returned unreliable data. 
●​ Added SUGetColorOrder() to allow for a platform dependent way to get the 

indices indicating the ordering of color data within 32-bit bitmap images. 
●​ Added SUTextureWriterGetImageRep() to allow for a way to export ImageRep 

from TextureWritter. 
●​ Added SUModelCreateFromBuffer() to allow for the creation of models from 

the bytes buffer. 
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Versions: ​
16.0.19912 (Win 64-bit) ​
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SketchUp Release Notes 

What’s New? ​
Trimble Connect 

Trimble Connect is a new way to store, sync, reference, share, and collaborate on 
design/build projects. Once you've signed up then start uploading .skp, .pdf, .dxf, 
.ifc. files. If you already have an account for 3D Warehouse or Extension 
Warehouse, we recommend that you use the same login (email) when creating a 
Trimble Connect Account. Trimble Connect allows users to publish, open, import 
reference files and update SKPs from Trimble Connect project folders. As you’re 
modeling you can even pull in and update reference SketchUp models as if they 
were locally hosted components. To learn more about Trimble Connect read this 
article. 

Reload Components with 3D Warehouse models 

In SketchUp 2016, a context click on a component gives you the opportunity to 
reload (or swap out) a new component directly from 3D Warehouse. This action will 
reload every instance of that component in your model (similar to the same action 
in the Components dialog), so it’s a helpful method for working with proxy models. 
And if your component was downloaded from 3D Warehouse, you can also use the 
context-click to quickly access its 3DWH details page. 

Generate Report 2.0 



The new Generate Report feature allows you to choose which attributes are 
exported (including a new attribute for capturing quantities), assign an order for the 
columns in your report, and specify a units format. You can even save your 
formatted report as a reporting template, to speed the process of re-running the 
same reports as the design changes. 

Enhanced inferencing and tool improvements 

Learning and utilizing SketchUp’s inference engine makes for fast and precise 
modeling. In this release, we’ve oiled that engine to provide slicker inferencing and 
locking across the board. This improvement is actually an entire set of smart tweaks 
we’ve made to inferencing and locking. Here’s a brief description of what’s new: 

Improved Parallel and Perpendicular Inferences: We’ve improved parallel and 
perpendicular inference display along with the ability to force the last referenced 
edge or plane (depending on tool) with the down arrow. This is particularly handy 
for drawing extending edges on off-axis planes. Now when you are using the 
parallel and perpendicular inferences, sketchUp will highlight in magenta, the entity 
which direction is based off of. Also keep an eye out for the new “Extend Edge” 
tooltip with magenta highlighting when extending lines with the pencil tool. 

Expanded Arrow Key locking: More tools now allow the use of arrow keys to quickly 
lock to a direction or plane. Each arrow key corresponds to a lockable color. Right = 
Red, Left = Green, Up = Blue, Down = Magenta. Additionally, you can now lock 
normals or rotation axis or surface normals prior to first click for tools that leverage 
a protractor or create a surface. These tools include Arc/Pie, Rotated Rectangle, 
Rotation, Protractor, Polygon, Circle and the Section Plane tool. 

Arc/circle: SketchUp will now easily inference circle and arc centers. While we were 
at it, we improved SketchUp’s ability to visualize arc endpoints. Another bonus, you 
can now change the number of segments using new modifier keys (check out the 
status bar right after you’ve drawn an arc/circle). 



Axes tool flexibility: A small but useful change: when changing axes orientation, you 
can now toggle through the exact axes you’d like to pick first using the Alt 
(PC)/Command (Mac) modifier. 

Inference hidden, active section planes: SketchUp will now recognize intersection 
points with hidden section planes. This functionality extends to snapping to 
elements of a SketchUp model in LayOut too: pay attention for a new inference tip 
“Intersection with Hidden Section.” 

Miscellaneous improvements: We’ve also tweaked the Move, Protractor, Offset, and 
Rotate tools with miscellaneous improvements to improve usability and close up a 
few loose ends. Additional improvements are identified in the “Tools” and 
“Inferencing” sections below. 

Customizeable Utility Trays on Windows  

On Windows machines, we’ve re-worked SketchUp’s floating utility dialogs (Styles, 
Scenes, Components, etc.) so that they neatly stack inside customizable, completely 
collapsible trays. This functionality also allows you to group dialogs that you may 
often use at the same time, and is incredibly useful for hiding, browsing, and 
revealing your go-to utilities. 

Refreshed Textures 

Textures make your models pop off the screen (and the page). In this release, we’ve 
reworked our default material libraries, adding contemporary textures and entirely 
new categories. 

Support for High DPI Graphics 

We’re now rendering all of SketchUp, LayOut, and Style Builder toolbar and cursor 
icons from vector graphics. This means they will scale well for a variety of resolution 



settings, with a much cleaner look and better sized icons on High DPI screens in 
particular. 

Extensions Loading Policy 

SketchUp now has three different Extension policies you can select that affect what 
extensions can and cannot be loaded when SketchUp starts. Starting with SketchUp 
2016, Registered Extension Developers can claim their software by signing it 
digitally, saying “I made this”, but in a secure coded format. The three extension 
loading modes correspond to this digital signature that Registered Extension 
Developers add to their extension. 

“Identified Extensions Only” mode means that SketchUp will only load extensions that 
have been signed by one of our Registered Developers. 

“Approve Unidentified Extensions” will load all signed extensions, and pop up an 
approval dialog window on startup that that lets you manually select which 
unsigned extensions you would like to load. 

“Unrestricted” mode will load all extensions, signed or unsigned. You can use this 
mode to continue to load old extensions that have not yet been signed by their 
author. 

Visit the Help Center article for more information. 

Welcome Dialog Refresh 

We’ve given our Welcome Dialog a refresh for SketchUp 2016. Everything works 
mostly the same, but we’re happy to say that the “Start SketchUp” button is bigger 
than ever! 

Knowledge Center Update 



Our Knowledge Center has been rewritten and redesigned for this release. Content 
is now organized in a hierarchy of “books” that focuses on learning SketchUp’s tools 
in the context of using SketchUp. 

Support for El Capitan and Windows 10 

Our QA team has smashed and banged on these new operating systems enough to 
say that SketchUp 2016 is fully compatible with Apple’s El Capitan and Microsoft’s 
Windows 10. 

SketchUp Exporters 

With the release of SketchUp 2016 we no longer support the EPix file format for 
export. If you continue to use this exporter you'll need to downsave your SketchUp 
file to SketchUp 2015 or earlier and then export using that older version. 

Bug Fixes/Small Improvements ​
  

In addition to the above, we’ve been heads down fixing bugs and adding some 
smaller features: 

Stability 

●​ Fixed a crash that could occur when importing an image into a model that 
had a corrupt image (0x0 size). 

●​ Fixed a crash that could occur when auto-folding certain geometry. 
●​ Fixed a crash that could occur when copy/pasting geometry or closing 

models. This crash is caused by component instances that have bad 
definitions. We added a validity check to catch and repair this condition, so if 
you are crashing, especially on copy/paste, please go to Model Info > 
Statistics > Fix Problems to see if SketchUp finds and fixes an issue related to 
component instances. 



●​ Fixed a crash that could occur when downloading a model from the 3D 
Warehouse by clicking on buttons rapidly. 

●​ Fixed a crash that could occur when moving geometry and toggling auto-fold. 
●​ Fixed a crash that could occur when changing arc segments in Entity Info. 

Added a new message to indicate if the number of segments is too large for a 
given angle and radius when changing arc segments in Entity Info. 

●​ Fixed a specific case in which a file could not be saved or fixed with a validity 
check related to a bad component. This led to a crash when closing the file. 

●​ Added a validity check to detect and fix components that have duplicate 
definition names (which can cause bugs/crashes when doing other things in 
SketchUp). 

●​ Many “under the hood” changes to resolve warnings and improve product 
stability. 

●​ (Win) Fixed a crash that could occur when closing out the Soften Edges dialog 
using certain key strokes. 

●​ (Mac) Fixed a crash that could occur when closing a file in SketchUp Viewer. 
●​ (Mac) Fixed a crash that could occur when undoing the pasting of certain 

components. 
●​ (Mac) Fixed a crash that could occur when opening and closing multiple large 

models. 
●​ (Mac) Fixed a hang that occur when closing the “Warning - Scenes and Styles” 

dialog. 

Performance 

●​ Improved the performance of Stamp and Drape and other operations where 
geometry is intersected. 

●​ Improved the performance of erasing entities within groups in large models. 
●​ Improved the performance of undoing changes to geometry. 

Trimble Connect 

●​ Located underneath the File menu on both Windows and Mac. 
●​ Requires use of a Google account to access Trimble Connect (either a Gmail 

account or an email associated with Google will work). 



Generate Report 2.0 (New!) 

●​ The Metric system is now supported. 
●​ The ability to choose and order the report columns has been added. 
●​ One or more reports can now be saved with a model as a template for future 

use. Templates can also be duplicated and edited as needed. 
●​ The ability to filter based on component levels has been added. 

Notes: 

●​ Generate Report is a Pro only feature. 
●​ You must be online for the new version of Generate Report to work. Offline 

users will see the older version 
●​ Users with Internet Explorer 8 Installed will see the older version of Generate 

Report. Upgrade IE to version 9 or newer for best results. 

3D Warehouse 

●​ Made the following UI changes: 
○​ Added a Window > 3D Warehouse menu item. 
○​ Renamed the *Get Models* button to *3D Warehouse”. 
○​ Added a new “3D Warehouse” component context sub-menu. 
○​ Moved the “Share Component” menu item to be under the new “3D 

Warehouse” component context sub-menu. 
●​ Fixed an issue where Unicode characters were not always maintained/404 

errors were issued when downloading models with Unicode definition 
names/file names from 3D Warehouse. 

●​ Fixed an issue where an uploaded model could get out of sync with the 
model saved to disk - we now require that a model be saved before 
uploading. 

●​ Made the following set of changes to retain a component’s definition name 
and original filename when uploading and downloading models from 3D 
Warehouse and when importing and exporting components locally: 



○​ When downloading components from 3D Warehouse, SketchUp now 
retains the component’s original definition name and description (if 
defined) vs using the model’s 3D Warehouse title and description. 

○​ Changed SketchUp to remember the definition name of components 
on import vs overwriting the definition name with the component’s 
filename. 

○​ Added a Name field to Model Info > File to allow a user to directly 
specify the model’s name which will become the component’s 
definition name if that model is inserted as a component from 3D 
Warehouse or directly imported as a component. 

○​ When using the context Save As menu to save a component, SketchUp 
suggests the component’s original filename (if known) vs suggesting 
the component’s definition name. 

●​ Added the ability to upload the current model via the Upload Model 
command that is visible within the 3D Warehouse dialog (Window > 3D 
Warehouse > User menu). 

●​ (Win) SketchUp now returns to your last visited 3D Warehouse location 
during your current SketchUp session vs redirecting to the home page each 
time you call up the 3D Warehouse dialog. 

●​ (Mac) Fixed an issue where a suffix could be appended to the definition name 
of downloaded components. 

Tools 

●​ Fixed an issue with the 2 Point Arc tool in which an arc endpoint could be 
misplaced when drawing in small dimensions. An excess line was created. 

●​ Fixed an issue where the edges were not removed when creating a fillet if the 
arc endpoint ended on another endpoint. 

●​ Fixed an issue where Arc and Pie detent radius tooltips were only displayed 
when parallel to an axis. 

●​ Fixed a cosmetic issue with the Arc and Pie tool drawing lines were 
hard-coded black and not using colors style-specific colors. 



●​ Fixed a cosmetic issue in which the Rotated Rectangle, Arc, and Pie cursors 
were not updating based on clicks or typing values in the VCB 
(Measurements toolbar). 

●​ Fixed an issue where the Rotated Rectangle protractor was not displayed 
with dotted lines when on a back edge. 

●​ Fixed a cosmetic issue with the Rotated Rectangle tool where a line could 
remain while locking to an axis using the arrow keys. 

●​ Fixed an issue in which an edge could not be directly extended when the 
edge was too close to an axis line. With this fix, the more you zoom in, the 
smaller this snapping tolerance becomes allowing you to extend an edge 
easier and eliminate undesired snapping of edges to axes during tracing. 

●​ Fixed a crash with the Rotate tool when using Ctrl/Option in between typing 
in values in the VCB (Measurements toolbar). 

●​ Updated status bar for Paint Bucket to identify modifier keys for sampling 
materials. 

●​ Changed the hotspot for the Eraser tool to be smaller. 
●​ Fixed an issue where, when performing two offsets with manually selected 

items, the first offset could be undone. 
●​ Added new modifier keys to lock just protractor orientation for Rotate and 

Protractor tools. 
●​ Fixed an issue where pressing Shift would release a constraint that was 

locked using an arrow key. 
●​ Fixed an issue where an invalid input in the VCB (Measurements toolbar) 

broke the copy mode. 

Inferencing 

●​ Improved consistency across drawing tools with using shift to lock through 
different point inferences (including endpoints, midpoints, arc centers, and 
guide points). This functionality is new to several tools. 

●​ Added inferencing when using the rotation handles within the Move tool. 
●​ Fixed an issue in which inference points could not always be found with the 

Move tool for points that were off of the gluing surface for glued groups or 



components. Expanded the list of inference types that can be found for this 
case. 

●​ Fixed an issue in which an incorrect parallel inference was found after 
undoing a rotation or move. 

●​ Fixed an issue in which an incorrect parallel inference was found after 
rotating an edge that was in a group or component. 

●​ Fixed an issue in which an incorrect parallel/perpendicular inference was 
found when editing a group or component and inferencing an edge of a 
rotated group or component. 

●​ Fixed an issue where Arc and Pie could show a parallel inference for a 
non-parallel edge. 

●​ Fixed an issue where the Circle and Polygon tools showed axis inferences 
when it wasn’t possible. 

●​ Fixed an issue in which a perpendicular inference couldn’t be found for 
Circle, Polygon, Rotate, and Protractor if the reference edge wasn’t parallel to 
the xy plane. 

●​ Updated protractor-based tools (e.g. Arc, Pie) and Circle/Polygon to ensure 
consistency with using shift to lock to a plane before first click instead of just 
locking orientation in some cases. 

●​ Fixed an issue in which Arc and Pie did not draw in the correct plane when 
using shift before first click. 

●​ Fixed an issue where the Rotated Rectangle tool was not showing 
Intersection, Guide Point, and On Face inferences. 

●​ Fixed an issue where the Arc and Pie tools were not showing Intersection 
inferences after first click. 

●​ Improved inferencing with Protractor tool while outside of a 
component/group. 

●​ Fixed an issue where the Center of a Circle could not be found when the 
Circle was contained within a Group. 

●​ Added arc segment “Midpoint” inferences and updated the actual arc 
midpoint to “Arc Midpoint”. 

●​ Fixed an issue where midpoints on Polygon segments could not be found if 
Polygon was split by an edge. 



●​ Fixed an issue where the Rotated Rectangle, Arc, and Pie tools were not 
always showing From Point inferencing along an axis. 

●​ Fixed a cosmetic issue where the Tape Measure, Rotate, and Protractor lines 
did not turn magenta when parallel/perpendicular to an edge. 

●​ Fixed a cosmetic issue where a magenta, dotted line was not drawn between 
the first and third points of a 3 Point Arc when parallel/perpendicular to an 
edge. 

●​ Fixed a cosmetic issue where the Circle and Polygon radii were not turning 
bold when locked to an inference using shift. 

●​ Fixed a cosmetic issue with the 2 Point and 3 Point Arc tools where the 
drawing line could change appearance when locked using shift. 

Support for High DPI Graphics 

●​ User may see graphics on certain Ruby Extensions that look small or low 
resolution, as the author for the extension may not have updated their 
graphics (Vector based graphics) to support High DPI yet. 

●​ (Win) When changing the screen resolution or scale% with multiple monitors, 
the monitor that is your ‘Main Display’ will be the one that controls how 
SketchUp will look when opened. 

●​ (Win) We support an unlimited number of screen resolutions, however, we 
currently only support a scale percentage change of up to 150%. Screen scale 
percentages set above 150% can result in unreadable menu items. 

Operating systems: El Capitan & Win 10 

●​ (Mac) Fixed an issue where importing Classifications was very slow. 
●​ (Mac) Fixed an issue where exporting 3D formats took an exorbitant amount 

of time. 
●​ (Mac) Fixed an issue where the original file was not visible in Finder (or on the 

Desktop) after saving a file a second time. 
●​ (Mac) Fixed a crash that could occur when closing SketchUp in Full Screen 

Mode using the Red X or Command+W to close the window. 
●​ (Win) Fixed the issue where the user would lose the scroll bars on the 

Welcome Dialog, Templates tab, when the middle mouse wheel was used. 



File Open / Save 

●​ (Win) Improved the look of the File > Open and File > Save dialogs. 
●​ (Win) Fixed the "File currently locked by another user" message that was seen 

when opening a file via double click when the Preview Pane in Windows 
Explorer was open. 

●​ (Win) Fixed an issue where you could see a CFileException 5 error when 
saving a model multiple times in a row without waiting long between saves. 

●​ (Mac) Changed SketchUp to now correctly save files with the “staff” group vs 
the “wheel” group. 

Fonts / 3D Text 

●​ (Mac) The Fonts dialog was refactored to fix the following: 
○​ Fixed an issue in which a fixed height text size could not be set. The 

height changes were applied as a font point size change. 
○​ Fixed an issue in which the height option was not working for 

Dimensions. 
○​ Fixed an issue in which 3D Text dialog did not always remember the 

last used typeface. 
○​ Fixed an issue in which the 3D Text dialog was resulting in 100% cpu 

usage while the dialog was open. 
○​ Provided a more complete fix for a crash on Yosemite when the dialog 

was opened. 
●​ (Mac) Fixed an issue where 3D Text could not be placed after clicking on a 

component in the Components browser. 

Entity Info 

●​ (Mac) Fixed an issue where Entity Info could sometimes get stuck at the top 
of your display window or be taller than expected. 

●​ (Mac) Fixed an issue where Entity Info could grow in size after SketchUp 
crashed. 



●​ (Mac) Fixed an issue in the Entity Info dialog where the "Text Position" and 
Endpoints" labels were swapped for linear dimensions. 

●​ (Win) Fixed an issue where the description could be cut off in Entity Info 
when multiple locked entities were selected. 

Miscellaneous 

●​ We removed the EULA license agreement from the installer. It is now 
displayed and must be agreed to at first launch by each unique user. 

●​ Changed SketchUp to display the major version number in the title bar. 
●​ Created new templates featuring Lisanne, one of our cheerful Customer 

Support representatives. 
●​ Fixed an issue where exploding components sometimes unsoftened 

softened edges. 
●​ Fixed an issue where hiding dialogs/minimizing SU smoothed/unsmoothed 

selected geometry. 
●​ Changed the Create Component dialog to remember what was last checked 

in the "replace selection with component" check box. 
●​ Fixed an issue where panning did not work in models with only construction 

points (e.g. point cloud models). 
●​ Fixed an issue where a blank component definition name could be added in 

the Create Component dialog. 
●​ Changed the section slice DWG exporter to export the model units (vs always 

exporting inches). 
●​ Renamed the Geo-location functionality in SketchUp to be more generic 

including: 
○​ renaming the location layers to “Location Terrain” and “Location 

Snapshot”. 
○​ renaming the “Google” toolbar to “Location” 
○​ removing the “Preview in Google Earth” button. Note: models can still 

be previewed in Google Earth by exporting them to the kmz format. 
●​ Added the ability to extend expiring (single-user) Enterprise licenses without 

a user needing to re-license SU. 
●​ Improved parsing of classification schema. 



●​ Added classification information to Model Info > Statistics. 
●​ Fixed an issue where the Aspect Ratio value chosen for animation exports 

was not saved between sessions. 
●​ Fixed a number of translation and truncation errors in our localized builds. 
●​ (Win) Fixed an issue where the Model Info dialog was not appropriately 

disabled (including the menu item) while editing a Match Photo. 
●​ (Win) Fixed an issue where the slider text on the Shadows dialog and toolbar 

did not always respect the current Window’s desktop theme. 
●​ (Win) Fixed an issue where the length snapping field in Model Info > Units 

updated to zero when changing precision. 
●​ (Win) Changed the default size of the Viewer application window to be larger. 
●​ (Win) Fixed an issue where the Add License button was unreachable at 

certain screen resolutions. 
●​ (Mac) Fixed an issue where textures created on Windows could not be edited 

via the "Edit Texture Image" context menu. 
●​ (Mac) Fixed an issue where the text seen when renaming a scene via right 

clicking on a scene tab was tiny on Retina displays. 
●​ (Mac) Fixed an issue where users were able to create duplicate named 

scenes in the Scenes dialog. 
●​ (Mac) Renamed the preference that checks for Software Updates in 

Preferences > General to “Allow checking for updates” to better reflect what 
the preference does. 

●​ (Mac) Increased the time interval that SU uses when it does a check to 
determine if you are online. 

LayOut Release Notes 

What’s New? LayOut cloud references 

With this release, LayOut’s reference objects are now web friendly. That means your 
LayOut projects can reference and update files that are stored and synced with 
services like Dropbox, Google Drive, and Trimble Connect Sync. When you 
reference a file from any of these services (.skp or otherwise), LayOut will notify you 
when an update is available for your ‘web reference.’ Say goodbye to missing 



references when different people are working on the same .layout document within 
a cloud sync folder that also contains the referenced files. 

Small dimensions 

A smart tweak to LayOut dimensions, our new ‘small dimension’ leaders ensure 
that text never interferes with arrows or extension lines, and that your dimensions 
always have room to stretch out when you’re working in confined spaces. When 
LayOut detects that your text strings are going to interfere with dimension arrows 
or extension lines, it will automatically pop-out your strings using a leader 
(customizable, of course!) 

Loveable LayOut layers 

We’ve improved pretty much everything about LayOut’s layers. Whether you’re 
grouping objects across layers, drawing objects on shared layers, or unearthing the 
bottom of a stacked viewport, our new layers are just plain better. Here’s how: 

Multi-Layer Groups: Entities on different layers can now be grouped together. If you 
tried to do this in the past, you’d collapse your entire group onto one layer. 

Maintaining Layers During Copy Paste: Copy/pasting entities now respects the layer 
assignments of the original entity (previously, everything would copy to the current 
layer). This should make it easier to copy/paste a SketchUp viewport (along with any 
grouped dimensions and labels) from one page to another and maintain layer 
assignments. If you’d like to paste to the current layer, choose Edit -> Paste to 
Current Layer, or use Cmd+Shift+V (Mac) or Ctrl+Shift+V (Win). 

‘Move to’ layer on context click: You can now move entities between layers with a 
context click. Use the new ‘Move to’ command, and then select from all unlocked 
layers. (In the past you could only move to the current layer, which was a multi-step 
process.) 



Differentiating between shared/non-shared layers: In order to help users understand 
when they are creating or manipulating entities on a shared layer, we’ve added tool 
highlighting that displays a different color (red) when you are drawing or selecting 
elements on a shared layer. (You can customize this highlighting in LayOut 
Preferences > General). 

Layer visibility maintained on new pages: If a layer is hidden on the current page, it 
will also be hidden on a newly added page. 

Optimized PDF Export from LayOut 

We are so happy to share that you can now choose to compress JPEG’s in your 
LayOut files when exporting PDF’s. Since every raster or hybrid rendered .skp 
viewport has a JPEG image, this leads to drastically smaller PDF exports from 
LayOut that still have a very high output resolution, but are much easier to share 
with others. One of our test files shrank from 115 MB down to 18 MB with very little 
loss in quality. Of course, you can choose your level of image compression on 
export, so that 115 MB PDF is still an option! 

Support for El Capitan and Windows 10 

Our QA team has smashed and banged on these new operating systems enough to 
say that SketchUp 2016 is fully compatible with Apple’s El Capitan and Microsoft’s 
Windows 10. 

Documentation Improvements 

Our Knowledge Center has been rewritten and redesigned for this release. Content 
is now organized in a hierarchy of “books” that focuses on learning LayOut’s tools in 
the context of using LayOut. Additionally, we have now provided links to all of 
LayOut’s Instructors that will direct you to the appropriate Knowledge Center 
article. 



Bug Fixes/Small Improvements ​
DWG Exporter 

●​ We fixed paragraph formatting for dwg exports. The correct anchoring and 
alignment will be preserved for text boxes when exported to dwg. 

●​ We addressed the issue regarding unit inconsistency when exporting to dwg. 
Exporting to model space now picks up the unit set in LayOut’s document 
properties and exporting to paper space sets the units to millimeter if a 
metric unit was used, and inches if an imperial unit was used. 

●​ We fixed a crash that occurred when exporting a document with two or more 
layers named the same to dwg. 

●​ We set the dwg exporter to use a default scale of 1:1 when exporting to 
model space if no other scale was chosen. 

●​ We reworked the dwg exporter to change the color of black text to white 
when exported to model space. We did this to avoid having black text on a 
black background in AutoCAD viewers. 

Layers and Pages 

●​ We addressed an issue that caused the thumbnail view in the Pages 
inspector to not update when a shared layer was deleted. 

●​ (Win) We fixed a bug that prevented the ability to reorder more than one 
layer or page at a time through multi-selection. 

●​ We fixed an issue that prevented the Layer’s visibility option from toggling 
when two documents were open. 

●​ We fixed an issue that caused the longest page name to be rendered when 
converting the page name auto-text tag to text if that tag was on a shared 
layer. 

●​ (Mac) We made the dialog that prompts you to either move or delete the 
entities on the layer when you delete the layer expandable so you can read 
the layer name if it was long. 

●​ We fixed an issue where undoing a layer reorder sets a different layer active. 

User Interface 



●​ We addressed the issue that caused toolbar customization to be difficult if 
the toolbar was docked vertically or at the bottom. 

●​ We made several improvements to our button and icon artwork so that they 
appear nice and crisp on high dpi Windows and Mac machines. 

●​ (Win) We fixed an issue that caused the default text editor preference to be 
reset every time LayOut was restarted. 

●​ (Win) We fixed the issue that wasn’t updating the paper height when changed 
from A3 Portrait to Legal. 

●​ (Win) We increased the size of the collapse/expand arrow buttons for the 
inspector trays on high dpi Windows machines. These were previously a little 
too small. 

●​ We increased the height of each row in the Sets Pane within Style Builder to 
avoid the pixel length text from being clipped on high dpi Windows 
machines. 

●​ (Win) We increased the size of the Viewer toolbar icons within Style Builder. 
●​ We fixed a crash that could happen regularly while customizing toolbars on 

Windows. 

Localization 

●​ We fixed an issue in the Japanese version of LayOut that caused a crash 
during font substitution. 

●​ (Mac) We fixed quite a few untranslated words in each of our localized builds 
for Mac. 

Labels and Dimensions 

●​ We addressed an bug that prevented the sample tool from applying a style 
default to labels if a label was sampled. 

●​ We fixed a bug that would cause dimension text to report 0 if the dimension 
was resized. This would only happen if the dimension was not extended and 
was resized by itself (not resized by resizing the entity it was attached to). 

References 



●​ (Mac) We moved the default scrapbooks and templates to the users’ folders 
and out of the app bundle. When the ones in the app bundle are modified, a 
copy is made so the original can be preserved. 

●​ We fixed a bug where sampling a pattern fill from within the scrapbook 
inspector wasn’t creating a permanent reference. When the document was 
reloaded, the reference would be missing. 

●​ We addressed an issue that prevented pdfs to be overwritten when saving to 
a FAT-32 formatted external storage device. 

Miscellaneous 

●​ (Win) We fixed a bug in our text renderer that prevented the font Flux 
Architect from being used. 

●​ We fixed an issue that caused some fonts, namely cityblueprint, to not get 
preserved when after exported to pdf. 

SketchUp API Release Notes 

What’s New? ​
  

For a complete list of all new features and bug fixes, see the Release Notes page 
that we maintain for developers here: 
http://www.sketchup.com/intl/en/developer/docs/releases 

A new LayOut API 

We’re proud to announce our first step towards an extension ecosystem for 
LayOut. Using this new API developers can now open, create, modify, save, and 
export .layout files. Practically, this means that other applications can import or 
export the .layout file format using the C API. (This includes creating a .layout file 
from SketchUp). We have several sample scripts for developers to try out at release. 
Check out the API documentation in the Developer Center for more information. 



Digitally Signing Extensions - Extensions Loading Policy 

With SketchUp 2016 we introduced the ability for users to select which Extension 
Loading Policy they want to use. The options are “Identified Extensions Only”, 
“Approve Unidentified Extensions”, and “Unrestricted. 

The developer side of this feature is known as a Digital Signature. All SketchUp 
extensions for 2016 or later will now require a Digital Signature to run in the 
highest security mode - “Identified Extensions Only”. If the user has chosen 
“Approve Unidentified Extensions” then all signed extensions will load automatically 
and any unsigned extension will have to be approved by the user. All extensions 
signed and unsigned, will load in “Unrestricted” mode. 

SketchUp installs in “Unrestricted” mode by default. 

To digitally sign your extension, simply upload your .rbz package to our new Digital 
Signature and Encryption page and we will sign it and return it to you. Visit the new 
Extension Digital Signature page. 

You will need to sign your extension each time you make code changes and want to 
re-release it. You will need to be a registered Developer on the Extension 
Warehouse to be able to sign or encrypt extensions. Apply here! 

Ruby Encryption 2.0 

Goodbye .rbs and Hello .rbe! We have added a new encryption that you can use to 
help protect your extension Intellectual Property (IP). SketchUp 2016 can read both 
.rbe and .rbs filetypes. This should help make sure that we maintain backwards 
compatibility for authors who need some time to re-encrypt their extensions. To 
use our new encryption, simply upload an unencrypted version of your .rbz 
package to our new Digital Signature and Encryption page and we will encrypt it 
and return it to you. Visit the new Extension Digital Signature page for more 
information. 



You will need to be a registered Developer on the Extension Warehouse to be able 
to sign or encrypt extensions. Apply here! 

Developer Center 

Between the Extension Digital Signature Page we added, the new LayOut C API and 
a whole lot of future ideas and potential, we have decided to create a new central 
location to organize our developer resources, API documentation, etc. Visit (and 
bookmark!): ​
https://extensions.sketchup.com/en/developer_center 

Observer Upgrades 

We have been working on finding ways to make observers more stable and reliable 
for all developers. Most of these changes happen under the hood and are not 
entirely visible to developers. To help with that, we added a few Ruby Warnings that 
appear in the Ruby Console, and two debugging methods that will determine 
whether those warnings are shown: Sketchup.debug_mode= and 
Sketchup.debug_mode?. See this pdf for a more in depth look at the changes we 
made to the Observers. 

SketchUp C API Parity - continued 

We have focused on adding features to the SketchUp C API in 2016 to provide 
greater benefit to our developers and as part of our continued effort to fully 
deprecate and remove the old C++ API in the future. Below is a complete list of 
functions that we have added for 2016. We are continuing to add more until we 
gain enough coverage to consider the C API at feature parity with the deprecated 
C++ API. 

 



February 29, 2016 
Versions: ​
16.1.1450 (Win 32-bit) ​
16.1.1449 (Win 64-bit) ​
16.1.1451 (Mac 64-bit) 

General Note 

Windows: This maintenance release fixes a Windows-only bug introduced in the 
first release of SketchUp 2016, also known as “M0” [version numbers 16.0.19912 
(Win 64-bit); 16.0.19911 (Win 32-bit)] where uninstalling SketchUp resets your 
default Internet browser. To avoid running into this issue, leave SketchUp 2016 
“M0” installed prior to installing this update - i.e., install SketchUp 2016 M1 over 
your existing version of SketchUp 2016 M0. See this article for more details on this 
issue. 

OS X: This maintenance release is for both Windows and OS X and addresses a 
number of issues. Please read below for further details. 

SketchUp Release Notes 

Fixes/Improvements: ​
Stability 

●​ Fixed a crash when saving a model after importing a .dwg file that had a 
component definition name the same as one already in the model. 

●​ Fixed a crash that could occur when auto-folding certain geometry and using 
an arrow key to lock direction. 

●​ (Mac) Fixed a crash that could occur when opening a new file or switching 
documents while in the middle of some operations (including importing a 2d 
image, viewing an image igloo, or using the Dimensions/Text tool). 

●​ (Mac) Fixed a crash that occurred by deleting an in model component’s 
definition name or description via the Components browser dialog. 



Tools & Inferencing 

●​ Fixed an issue where SketchUp was incorrectly parsing negative lengths for 
specific formats such as feet and inches (e.g. -2’ 8”) and fractional (e.g. -15 
1/2”) when entered in the VCB (Measurements toolbar) or the Ruby Console. 

●​ Removed Shift + Press Alt (Win) and Shift + Press Command (Mac) 
functionality from Rotate and Protractor tools which freed the center of the 
protractor. Shift + Alt functionality clashes with the Windows shortcut default 
setting that changes keyboard language on Windows if multiple languages 
are installed. The down arrow key provides the same functionality. 

●​ Fixed an issue with the Protractor and Rotate tools in which the protractor 
jumped to the corner of the screen when making multiple slope entries in 
the VCB (Measurements toolbar). 

●​ Updated the Section Plane tool so it is colored based on the axis it is normal 
to when being placed (for consistency with other tools). Also, added a tooltip 
to indicate “Unlocked plane” or “Locked plane”. 

●​ Added ability to Circle/Polygon tools to use Shift to lock through different 
point inferences (including endpoints, midpoints, arc centers, and guide 
points). 

●​ Fixed an issue with Arc, Pie, Circle, and Polygon tools in which the tool could 
remain locked to a plane after releasing Shift with the down arrow key active. 

●​ Fixed some cosmetic issues with several tools in which the drawing line could 
be incorrectly colored when locked with the down arrow key. 

●​ Fixed a cosmetic issue with surface based tools in which the tool cursor could 
be incorrectly colored when locking with an arrow key and parallel to an axis 
plane. 

●​ Fixed a cosmetic issue with several surface based tools in which the tool 
highlighted in magenta when pressing Shift to lock normal to an axis. 

●​ (Win) Fixed an issue in which Entity Info accepted arc/pie/circle/polygon 
segments that were out of range as specified by an error message. 

●​ (Mac) Fixed an issue in which you couldn’t update two consecutive 
arcs/pies/circles/polygons with the same number of segments in Entity Info. 

●​ (Mac) Fixed an issue where arc/pie/circle/polygon segments temporarily 
updated to 0 or last valid entry in Entity Info when an invalid entry was made. 



Customizeable Utility Trays on Windows 

●​ Fixed an issue where the drawing window took focus away from extension 
dialogs. This impacted our shipped extensions (e.g. Component Options, 
Photo Textures) and some external extensions (including Brighter3D and SU 
Podium). In some cases extension dialogs appeared to disappear but were 
located behind the SketchUp window. 

●​ Made a change so that the visibility of an auto-hide tray does not toggle by 
way of the Window menu or a shortcut as toggling this way caused the tray 
to immediately retract. The visibility of an auto-hide tray is only managed 
with the tray tab (hover over tab to display tray). 

●​ Fixed an issue in which renaming an entity in Entity Info didn’t save correctly 
when subsequently clicking in Outliner. 

●​ Fixed an issue where the selection highlighting was visible when softening 
edges. The highlight now returns once the cursor moves out of the Soften 
Edges dialog. 

●​ Fixed an issue in which some drop down and sliders no longer scrolled using 
the mouse wheel when they had focus. 

Localization 

●​ Fixed an issue where the "Use Image As" text was not translated for our 
localized builds. 

●​ Fixed missing carousel arrows on our Spanish version of the Learn tab. 
●​ Fixed several German translation issues on our About dialog. 
●​ Fixed the German translation of ‘Knowledge Center’. 
●​ Various other translation quality fixes. 

General fixes 

●​ Fixed an issue where Ruby extensions fail to load / gave errors on launch if 
you have certain non-English characters in your Ruby path (which can occur if 
your Windows user name has certain non-English characters). If you’re still 



seeing an error with the Trimble Connect extension, please update that 
extension in the Extension Warehouse. 

●​ Fixed our Updater Service so that the user is notified at a more appropriate 
frequency. 

●​ Fixed issue where cameras were not being exported in the Collada exporter. 
●​ Fixed an issue where temp files were not removed when exporting a 3D 

model. 
●​ Fixed an issue where the text "This is a very long string. How long do we 

want?" could show up in the status bar on launch under rare circumstances. 
●​ (Win) Fixed an issue where uninstalling SketchUp disabled the ability to set 

Internet Explorer as your default browser, and may have disabled other 
programs’ defaults similarly. 

●​ (Win) Addressed several issues surrounding invalid file locations in 
Preferences. 

○​ Fixed an issue where you could see a CFileException 3 error if the 
“Models” file location was invalid and auto-save kicked off. A new, 
more descriptive error message is now displayed. 

○​ Fixed an issue in which you could see multiple CFileException 3 error 
messages within the same session even after updating the “Models” 
location to a valid path. 

○​ Added a new error message upon startup if any of the File locations in 
Preferences > Files are invalid. 

○​ Invalid file locations are now displayed in red in Preferences > Files 
and a tooltip is displayed indicating an invalid path. 

●​ (Win) Fixed an issue where the slider labels in the Choose Colors dialog could 
be incorrect after switching between picker types. 

●​ (Win) Increased upload timeout of models to the 3D Warehouse. 
●​ (Win) Replaced our expired signing certificate, then changed our digital 

signatures and timestamps to use SHA2/256, in accordance with Microsoft’s 
SHA1 deprecation announcement. 

●​ (Win) Fixed an installer issue where the user would receive "An error 
occurred in PreBootstrapper. [could not create sketchup_install]" if an empty 
sketchup_install folder existed. 



●​ (Mac - El Capitan) Fixed an issue where Toolbars containing dropdown 
arrows got misaligned when accessing the Customize Toolbar dialog. 

●​ (Mac) Fixed an issue in which a component could no longer be replaced if it 
had the same name as another component. 

●​ (Mac) Fixed the ‘SketchUp License Agreement’ link on the About SketchUp 
dialog. 

●​ (Mac) Fixed an issue in which BugSplat technical support responses were not 
being displayed. 

●​ (Mac) Fixed an issue where adding 3D Text created an “unreferenced fonts” 
validity error. 

LayOut and Style Builder Release Notes 

Fixes/Improvements: 

●​ (Mac) Inserted pdfs will no longer be influenced by the image compression 
setting while exporting a document to pdf. Thus, your inserted pdf images 
will remain sharp even if you use heavy compression when exporting to pdf. 

●​ We made changes to prevent drawing pattern fills for single-segmented lines. 
This may prevent some memory related crashes. 

●​ (Win) The object snap button wasn’t toggling correctly. Often, pressing the 
object snap button would turn object snapping on or off but the icon artwork 
wouldn’t change to the correct state. We fixed this so that the icon artwork 
will always reflect the object snapping state. 

●​ We added check marks in the Move to Layer context menu next to any layers 
that the selection set currently has entities on. 

●​ (Win) We fixed an issue that would cause save to fail (and pop a dialog 
exclaiming as much) if the save event came immediately after a previous 
save. 

●​ (Win) We fixed a crash that occurred while attempting to close LayOut 
immediately after starting (before the getting started dialog was visible). 

●​ Fixed an issue where LayOut was incorrectly parsing negative lengths for 
specific formats such as feet and inches (e.g. -2’ 8”) and fractional (e.g. -15 
1/2”) when entered in the VCB (Measurements toolbar). 



SketchUp API Release Notes 

Fixes/Improvements: 

●​ (Mac) Fixed issue where custom image importers were not being honored. 
●​ Fixed issue where Sketchup.require/load fails to indicate a load failure. 
●​ Fixed issue where load_on_start was not being honored on extensions that 

were manually placed within the Plugins folder. 
●​ Fixed issue where extensions fail to load / gave errors on launch if you have 

certain non-English characters in your Ruby path (which can occur if your 
Windows user name has certain non-English characters). If you’re still seeing 
an error with the Trimble Connect extension, please update that extension in 
the Extension Warehouse. 

●​ Fixed issue where the Trimble Connect Extension fails to load due to an 
invalid byte sequence error. Users will need to update to SketchUp 2016 M1 
and update the Trimble Connect Extension to version 1.1.1 (via the Extension 
Warehouse) to see this change. 

●​ (Win) Fixed issue where the unchecking an Extension within the Extension 
dialog caused the list to scroll back to the top of the list. 

●​ Fixed issue where unchecking an Extension within the Extensions dialog did 
not change the appearance of the checkbox. 

●​ (Win) UI.preferences_pages() will now include "Extensions Policy" 
●​ (Win) UI.show_preferences("Extensions Policy") will now open the correct 

property page. 
●​ Fixed issue where the Extension Status dialog incorrectly stated a user was 

under the "Identified Extensions Only" policy. 
●​ Updated dialog content for extensions that were installed but not loaded. 

The dialog now clearly states that the user must load the extension in order 
to use it. 

●​ Fixed issue where an extra dialog appeared on startup when loading an 
uncertified extension that was previously certified. 

●​ (Mac) Fixed issue where exporter progress dialog had the incorrect title of 
'Import progress. 



●​ Fixed issue where the language handler treated all double slashes (//) as 
comments. 

●​ (Mac) Fixed issue where the 'Uncertified Extension detected' dialog did not 
appear when installing an extension through the Preferences dialog. 

●​ Prevent the unsigned extension dialog from appearing unless the number of 
unsigned and loaded extensions has changed. 

●​ On startup, only extensions.rb, langhandler.rb and sketchup.rb will be loaded 
from the Tools directory. 

●​ On startup, users will be prompted if any of the following files have been 
modified since being digitally signed: extensions.rb, langhandler.rb and 
sketchup.rb. 

●​ Modified the Ruby file loading priority to be .rbe, .rbs then .rb. 
●​ (Win) Fixed issue where third party DLLs in Windows system folders could 

override the Ruby standard library DLLs. 
●​ Fixed issue where extensions installed in the Plugins directory were not 

respecting the load_on_start value. 
●​ Added Sketchup::RegionalSettings.decimal_separator 
●​ Added Sketchup::RegionalSettings.list_separator 

 



September 20, 2016 
Version:​
16.1.2418 (Mac 64-bit) 

General Note: 

Mac: This update for SketchUp 2016 for Mac is to address a number of issues which 
arose with the release of Apple MacOS Sierra (10.12) 

SketchUp Release Notes 
Fixed 

●​ Fixed a crash which occurred when closing a tab in fullscreen mode. 
●​ Fixed some resources in SketchUp which didn’t display as translated. 

LayOut Release Notes 
Fixed 

●​ Fixed a crash which occurred when editing rich text. 

 



November 3, 2014 
Version Numbers: ​
Microsoft Windows 64-bit: 15.0.9350 ​
Microsoft Windows 32-bit: 15.0.9351 ​
Mac OS X: - 15.0.9349 

SketchUp 

What's New? 

64-bit application 

We’ve updated the SketchUp engine to run as a 64-bit application on both PC and 
Mac operating systems. What exactly does this mean? The least nerdy way to 
explain it is that 64-bit allows for more bandwidth between SketchUp and your 
computer’s active memory. Theoretically, the 64-bit version of SketchUp should 
have a better working relationship with your 64-bit computer. Check out this article 
for more details including things you need to know about installing 64-bit SketchUp. 

If you don’t have a 64-bit Windows machine, we’re still offering a 32-bit version for 
Windows machines. 

On the Mac, given that all of our supported operating systems are 64-bit, SketchUp 
2015 is available only in 64-bit. 

Learn more about OS support here. Note that we have dropped support for 
Windows Vista, XP and OSX 10.7 Lion with this release. 

Face Finder improvements 

We’ve mined and optimized the code for Face Finder, one of the core 
under-the-hood operations that make SketchUp’s magic possible. Face Finder is the 
code that runs whenever SketchUp automatically creates a face from coplanar 



edges. Think for a second about how often that happens. When we tested this 
sharpened code on large models, we found big performance improvements in 
operations like Explode and Intersect. 

Rotated Rectangle 

For a few years now, we hosted a wildly useful, but not wildly popular Rotated 
Rectangle extension. This extension allows you to draw non-90 degree rectangles 
on the ground. The folks who used this tool found it extremely handy, so we 
decided to build it into SketchUp with some significant enhancements. SketchUp 
2015’s official Rotated Rectangle tool lets you draw off-axis rectangles at any angle 
(and not necessarily on the ground). Give it a try: we bet it’ll make you feel like 
you’re using SketchUp for the very first time again. 

3 Point Arc 

Who said SketchUp only does boxes? With the addition of a 3 Point Arc tool, there 
are now four different ways to draw arc’d edges in SketchUp. This new arc tool lets 
you define an arc bulge via the arc’s end point. If you’re trying to set an exact 
intersection along the path of your arc, this tool is for you. In contrast, the good ole’ 
2 Point Arc tool asks you to choose two points and then define a bulge by the 
midpoint. The point is, now your arcs are up to you. 

New licensing system 

We’ve replaced our licensing system to make it much more friendly. Here are some 
of the high points: 

●​ SketchUp now starts with a 30 day trial of SketchUp Pro. Our trial period 
used to be 8 hours of active use; we’re excited to give you more time to try 
out everything we have to offer! 

●​ There are no longer separate licenses for PC and Mac. Single-user and 
network licenses are now platform independent. 



●​ Single-user Licenses 
○​ We’ve simplified how single user licenses are added. Just select Help > 

License (Microsoft Windows) or SketchUp > License (Mac OS X), 
copy/paste the serial number and authorization code you received via 
an e-mail and click the Add License button. Or click the Advanced... 
link, paste in your license information and click Add License. It is that 
easy! 

○​ If you’ve purchased a new SketchUp Pro license or a renewal of your 
Maintenance & Support plan, you should receive an email with your 
SketchUp Pro 2015 license within 48 hours of launch. Check your 
email, or look up your 2015 license using our wizard. 

○​ If it’s been more than a year since you’ve bought a SketchUp Pro 
license or renewed your Maintenance and Support plan, you’ll need to 
enroll in or renew a Maintenance & Support plan to upgrade your 
license for SketchUp Pro 2015. You can do this using our License 
Wizard (Note: you’ll need to have your existing license information 
handy). 

●​ Network Licenses 
○​ License management now happens in the cloud! This is huge - no 

more creating a shared folder on a local server and no more “license 
file” that you need to generate. 

○​ Network licenses are added the same way single user licenses are 
added. Just select Help > License (Microsoft Windows) or SketchUp > 
License (Mac OS X), copy/paste the serial number and authorization 
code you received via an e-mail and click the Add License button. Or 
click the Advanced… link, paste in your license information and click 
Add License. 

○​ No setup is required by an IT manager to, well, manage the license. 
Trimble runs the licensing servers that SketchUp checks in with on 
startup to make sure you are not exceeding the licensed number of 
simultaneous users. 

○​ No more LAN restrictions. Since the license exists in the cloud, the 
computers using network licenses just need an Internet connection. 



Your network will, however, need to allow access to ports 5053 and 
50530. 

○​ If you need to work offline, you can "check out" a floating license 
before you go offline for seven days, then return it to the pool of 
licenses when you get back online. 

Fast Styles 

Styles are an incredibly powerful (and fun) feature in SketchUp, but very few 
SketchUp users understand that style choices heavily affect modeling speed. We 
went ahead and badged those styles that help SketchUp operate smooth and fast. 
Specifically, Fast Styles are those that place less demand on your computer’s 
microprocessors, and instead render primarily through your graphics card. You can 
learn more about Fast Styles and how to create your own here. 

IFC Import and Classifier enhancements (SketchUp Pro Only) 

This is the second release in a row that we’ve beefed up SketchUp Pro’s capabilities 
to participate in information modeling. This time around, we’ve added an IFC 
importer to allow the exchange of information between SketchUp and other “BIM” 
applications in both directions. This is a big deal and another proof point of our 
belief that your data belongs to you. 

We’ve also sharpened the Classifier tool, providing an easier way to erase 
classification Types and allowing you to export additional Types (IfcProject, IfcSite, 
IfcBuilding, IfcBuildingStorey, IfcSpace, IfcFooting). 

Ruby API improvements 

Along with upgrading SketchUp’s API to 64-bit, we’re also introducing some new 
developer-facing features. In particular, SketchUp 2015 is the first release where 
developers have access to and control of information modeling classifications. We 
also added new API features to allow developers to create licensed extensions. On 
top of all that, we also made improvements for materials, cameras, section cuts, 



and there’s a big list of of other enhancements and bug fixes. See here for more 
details. 

Trimble Vision Technology Integration 

Imagine Match Photo on steroids and you’ve got our SketchUp integration with 
Trimble Vision. The integration involves Trimble Vision instruments like the V10 and 
Trimble Business Center. Essentially the Trimble V10 is a super camera that uses 
GPS and Total Station technology to accurately position and orient multiple 
photographs. The combination of the V10 and the processing power of Trimble 
Business Center lets you bring multiple site photographs directly into SketchUp (via 
an exported SketchUp model) with their correct camera positions, orientations and 
corrected for image distortion; so you don't need to use any vanishing lines in 
SketchUp's Match Photo. Just set up your axes once and you're ready to use all of 
your site photographs to generate model geometry. See here for more details. 

Bug Fixes/Small improvements 

In addition to the above, we’ve been heads down fixing bugs and adding some 
smaller features: 

General 

●​ Improved the Polygon tool to allow the creation of both circumscribed and 
inscribed polygons via a modifier key (Ctrl on Microsoft Windows, Option on 
Mac OS X). 

●​ Added the ability to delete all in model materials. 
●​ We renamed the Plugins menu to Extensions to be more inline with our 

current naming conventions. This should not break existing plugins. Adding a 
menu item to the Plugins menu will still work, but that menu item will be 
added to the Extensions menu instead. 



●​ Fixed an issue where DWG/DXF files imported into other applications were 
scaled incorrectly if SketchUp and the other application were not using 
inches. 

●​ Fixed an issue where Intersect with Selection would fail when it should have 
worked. 

●​ Fixed an issue that could cause glued components to move when moving 
other model geometry. 

●​ Fixed an issue where Guide lines could fail to display or could display 
incorrectly in some models. 

●​ Fixed an issue where the Axes tool could fail to display in some scenes. 
●​ Improved the error message you see when a component created in a newer 

version of SketchUp is imported into an older version of SketchUp. 
●​ Fixed an issue where Entity Info could display incorrect information when 

components and groups are selected. 
●​ Fixed an issue that caused ground shadows for profile edges to sometimes 

draw incorrectly. 
●​ Fixed the Measurements toolbar to no longer cut off labels. 
●​ Changed Entity Info to report the correct value for a polygon perimeter. 
●​ Windows: Added the ability to export TIFF and PNG images with a 

transparent background. 
●​ Windows: Fixed an issue that caused the error message “Invalid length 

entered” when trying to change the point size of text after changing Unit 
precision. 

●​ Windows: Changed the active component thumbnail displayed at the top of 
the Components browser to show Dynamic Component and Classified 
badges. 

●​ Windows: Fixed an issue where thumbnails for SketchUp models were not 
visible when using Windows Explorer on 64-bit machines. 

●​ Mac: Added the ability to export animations using the Theora codec. 
●​ Mac: Fixed an issue that caused the BugSplat dialog to not be displayed on 

some machines. 
●​ Mac: Fixed an issue where icons for Ruby commands on the main toolbar 

were not visible until clicking File > New. 



●​ Mac: Fixed an issue where the incorrect scene tab could be highlighted when 
using the Scenes dialog to select a scene whose scene tab is not visible. 

●​ Mac: Changed the Styles dialog to disable Back Edges when Edges are 
unchecked and to disable Depth Cue, Extensions, Endpoints, and Jitter when 
Profiles are unchecked. 

●​ Mac: Fixed an issue where you could create blank layers when working in the 
Layers toolbar. 

●​ Mac: Fixed an issue where duplicate styles could be created when saving new 
styles. 

●​ Mac: Fixed a bug where the Restore Defaults button for animation export 
was not restoring all defaults. 

●​ Mac: Fixed an issue where the files that are shown as available for import 
were incorrect when switching between import formats. 

Performance 

●​ Fixed an issue where move/copy could be very slow when copying geometry. 
●​ Fixed an issue where, in some models, the Edit menu displayed slowly. 
●​ Fixed an issue where, in some models, performance could drop after clicking 

Model Info > Statistics. 
●​ Improved the performance of Model Info > Statistics which previously could 

lag when viewing statistics for large models. 

Stability 

●​ Fixed a long-standing crash that could happen when stamping and draping 
entities. 

●​ Fixed a crash that could occur when changing Arc segments. 
●​ Fixed a crash that could occur when dividing a circle and push pulling it. 
●​ Mac: Fixed a very frequent image-related crash that could occur when 

working in models (many different actions triggered it). 

Arc and Pie tools 

●​ Changed the Arc tools to more easily create fillets 



○​ Dragging out an arc from an edge now shows a tangent arc (colored 
blue) vs a dotted line. 

○​ Double clicking when the fillet turns magenta completes the fillet. 
○​ Double clicking on a face near a vertex connecting two edges 

automatically creates a fillet with the last used radius, allowing you to 
quickly fillet multiple corners with the same radius. 

●​ Arc and Pie tools: Added the ability to click-drag on the first click, allowing the 
setting of the protractors plane. 

●​ Arc and Pie tools: Added the ability, after the first click, to inference another 
object and lock that inference. 

●​ Arc and Pie tools: Added the ability, when defining the second arc point, to 
find the intersection between the arc being drawn and an extension from an 
existing line that intersects it. 

●​ Arc and Pie tools: Changed the tools to display a full protractor on tool 
activation. 

●​ 2 Point Arc tool: Added the ability to enter circle sides. 
●​ Arc tools: Fixed a bug where the Measurements toolbar label could be wrong 

when entering multiple values. 

Mac OS X 10.10 - Yosemite 

●​ Fixed a crash that occurred when using the Fonts dialog. 
●​ Fixed a crash that could occur when hiding components via the Outliner. 
●​ Fixed a bug that could cause an "atos needs to take control" message to pop 

up when SketchUp crashed. 
●​ Fixed an issue where Ruby tool icons were not displayed in the main toolbar 

when relaunching SketchUp. 
●​ Fixed a bug where the Instructor dialog failed to close unless it was 

minimized. 

Classifier/IFC exporter 

●​ Made it easier to erase Types from objects via adding a modifier key that 
puts the Classifier tool into erase mode. 



●​ Fixed an issue where copy/pasting a component several times could cause 
duplicated GUIDS (used by the IFC exporter). 

●​ Added the ability to import classification systems with circular dependencies. 
●​ Type data is now sorted alphabetically. 
●​ Added the ability to undo some actions that were missing (e.g. setting the 

active Type, importing a classification system and deleting a classification 
system). 

●​ Changed the Classifications panel to allow deleting only one classification 
system at a time to fix several issues related to deleting multiple, 
simultaneous classifications. 

●​ Windows: Added the ability to import SKC and XSD files simultaneously 
(previously they were separate import options that were not saved). 

●​ Windows: Improved the appearance of the Simplify button. 
●​ Mac: Fixed an issue where schema names could temporarily disappear from 

Model Info when copy/pasting a classified component. 

Localization 

●​ Various fixes to address incorrect and missing translations. 
●​ Windows: Fixed an issue where Add Location would fail when using a user 

name with Unicode characters. 
●​ Made a change to no longer translate “Extension Warehouse” and “3D 

Warehouse”. 
●​ Windows: Fixed the File Locations preference to be correct when using a user 

name with Unicode characters. 
●​ Windows: Fixed an issue where the Customize Toolbars dialog was not 

translated on some configurations. 

Matched Photo/Image Igloo 

In order to support the Trimble Vision Technology Integration feature listed above, 
we made the following enhancements: 



●​ Added a Photo Point tool on the Match Photo dialog that allows the picking 
of a point you are trying to locate which will cast a Guide line from the eye 
through a Matched photo. Once cast, the point you clicked on can be found 
in 3D by picking along the Guide line in another Matched Photo scene. 

●​ Enhanced the Image Igloo tool to better handle V10 image data, including 
adding new modifier keys for navigating between the model’s images. 

●​ Enhanced the warning message you see when editing an API-created 
Matched Photo scene. 

●​ Prevented vanishing points from being created when editing an API-created 
matched Photo scene. 

●​ Added the ability for users to change the axes location for API-created 
Matched Photo scenes. 

●​ Added Instructor content for the Image Igloo tool. 
●​ Fixed a bug where scene names could fail to display when using the Image 

Igloo tool. 

LayOut 

What's New? 

64-bit 

We have 64-bit versions of LayOut and Style Builder on Mac OS X and Microsoft 
Windows! We still offer the 32-bit version on Microsoft Windows. 

Two-segmented labels 

We overhauled the label tool! You can now conveniently place beautiful, 
two-segmentented leader labels that can easily be aligned with other labels to give 
your drawings a polished, professional appearance. 

Label auto-text 



While we were at it, we made the label tool a lot smarter. When you place a label on 
a model, you’ll be given the opportunity to choose any of the information 
associated with it as the label text. Pick an attribute of a dynamic component, a BIM 
classification type, or simply the area of a face. Because the label tags are auto-text, 
they will automatically update as you update the model. 

Improvements 

Spell checking 

We added spell checking to our Windows version. This will only work on Windows 8 
and 8.1 machines. Mac already has this feature. 

Multi-select 

You can now perform actions on more than one layer or page by shift-selecting any 
number of layers or pages. 

Dynamic vector model loading 

We now wait to load vector models until the page is viewed instead of at the time of 
document load. This offers a performance increase when documents are opened. 

Shared connections 

We’ve updated our global connections manager. You can now have connections 
between entities and auto-text on shared layers. 

Infrastructure 

We’ve upgraded versions of some of our 3rd party libraries. These include the pdf 
exporter and the UI and text editor on Windows. 



Bug Fixes 

General 

●​ Fixed an issue where documents with metric units and using a tool whose 
output of a drawing event featured polar coordinates would be wrong by a 
factor of 25.6 degrees. 

●​ Fixed a JPEG export issue when a document’s paper size had been changed 
after it had been started. The image export would not respect the new paper 
size dimensions. 

●​ Fixed an issue where Section planes would disappear from the model after 
entering and exiting 3D edit mode, if the style was set to a modified active 
style. 

●​ Fixed Label and Dimension connections to SketchUp models or LayOut 
elements which weren’t preserved after the following events: 

○​ Layers were shared. 
○​ Pages were duplicated. 
○​ Entities were copy and pasted. 
○​ Entities were made into scrapbooks and inserted into the document. 

●​ Mac: Fixed a crash on Mac OS X 10.10 (Yosemite) which would occur while 
labeling and then switching to another application using Command + Tab. 

●​ We touched up a few tool icons. These were the New, Open, Save, Print, 
Paste, and Delete buttons. 

●​ Mac: Fixed a limitation in Style Builder that would only allow you to choose 
up to four strokes per set when generating a template. 

Localization 

●​ Fixed an issue where commas, which were being used as decimal separators, 
were not working as such while interacting with the Measurements toolbar. 

Performance 



●​ We relaxed the frequency of file I/O by caching scale information. Before, the 
constant I/O could have lead to a crash. 

Rendering 

●​ We fine-tuned the vector rendering engine to more accurately detect and 
eliminate what would have previously been considered “noise” during the 
render event. 

●​ Fixed an issue when using hybrid render mode on a SketchUp model and 
toggling “Preserve Scale on Resize. Resizing would cause the underlying 
raster image of the model to change but not it’s vector lines. 

●​ Fixed an issue where LayOut wasn’t respecting the auto-rendering setting 
after changing from raster to vector/hybrid. 

●​ Fixed an issue where Profile and Section Cut edge lines would disappear 
from a model when vector rendered - if edges had been turned off within 
SketchUp’s Style settings. 

●​ Fixed Section Cut edge lines that would disappear if rendered in Hybrid 
mode. 

●​ LayOut will now load potentially corrupt documents by discarding the 
corrupted page(s) and load the remaining healthy pages. 

●​ Fixed an issue where SketchUp components that use the Cut Opening option 
in Styles were rendering neighboring faces with the wrong color. This only 
happened when using Vector rendering. 

Trimble Connect for SketchUp Release Notes 

Trimble Connect is the Trimble Buildings’ online collaboration platform. Think of it 
like a private 3D Warehouse, just for building project assets. Upload SKP’s, DWG’s, 
DXF’s, IFC’s, PDF’s and share with team members. Trimble Connect is built off the 
GTeam platform, meaning that it enables sharing, reviewing and commenting in a 
web browser. 



Alongside the SketchUp 2015 launch, we are proud to release Trimble Connect for 
SketchUp, an extension that links your SketchUp models to Trimble Connect. Once 
you download and install the extension, you can: 

●​ Sign-up for and sign-in to a Trimble Connect account 
●​ Publish, download, and update SketchUp models hosted on Trimble Connect. 
●​ Access and update reference models from Trimble Connect (which is kind of 

like importing a component model, then reloading it.) 

Trimble Connect is rolling out across the entire Trimble Buildings portfolio of 
products. That means that SketchUp, Tekla, Vico, MEP customers can all upload and 
pull-down projects from Trimble Connect. From our point of view, this is the first 
time that design-build stakeholders have had a shared workspace. Trimble Connect 
starts with a free trial that gives you one project workspace to tinker with. 

 



November 21, 2014 
Version Numbers:​
15.1.106 - Windows 64-bit​
15.1.105 - Windows 32-bit​
15.1.104 - OS X 64-bit 

SketchUp 

Bug Fixes 

●​ Windows users who installed SketchUp directly into a root of a drive, or into 
a network path that did not begin with a driver letter, or into a path with 
unicode characters in it would crash on startup. We have fixed this issue so 
that installing to these locations no longer crashes. We strongly recommend 
that users not install SketchUp into a path with unicode characters, as this 
can still cause Ruby errors. 

LayOut 

Bug Fixes 

●​ Fixed an issue where the flyout picker button would disappear on Mac as you 
typed custom text. 

 



December 18, 2014 
Versions:​
15.2.685 - Windows 64-bit​
15.2.687 - Windows 32-bit​
15.2.686 - OS X 64-bit 

SketchUp Release Notes 

Fixes/Improvements: 

●​ Fixed a crash that occurred at program startup on some computers. 
●​ Fixed a crash that could occur while exporting certain complex models. 
●​ Fixed a crash that could occur when changing the number of segments in a 

circle or polygon. 
●​ Fixed an issue that caused SketchUp Make to launch with a “SketchUp Pro is 

expired” dialog on some computers. 
●​ Fixed an issue where escaping from the Classifier tool resulted in no tool 

being active. 
●​ Added all currently supported IFC export Types to the IFC exporter Options 

dialog. 
●​ Fixed an issue where certain labels on the Welcome dialog could temporarily 

be blank after entering a license. 
●​ Mac: fixed an issue where SketchUp could lag when switching from a 

document that has lots of scenes to a different document with few or no 
scenes. 

LayOut Release Notes 

Fixes/Improvements: 

●​ Windows: fixed an issue where the gray text could go missing in the label 
attribute picker. 

●​ Fixed the issue that was causing the left align button icon to include the tool 
text when dragged to a toolbar (customizing toolbars). 



●​ Windows: fixed a rare crash in LayOut that would occur during the close 
process. 

●​ Fixed a rare crash due to a problem within the text inspector when LayOut 
launches. 

 



February 5, 2015 
Versions:​
15.3.331 - Windows 64-bit​
15.3.330 - Windows 32-bit​
15.3.329 - OS X 64-bit 

SketchUp Release Notes 

General Fixes: 

●​ Fixed an issue where the Dynamic Components and Classified badges were 
not always visible for online models in the Components browser. 

●​ Fixed an issue where the Component browser was showing an older model 
version than when downloading the component in a browser. 

●​ Fixed an issue where a Rotated Rectangle would incorrectly rotate when 
entering a length/width without an angle. 

●​ Changed the SketchUp Pro title bar to show trial days remaining when in a 
trial. 

●​ Windows: fixed an issue where thumbnails of SketchUp models were not 
visible in Windows Explorer on some machines. 

●​ Windows: fixed an issue where links on the Learn tab of the Welcome dialog 
wouldn’t open in a user’s default browser. 

●​ Mac: fixed an issue on Yosemite where month abbreviations did not fit in the 
Shadows dialog. 

●​ Mac: fixed an issue where Ruby tool icons could turn into an icon of a green 
zombie when the Ruby extension was removed or disabled. 

●​ Localization: various fixes for incorrect translations and truncated 
translations. 

Stability Improvements: 

●​ Fixed a crash with the Push/Pull tool when using the VCB after pushing a face 
up twice, selecting undo, and then selecting the face. 



●​ Fixed a crash with the Push/Pull tool in a particular case when double clicking 
to repeat an operation and using the VCB. 

●​ Fixed a crash with the Offset tool when using the VCB after offsetting certain 
faces. 

●​ Fixed a crash that could occur in the Move tool when toggling on auto-fold 
during a copy. 

●​ Fixed a crash when exporting certain models with text to an animation. 
●​ Fixed a crash when exporting certain models with different style changes 

between scenes to an animation. 
●​ Fixed a crash when drawing lines connecting vertices in extremely large 

geometry. 
●​ Mac: fixed a crash when using Outliner to drag a component into another 

component which has subcomponents and is not yet expanded. 
●​ Mac: fixed a crash when switching to another application during an 

animation export. 
●​ Windows: fixed a crash that could occur on some machines when using 

Windows Explorer to view SketchUp models. 
●​ Windows: fixed a crash that could occur in certain complex models when 

exporting to .3ds, .obj, .xsi, or vrml file types. 
●​ Windows: fixed a crash when inserting certain components, undoing the 

insert, and pressing Escape while trying to drag/drop the component again. 

Exporter and Importer Improvements: 

●​ IFC: added the ability to export transparent materials. 
●​ IFC: added the ability to export geometry that was classified as IfcSite, 

IfcBuilding, or IfcBuildingStorey. 

LayOut Release Notes 

General Fixes: 



●​ Fixed a bug on Windows related to particular fonts of symbol character sets 
(as opposed to ANSI) not properly rendering. We updated a text library to 
add support for symbol character sets, e.g., Flux Architect. 

●​ Fixed a bug with exploding labels and dimensions, where auto-text wouldn't 
work anymore after undoing the explode. 

●​ We put in a fix that changes the horizontal constrainment behavior of the 
label leader. The label tool will now constrain the second leader line to 
horizontal. Previously, the user needed to hold Shift to constrain to 
horizontal. 

●​ Fixed a dwg export issue that would cause some templates to export with a 
landscape orientation when portrait was expected and vice versa. 

●​ Fixed a bug where window restoration would interfere with LayOut's ability 
to show the recovered files at launch after a crash. 

●​ Fixed a Yosemite bug where LO's font panel accessory view wouldn't be 
correctly initialized when the font panel was restored (if previously open 
when LO quit). 

●​ Fixed a bad German translation for the text that appears in the delete layers 
dialog. 

●​ Fixed a bug that prevented the version number from showing in the About 
dialog for some localized versions of Style Builder. 

●​ Mac only: Fixed a bug that caused scrapbooks to save to the app bundle 
instead of the users’ application support directory or any custom directory.​
​
If you have created scrapbooks in LayOut 2015, you will need to copy them 
from /Applications/SketchUp 2015/ 
LayOut.app/Contents/Resources/English.lproj/Scrapbooks/ 
before you delete the old version of LayOut, or they will be lost (if you are 
running a localized build, replace ‘English.lproj’ with the localized version you 
have installed). 

 



February 27, 2014 
​
Version Numbers: ​
Win: 14.0.4900 ​
Mac: 14.0.4899 

  

SketchUp 

Issues Fixed: 
General 

●​ Fixed a crash that could occur when loading models with invalid match photo 
images. 

●​ Fixed a crash that could occur when opening models containing images with 
certain Exif data on them. 

●​ Fixed an issue where certain models with large textures and nicer 
transparency could become unusable after toggling x-ray mode off and on. 

●​ Fixed an issue where SketchUp could appear to hang after switching between 
a scene with no transparency and one with nicer transparency. 

●​ Fixed the Layers toolbar to perform a case-insensitive sort when sorting 
layers. 

●​ Fixed an issue where 64-bit 4 x 16-bit RGBA alpha images displayed opaque. 
●​ Fixed an issue where artifacts could be seen when holding down the left 

mouse button and moving the mouse rapidly with the Select tool active. 
●​ Fixed an issue where drag selection did not always work properly after doing 

a triple-click select. 
●​ Changed the units display of areas and volumes to now follow ISO 

conventions - e.g., we now display 100 mm2 vs 100 Millimeters2 

●​ Added better error reporting when entering the wrong type of license to 
SketchUp. 

●​ Changed the Text tool to report the xyz coordinate location when adding text 
to construction points. 



●​ Windows: fixed a common crash that could occur when opening certain 
models with large images on XP. 

●​ Windows: fixed an issue where thumbnail images in the Component Options 
dialog did not display for standard, non-admin users. 

●​ Windows: fixed an issue where cancelling from saving a file with the "File > 
Save As" menu resulted in a failure to prompt you to save unfinished work. 

●​ Windows: fixed an issue where material (*.skm) files saved on Windows 
would not display material thumbnails on the Mac. 

●​ Mac: fixed an issue where in model materials were not visible until opening 
or creating a model. 

●​ Mac: fixed an issue where the Layers toolbar did not change the current 
layer. 

●​ Mac: fixed Photo Textures to accurately grab textures on Retina displays. 

User Interface 

●​ Added, to the Getting Started toolbar, new drop down toolbars that group 
together tool sets. 

●​ Changed the Draw menu to group certain tool sets together. 
●​ Changed the Large Tool Set on the PC to be fixed at 2 columns and to dock 

vertically. 
●​ Fixed a bug where the status bar was not showing text when hovering over a 

menu or toolbar. 
●​ Changed the "Zoom Extents" context menu to "Zoom to Selected" to more 

accurately describe what it does. 
●​ Mac: fixed a Mavericks-specific bug where snappy dialogs don't stay together 

when they are collapsed/expanded. 
●​ Mac: fixed an issue where SketchUp would not remember that Ruby toolbars 

were opened. 
●​ Mac: fixed a case where a snappy dialog stack containing the Styles dialog 

could break apart when being expanded/collapsed. 
●​ Mac: added a warning message when deleting a scene via the scene context 

menu. 
●​ Windows: increased the size of the face style buttons in the Styles browser. 



Exporters and Importers 

●​ We updated the DWG libraries to support AutoCAD 2013. 
●​ Fixed an issue with the DWG importer where some arcs could import 

inverted/displaced. 
●​ Fixed an issue where some *.kmz files failed to import into SketchUp. 
●​ Mac: DWG import now imports solid, region and body entities! 
●​ Mac: fixed animation export to work when specifying a custom frame size. 
●​ Windows: fixed EPS export to work and no longer create blank files. 
●​ Windows: fixed mp4 animation export to no longer drop frames right before 

the video pauses on each scene. 
●​ Windows: fixed an issue where you saw an "Unable to create video file" error 

when exporting animations to the mp4 format with certain custom settings. 

Shadows 

●​ Hidden geometry made visible via View > Hidden geometry used to 
incorrectly cast a shadow. With SU 2014, it no longer casts shadows. 

●​ Fixed an issue where, if the "enable transparency" setting is turned off, 
SketchUp would ignore that setting and still treat faces as transparent for 
shadow casting, resulting in shadows not being cast that should have been. 

●​ Fixed an issue where face me components with transparent materials that 
should not cast shadows (opacity < 70), previously cast shadows. 

●​ Fixed an issue where edge shadows were incorrectly cast when a section 
plane lies right on a face. 

●​ Fixed an issue where, in models with faces that are slightly non-planar, 
stringy shadows could be seen. 

Ruby API 

●​ We upgraded the Ruby API runtime to Ruby 2.0 with full Standard Library, 
giving Developers a better platform for creating new SketchUp tools and one 
that offers improved support for non-English characters, section planes, text 
and dimensions and more. ​



If you use Ruby plugins, be sure to read this article which explains how to 
migrate your plugins to SketchUp 2014. If you don't follow these instructions, 
some of your plugins may not work!​
If you are a Ruby Developer, check out our Developer Release Notes to see 
what has changed. 

Known Issues: 
General 

●​ Windows: units displayed for materials, arcs, curves and circle entities can be 
incorrect after changing your model's units. To work around this issue, open 
SketchUp using a template that has your desired units - SketchUp is currently 
using that template to determine the units for these entities. 

●​ Mac: when opening large models, toolbar icons on the new Drop Down 
toolbars can disappear as shown in the following. Note: though this looks 
scary, the drop down menus will still work if you select them. 

 
●​ Mac: SketchUp does not clean up after itself when closing models. If you are 

closing lots of models on the Mac, memory can increase and eventually, 
SketchUp can crash. 

●​ Mac: SketchUp can issue an error ("NoMethodError: undefined method 
‘size=' for nil:NilClass".) after uploading a model to the 3D Warehouse and 
grabbing a Photo Texture. To work around this issue, open the Component 
Options dialog or re-launch SketchUp. 

Classifier 



●​ Although, SketchUp can import a valid XSD file or collection of files that use 
the "http://www.w3.org/2001/XMLSchema" namespace, the following are 
known issues with parsing the format: 

○​ The XML Schema format allows for circular importing of XSD files (i.e. 
two files referencing each other with the element). At this time, 
SketchUp does not allow for this type of circular dependency. 

○​ The XML Schema format allows for externally referenced XSD files. At 
this time, SketchUp will fail to import XSD files that reference external 
files. A workaround is to download the externally referenced file and 
change the path in the parent XSD file to point to the local copy. 

○​ Any <xsd:list> or <xsd:choice> attributes will not appear in the 
Component Options dialog (where classification attribute data is 
displayed). We may expose these in future versions of SketchUp. 

●​ De-classifying entities is confusing. Currently, to de-classify a 
component/group, you must pull down the Type drop down and re-select the 
Type you originally selected. We will make this process easier in a future 
release. 

3D Warehouse 

Things to know: 

●​ Our new integrated WebGL viewer, which allows you to preview and orbit 
models in full 3D before downloading them into your own project, is 
accessible via the "View 3D Views of this model" button when viewing a 
model in the 3D Warehouse. The WebGL viewer works in WebGL enabled 
browsers - you can find out if your web browser is WebGL enabled by clicking 
here. 

●​ If you used the previous 3D Warehouse and had an avatar image associated 
with your account, that image will not be shown to other users by default for 
privacy reasons until you log in to the Warehouse. 

●​ We have improved the web upload form to support SketchUp (.skp) and KMZ 
file formats. This means you now have the option to upload SketchUp 
models via SketchUp's embedded 3D Warehouse window (File > Share Model 
& File > Share Component), or when signed in to 3D Warehouse via your web 



browser and clicking Upload Model from the user menu. Note: The web 
upload form supports the upload of new models: it does not support the 
upload of edited versions of models that have previously been uploaded to 
3D Warehouse. 

●​ Models on 3D Warehouse can either be private or public and all public 
models are downloadable. If you had a model on the old 3D Warehouse that 
was set to 'public but not downloadable' that model is now private and you 
have the option of either keeping it private, or making it public. 

Known issues: 

●​ Windows: the WebGL viewer currently does not work when launching the 3D 
Warehouse from within SketchUp due to older versions of Internet Explorer 
not supporting WebGL. The good news is that WebGL will be supported in 
future versions of Internet Explorer. 

●​ The 3D Warehouse no longer supports collaborator access control levels. If 
you owned a model on Google's 3D Warehouse and invited collaborators, 
you will remain the owner, and collaborators will no longer have access to 
your model. This means that users who had access to your private models, 
owned by you, will no longer be able to view or edit those private models. 

●​ 5-star ratings and reviews are no longer available. We are working on a 
simpler "like" mechanism. 

●​ On the Mac, logging into the 3D Warehouse via SketchUp will log you into the 
same account in Safari. We will change this behavior in a future release. 

LayOut 

Issues fixed: 

●​ On Macs, templates, scrapbooks, and pattern fills would disappear if you had 
moved LayOut.app from it's default install location to somewhere else on 
your hard drive. 

●​ When a scene was aligned to a section plane, dimension measurements were 
incorrect. Views aligned to a section plane will now have paper space 
dimensions, just like standard top/front/right/etc. views did previously. 



●​ LO used to crash on close if the user didn't have write-access for their PLO or 
xml files. LO will now display an error dialog if it fails to write the PLO file, and 
will no longer crash. 

●​ The ending arrowhead of a polygon was drawing in the wrong location 
(usually in the center of the polygon). 

●​ The use of maximum texture size and hardware acceleration SketchUp was 
not reflected in LayOut. Now, all OpenGL settings from SU are reflected in 
LayOut. The use of hardware acceleration is carried over into LayOut. Also, 
high resolution images and textures brought into LayOut will be the same 
size as they were in SketchUp. 

●​ Pattern Fills inside groups were not appearing in the "In-Document Patterns" 
list. 

●​ Trying to save a corrupt file would also corrupt the autosaved file. We now 
detect the case where an auto-save is available (and newer than the saved 
document), and allow the user to revert to the auto-saved version. 

●​ Chinese and Japanese Input method editor (IME): there was some focus 
confusion between the IME and the in edit text cell. This was causing the IME 
to fail to update the the edit cell. 

●​ The IME window position and font size was not correctly updating if the user 
had zoomed or scrolled during a text edit. 

●​ Scaling about center using the the alt modifier on a SketchUp model was not 
respecting the "Preserve Scale on Resize" option. 

●​ Picking through styles, we found that a SketchUp model would sometimes 
not update to the style selected. This despite the expected style being 
highlighted in the Styles tab. 

●​ On Macs, the Ungroup button was not working if added from the Customize 
Toolbar dialog. 

●​ Radians would sometimes show if angle degrees had been selected in the 
Dimensions inspector (and vice versa). 

●​ LayOut pointer icons were inverted on 64-bit machines running Windows XP. 
This fix will require the user to add a special key to the SketchUp Preferences 
registry. 

●​ Undoing a layer deletion (with all of the entities on that layer) would put the 
layer back, but not it's deleted entities. 



●​ Line break logic for Chinese, Japanese, and Korean languages was not right 
for line closing and line beginning punctuation marks during a text edit. 

●​ Sometimes rendering a SketchUp model in Vector or Hybrid would show 
lines that shouldn't be there (and wouldn't be there in a Raster rendering). 

●​ Right-clicking on blank space would clear the selection set. We improved this 
by showing the blank-space-context-menu while maintaining the selection 
set. 

●​ If a save fails we now offer to restore the auto-saved version or revert. 
●​ On Windows, you couldn't change text font as you were creating the text. In 

order to change the font, you had to first create the text then select the text 
and change the font. This occurred with the Text and Label tools. 

●​ There was an extraneous space between the document scroll bars and the 
inspector tray and status bar when LayOut was ran on a Windows machine 
with display scaling greater than 100 percent. 

●​ Inspectors were not expanding and collapsing properly on OS X 

Known Issues: 

●​ PLO files store the customizations users have made the the GUI (i.e, 
inspectors and toolbars). However, new PLO files are created for each Major 
and Minor release. This essentially means that users customizations are 
never carried over. A work around for the user would be to copy the name of 
the previous install's PLO file over the name of the most recent PLO file. 

●​ Faces that have overlapping holes created by openings (components that 
intersect the face) are currently causing the HLR item buffer to get confused. 
If a component, defined with a "Cut opening" behavior (Components > Edit > 
Glue to: Any > Cut opening), is placed on a face within or overlapping with an 
existing hole, HLR can get confused and display linework that would 
otherwise be hidden by said face. 

 



June 3, 2014 
Version Numbers: ​
Win: 14.1.1282 ​
Mac: - 14.1.1283 

SketchUp 

General 

●​ Fixed the File > Generate Report functionality which was failing to generate a 
report.​
Note: if you are installing SketchUp 2014 M1 over a previous version of 
SketchUp 2014, you will need to go to the Extension Warehouse and update 
the Dynamic Components extension to receive this fix. If you are installing 
SketchUp 2014 M1 for the first time, no further action is needed. 

●​ Fixed a "Callback function" error that could occur when a single 
non-component (or non-group) entity was selected and Component Options 
dialog was opened. 

●​ Fixed the Component Browser search box to no longer show the text 
"Is:downloadable" when paging through search results. 

●​ Fixed an issue where shadows did not update properly when switching 
between scenes in models where scene transitions were turned off and the 
"Shadow setting" Property to Save was unchecked. 

●​ Changed the status bar text for the Paint tool to fix some text that was 
incorrect. 

●​ Windows: fixed an issue where the units displayed in the model were not 
always correct after changing them in Model Info > Units. This issue showed 
up when viewing the dimensions of materials and when selecting arc, curve 
and circle entities. 

●​ Mac: fixed an issue where Photo Texturing could fail after uploading a model 
to the 3d Warehouse.​
Note: if you are installing SketchUp 2014 M1 over a previous version of 
SketchUp 2014, you will need to go to the Extension Warehouse and update 



the Photo Textures extension to receive this fix. If you are installing SketchUp 
2014 M1 for the first time, no further action is needed. 

●​ Mac: fixed an issue where dropdown toolbar icons could sometimes 
disappear, leaving only arrows. 

●​ Mac: updated the Advanced Camera Tools so that the + and - keys work 
again.​
Note: if you are installing SketchUp 2014 M1 over a previous version of 
SketchUp 2014, you will need to go to the Extension Warehouse and update 
the Advanced Camera Tool extension to receive this fix. If you are installing 
SketchUp 2014 M1 for the first time, no further action is needed. 

Classifier 

●​ Added the ability to import classification systems that reference external 
files. 

●​ Fixed the filter box to accurately find Type information when searching on a 
keyword that matches the classification system name. 

●​ Added an error message when importing classification systems that have 
circular dependencies (which are currently not supported). 

●​ Fixed an issue where duplicate attributes could be seen when importing 
certain classification systems. 

●​ Relaxed the strict format requirements for the "created" and "modified" date 
fields in the documentProperties.xml file within the SKC format. 

●​ Windows: fixed a crash that could occur when doing a File > New after 
canceling a classification import. 

●​ Mac: fixed a crash that occurred when filtering on a keyword and toggling 
simplification in models with multiple classification systems. 

●​ Mac: fixed an issue where the IFC Options Cancel button didn't cancel 
changes made to the options. 

Localization 

●​ Unicode languages: fixed a very common crash that could occur when saving 
some models with validity errors. 

●​ Made numerous fixes for incorrect translations. 



Ruby - Please review our Ruby Release Notes here. ​
SDK 

●​ Mac: changed the deprecated SDK (SkpReader) to be able to read SketchUp 
2014 files. 

SketchUp Viewer 

●​ Mac: fixed an issue that caused SketchUp Viewer to crash when launching it 
on a machine where SketchUp was not installed. 

LayOut 

Bug Fixes: 

●​ Mac: Model surfaces containing "cut opening" components would sometimes 
disappear when vector or hybrid rendered, revealing linework that should 
have otherwise been hidden. 

●​ Mac: LayOut would freeze or crash during a vector or hybrid render of 
certain models and has been resolved. 

●​ Windows: The thumbnail list of pages in the Page Inspector was not properly 
refreshing when switching between 2 or more open documents. Upon 
switching to another open document, the Page Inspector would continue to 
show the previous document's thumbnails. 

 



May 21, 2013 
Version Numbers: ​
Win 13.0.3689 ​
Mac 13.0.3688 

SketchUp: 

New Features and FYI's: 

●​ An Extension Warehouse has been created and integrated with SketchUp. 
Users can now manage hundreds of extensions installed on their computer 
via the Extension Warehouse. 

●​ The word "SketchUp" now refers to a product family of which there are two 
members: SketchUp Pro and SketchUp Make. 

●​ Toolbars for SketchUp on Windows operating systems have been improved. 
They are now customizable and more reliably stay put once they have been 
docked, or you can customize by right-clicking in the toolbar area. 

●​ Scene-based animations can now be exported to high-quality video from 
SketchUp. 

●​ Toolbars and cursors have been updated and made consistent between 
SketchUp, LayOut, Style Builder and SketchUp Viewer. 

●​ The Select tool is now the default tool. 
●​ We have a new SDK. See the "getting_started.html" and 

"migration_guide.html" in the SDK package for details. 
●​ Lots of little tweaks, bugs fixes and improvements were made to existing 

features. 
●​ SketchUp no longer will take a long time to open and close with an unstable 

Internet connection. 
●​ (Mac) SketchUp does not support OS X 10.6 and older versions of OS X. Users 

with these platforms will see an error on launch. 
●​ (Windows) XP SP3 is now required to run SketchUp on XP. 

Extension warehouse/Ruby plugins: 



●​ We are installing only the following extensions with the product : Advanced 
Camera Tools, Dynamic Components, Sandbox Tools, Photo Textures. The 
other SketchUp 8 extensions (Ruby Script Examples, Ocean Modeling, 
Utilities Tools, Shadow Strings Fix toolbar, Solar North toolbar) are available 
for download on the Extension Warehouse. 

●​ The plugins directory on the Mac has moved to ~/Library/Application 
Support/SketchUp 2013/SketchUp. We no longer install anything into the 
Macintosh HD/Library/Application Support/SketchUp directory. 

SketchUp Toolbars (Windows only): 

●​ Toolbars now stay put and you can customize toolbars containing non-Ruby 
tool icons! 

●​ The SketchUp 8 "Save toolbar positions" menu choice has been removed as it 
is no longer needed - toolbar settings are saved when exiting SketchUp. 

●​ View > Toolbars shows just one menu choice now. Customization of toolbars 
has been moved to one dialog. 

●​ SketchUp 2013 does not have the ability to create 2 column vertical toolbars 
(a limitation of the libraries we used as the basis of our new toolbars). If you 
want to create a setup similar to what is in SketchUp 8, you can either create 
a few new custom toolbars, docking them side by side to create 2 columns, 
or you can dock some of our smaller toolbars side by side. 

●​ To customize non-Ruby toolbars, bring up the View > Toolbars dialog. You 
can move an icon from one toolbar to another by dragging it or pressing the 
Alt key. Holding down the Ctrl key allows you to copy an icon. Right clicking 
on a toolbar gives you some additional functionality. 

Known issues: 

●​ (Mac) Photo texture dialog turns black when switching faces. The 
workaround is to disable HWA in Safari. See this article for how to do that. 

●​ (Mac) The "Create new Style" button does not create a style with a unique 
name. To workaround this issue, rename new styles to have unique names. 

●​ (Localization) Function names for some dynamic components functions are 
incorrectly translated in some languages. When selecting these functions via 



the Dynamic Component interface, users will need to re-name them to their 
proper English names for them to work. 

●​ (Windows) a "CFileException 3..." error occurs when auto-save activates if the 
"Models" directory in Preferences > Files is set to a location that does not 
exist..." 

●​ (Windows) The status bar no longer shows text when hovering over a menu 
item or toolbar icon. 

●​ (Mac) When using the drac-select feature to select things, ghost artifacts can 
be seen. 

●​ (Windows) Menu items/toolbar become grayed out when clicking in and out 
of the SketchUp window. The menu items/toolbars are fully functional 
though and moving the SketchUp window returns them to their correct 
appearance. 

●​ Section planes are not immediately visible when they are copied into a new 
document. Work around this issue by toggling on section planes in the Styles 
dialog box (View > Section Planes) 

●​ (Mac) Solid, body, and region entities can not be imported by the DWG 
importer. Not a regression. 

●​ Google login is sometimes shown when selecting File > Generate Report or 
when selecting Window > Photo Textures. Logging in to your Google account 
when selecting Window > Photo Textures appears to be a workaround that 
fixes both the Photo Textures and Generate Report functionality. 

●​ (Extension Warehouse) Translations still not 100% complete throughout the 
site. 

●​ (Extension Warehouse) When you submit a developer application, you 
sometimes see an error "Email was not sent." But we should have received 
the application anyway. 

●​ (Extension Warehouse) Mouse scroll wheel doesn't work until you click into 
the dialog. 

LayOut: 

General 



●​ Changes were made to improve overall performance with LayOut. 
●​ Shapes can now be filled with image-based patterns in addition to solid 

colors. This is called Pattern Fill. 
●​ LayOut now has the ability to create multi-copy arrays, similar to the way 

SketchUp works. 
●​ Text leader lines can now be curved. 
●​ Users can now zoom in to a document up to 10,000%. 
●​ To better reflect standards, dimensions now have dashes to separate feet 

from inches. 

Known Issues 

●​ (Localization) LayOut will continue to use Templates, Scrapbooks, and 
Pattern Fills from the previous install of LayOut after upgrading or 
reinstalling. This will only become apparent if the user has gone from one 
language version of LayOut to a different language version. It will appear as if 
there are no templates to choose from in the getting started screen. Navigate 
to Preferences > Folders and click on restore defaults for Templates and 
Scrapbooks and restart LayOut. After, the application will work as designed. 

●​ The thumbnail images shown by the Pattern Fill inspector will have a white 
background by default, which is visible for any non-opaque pixels in the 
image. For some types of pattern images that use white linework, it is 
necessary to override this default white background with something darker 
to make the white linework visible. This can be achieved by saving the PNG 
file with a bKGD chunk (background color). Gimp is free and supports this 
option when exporting PNG files. 

●​ LayOut's page draw performance is noticeably slower on a Macbook pro with 
retina display than it was on previous generation non-retina Macbook pros. 
With the retina display, there are 4 times as many pixels to fill every time the 
page is drawn, but the processing power of this first generation of the 
Macbook Pro retina is not 4 times better than its non-retina predecessor. For 
users working with very complex pages in a LayOut document that suffer 
from sluggish performance, there is a setting that allows the user to force an 
application to run in low resolution on a retina display. See the section "I'm 



noticing functional or visual issues with an application. How can I make it 
work better?" here: http://support.apple.com/kb/HT5266 

 



June 12, 2013 
Version Numbers:​
Win 13.0.4124​
Mac 13.0.4123 

SketchUp: 

●​ (Windows) Ruby toolbars have been fixed so that they dock in the right place, 
as opposed to behind other toolbars. 

●​ (Mac) Dynamic Components Options and Attributes dialogs have been fixed 
so that they no longer display an empty window. 

●​ (Mac) Corrected WebDialog.get_element_value to properly support 
HTML elements. 

LayOut: 

●​ (Windows) Copying geometry from SketchUp and pasting it into LayOut is 
supported again. 

Style Builder: 

●​ (English and French) The Style Name label has been given extra padding to 
eliminate an overlap with the input box in the Stroke Settings panel. 

 



August 15, 2013 
Version Numbers:​
Win 13.0.4812​
Mac 13.0.4811 

SketchUp: 

The following issues have been fixed: 

●​ Graphics card-related crash when updating scenes which use a standard 
view (e.g., Top, Front) on some machines. 

●​ Mac: crash when exporting a model with dimensions or text to 2d DWG. 
●​ Mac: VCB does not work if you give it focus. Previously, when clicking in or 

tabbing to the VCB on the Mac and typing data, the VCB didn't behave as 
expected. 

●​ Mac: machines with a 10.8 operating system show instructor content that is 
Windows-specific. 

●​ Windows: crash when selecting the "File" menu item on a small subset of 
machines. Previously, on some machines, selecting the File menu item 
crashed SketchUp. This crash was caused by the fact that we used to load all 
exporters and importers when the File menu item was selected and, on some 
machines, loading the FBX exporter caused SketchUp to crash. Now, we only 
load exporters and importers when exporting or importing files. This should 
lessen the likelihood of experiencing the crash - i.e., the crash should occur 
now only when selecting File > Export > 2d graphic and File > Export > 3d 
graphic vs when selecting the File menu item. We are still working on fixing 
the FBX crash itself. The workaround to this crash is as follows: 

1.​ Open Windows Explorer 
2.​ Navigate to the C:\Program Files (x86)\SketchUp\SketchUp 

2013\Exporters directory (or wherever you have installed SketchUp) 
3.​ Rename the file 'Skp2Fbx.dll' to some other name - e.g., Skp2Fbx.bak 
4.​ Launch SketchUp again - the crash should no longer occur 

●​ Windows: SketchUp loses floating toolbar visibility state when closing from a 
minimized state. Previously, floating Ruby toolbars would no longer be visible 



when re-launching SketchUp if SketchUp were closed from a minimized state 
via the Windows taskbar. 

●​ SketchUp quits extracting at first failure when extracting files from *.rbz zip 
files. Previously, when extracting *.rbz files, SketchUp would quit on first 
failure. Now, SketchUp continues to extract files if it encounters failures. 

●​ Clicking on the "Name" column header in the Layers dialog doesn't sort 
layers as expected. 

●​ Model Info > Geolocation Dialog does not always refresh after adding a 
location. Previously, after adding a location, the Model Info > Geolocation 
dialog did not always reflect that a location had been added. 

●​ Crash when clicking on a material or style on some Unicode configurations. 
SketchUp previously crashed when clicking on a material or style when it was 
run using a username containing Japanese/Chinese characters on a native 
operating system. 

●​ SketchUp fails to export and import for some Unicode configurations. 
SketchUp previously failed to import and export files when it was run using a 
username containing Japanese/Chinese characters on a native operating 
system. 

●​ Bad translations, missing translations and string truncations for the FIGS 
languages. 

●​ Crash when de-authorizing SU when using the Italian Windows build. 

The following new things have been added: 

●​ We have new installs for the following languages - Japanese, Korean, Brazilian 
Portuguese, Simplified Chinese and Traditional Chinese. 

LayOut: 

The following issues have been fixed: 

●​ Crash on startup, or shortly after initialization, on Windows machines with 
user account names that were composed of at least one special character. 
Typically, this was more present with localized builds. 



●​ Bad translations, missing translations and string truncations for the FIGS 
languages. 

The following new things have been added: 

●​ We have new installs for the following languages - Japanese, Korean, Brazilian 
Portuguese, Simplified Chinese and Traditional Chinese. 

 



September 1, 2010 
Good to know: 

●​ We've added the ability to pre-select a face when using the Push/Pull tool. 
The Push/Pull tool now behaves similarly to our other tools (e.g. Move), but 
be sure that you don't have an incorrect face selected prior to activating the 
tool. 

●​ The Scenes dialog has been reworked to show scene thumbnails. The first 
time you open the Scenes manager with a pre-SketchUp 8 file, we generate 
thumbnails for all of your scenes. You can always stop this process or tell 
SketchUp never to generate thumbnails for that model. 

●​ The timezone drop-down has moved from Model Info to the Shadow Settings 
dialog box. We've also added additional UTC offsets, including fractional hour 
offsets. 

●​ We upgraded our API's Ruby interpreter from version 1.8.0 to 1.8.6, which is 
a better supported, more stable version. This gives API users the benefits of 
hundreds of Ruby bug fixes, but version 1.8.6 is also more strict on Ruby 
syntax. If a script is broken, you may need to contact the script's original 
author to get an upgraded version. 

●​ The DWG and DXF import and export features now support 2010 versions of 
AutoDesk software. 

●​ The Display shadows setting is now a button, not a checkbox. You can find it 
next to the timezone drop-down in the Shadow Settings dialog box. 

●​ Match Photo's opacity, background photo, and foreground photo settings 
have been moved to the Styles dialog box. 

●​ (Mac only) The Display shadows checkbox has been removed from the 
customized Shadows toolbar. You can get the same functionality by dragging 
the Shadows toggle separately to your customized toolbar. 

●​ (Mac only) The Eraser and Zoom extents tools have been removed from the 
main toolbar. See this article for more information. 

●​ (PC only) You can now save toolbar positions via the View > Toolbars > Save 
Toolbar Position menu item and then restore them via the View > Toolbars > 
Restore Toolbar Position menu item. 



The following notable issues have been fixed: 

●​ The reported area of materials is now correct with scaled or internally 
rotated components. 

●​ (PC only) Importing shortcuts on the PC now allows you to overwrite our 
defaults if you had changed them. 

●​ (Mac only) Disabling Auto-activate paint tool now actually disables the 
auto-activation of the Paint tool. 

●​ This new release contains fixes for two security issues: 
1.​ The authors of the third-party libpng graphics library published a 

vulnerability warning for older versions of the library. It is unclear 
whether the way SketchUp uses libpng could be exploited, but the 
library was updated to version 1.2.44 as a precaution. 

2.​ SketchUp could fail to properly handle certain types of invalid edge 
geometry when parsing a malicious .SKP file, resulting in a potentially 
exploitable crash. We would like to thank Dave Weston from the 
Microsoft Vulnerability Research Center (MSVR) for reporting this issue 
to us. 

Known Issues: 

●​ Materials created by Building Maker can look excessively black during LOD 
processes or when "Shading without textures" is enabled. 

●​ Building maker system requirements message can be incorrect when 
launching Building Maker via SketchUp. You do need to have Internet 
Explorer 7 installed, even though Chrome is listed as an option. 

●​ When editing a component and hiding the rest of your model (using Model 
Info > Components) images aren't hidden. 

●​ Solid tools and Outer Shell operations do not maintain Dynamic Component 
attributes. 

●​ Selecting a hidden group or component with the outliner does not reveal the 
component. 

●​ (Mac only) DWGs with 3d solids, body and region entites can no longer be 
imported due to a DWG library bug. 



●​ (Mac only) In rare cases, memory can increase rapidly when editing 
components with the Component browser open. If you notice this you'll want 
to save your model and restart SketchUp 

●​ (PC only) Importing shortcuts may cause a multitude of dialog boxes - one for 
each default shortcut you override. 

LayOut 3.0 ​
​
Released 9/1/2010 

Good to know: 

●​ You can export your LayOut files to DWG/DXF. 
●​ You also have more control over dashed and dotted line patterns. 

The following notable issues have been fixed: 

●​ Exporting to PDF would fail if your document included a font that was not 
licensed for embedding. We now substitute a different font so that you can 
still export, but the export may look different from your on-screen 
document. 

●​ LayOut 2 often couldn't open corrupt files. LayOut 3 can open many of these 
files, though some data may be missing. 

Known Issues: 

●​ We changed the way dimensions offset from their connection point. As a 
result, when you open a LayOut 2 file with dimensions in LayOut 3, the offset 
point will be on top of the connection point. To reconnect a dimension to 
another entity, you must first move the offset points along the extension line 
to get them out of the way. You can then select the connection points and 
move them. 

●​ Dashed lines from LayOut 2.1 files will look different when opened in LayOut 
3; the spaces between dashes and dots are now four times longer than they 



used to be. To get the dashes to look like they did before, select the lines and 
then select .25 x in the Dashes Scale drop-down. 

●​ (PC only) Exporting to PDF with a "dash-dash-dot-dot-dot" line style does not 
export correctly. 

●​ (PC only) Custom icons and toolbars will not be saved when upgrading. 
●​ (Vista and Windows 7) SketchUp's "Send to LayOut" command may not work 

if LayOut is already open. You can fix this by following the steps below: 
1.​ Right-click on the LO3 desktop icon. 
2.​ Select Properties. 
3.​ Click on the Compatibility tab. 
4.​ Check Run this program as an administrator. 
5.​ Click Apply. 

 



January 12, 2011 
​
SketchUp 

  

The following issues have been fixed: 

Shadows: 

●​ The shadow bug has been fixed! Previously, when the eye was in shadow, 
artifacts that look like inverted shadows could show up over all or part of the 
screen and annoying flickering could show up during animations. 

●​ The "shadow strings" bug has been fixed too. Previously, shadows could 
show string-like artifacts. There is now a Shadow Strings Fix toolbar which 
allows you to toggle on and off a fix for this issue. 

Push Pull and Follow Me: 

●​ The Follow Me cursor is now correctly shown when using the Follow Me tool 
with pre-selected items. 

●​ The Follow Me cursor is now correctly shown when activating the Follow Me 
tool via a keyboard shortcut. 

●​ The Context menu items are now complete when activating the Push/Pull or 
Follow Me tools and right-clicking on an entity. 

●​ (Mac only) Previously, certain shortcuts weren't respected while using the 
Push/Pull tool. This issue has been fixed. 

Image export: 

●​ (PC only) In this release, Windows users should be able to export images at a 
higher resolution. Export capabilities still depend on your computer 
environment but are now consistent between Mac and Windows machines. 



●​ When exporting images with the camera.aspect_ratio set to a non-default 
value, block-like artifacts could be seen in the exported images. This issue 
has been fixed. 

Performance: 

●​ In this release, SketchUp is now built using the /Largeaddressaware property 
on the PC. This change allows SketchUp to potentially allocate/address more 
memory on 64-bit machines. (Note: 64-bit users must have at least 1.89 GB 
RAM to see any improvement, and improvement is only noticeable in areas 
where memory was a limiting factor (e.g exporting images). 

Outliner (Mac only): 

●​ Previously, when working in Outliner and selecting or editing entities, 
non-selected entities might expand or contract. Additionally, after scrolling in 
the Outliner, sometimes choosing an entity would select a different entity 
than desired. Both of these issues have been fixed. 

●​ Search now works properly after minimizing and restoring the Outliner. 
●​ Component and group names should now be visible in Outliner results after 

doing a keyword search. Found items are shown in red. 
●​ The Rename context menu on the Outliner > Details menu works as 

expected and allows you to rename components and groups. 
●​ Previously, when renaming a component by single clicking on the name in 

the Outliner, you couldn't see the text as you typed it. You should now be 
able to see the text when renaming components or groups via this method. 

Add Location: 

●​ (Mac only) Previously if you launched the Add Location dialog, kept it open, 
and then closed the SketchUp model, the Add Location dialog would no 
longer open. This issue has been fixed. 

●​ Previously when navigating to a location and then taking a snapshot, the 
maps portion of the dialog re-sized in a way that was visually jarring. We have 
improved the appearance of the dialog in this case. 



Animation: 

●​ In some cases, animations exported on the Mac in SU8 were not as smooth 
as they were in SU7.1. The underlying issue has been fixed. 

●​ (PC only) You are now able to select a codec other than the default. 
●​ (PC only) Estimated file size is now correct (previously it was reported always 

as 0). 

3D Warehouse: 

●​ Previously, uploading large models to the 3D Warehouse might fail. You 
should be able to upload models up to 10MB. 

●​ (Mac only) Previously, when you searched in the Components browser and 
then clicked on a results link for the first time, you were sometimes brought 
to the wrong model in the 3D Warehouse. This has now been fixed and 
clicking on links should always bring you to the correct model. 

Outer Shell: 

●​ When performing Solid tool operations on coplanar geometry where some of 
the geometry is on a hidden layer and some is not, geometry could 
incorrectly be removed. This issue is now fixed and the Solid tools ignore the 
hidden geometry in this specific case. 

Toolbars: 

●​ Previously, when adding new Ruby toolbars and relaunching SU, existing 
Ruby toolbars could unexpectedly reposition themselves and Restore 
Toolbar positions would not restore toolbars to their original positions. This 
issue has been fixed. (Note: it is still possible for Ruby toolbars to become 
repositioned when deleting plugins.) 

Scenes: 



●​ Geometry will not disappear when generating scene thumbnails in a model 
where hidden layers were created via Ruby. 

●​ (Mac only) Scene thumbnails are only created if the Scenes dialog is open. 
●​ (Mac only) When creating a scene via the View menu the scene thumbnail is 

now created immediately. 

Match Photo: 

●​ Previously, when opening a model or creating a new matched photo scene, 
the active scene was not selected causing confusion as the settings shown in 
the Scenes panel could differ from the settings of the active scene. This issue 
has now been fixed. 

Localization: 

●​ (Mac only) When using the "Save as" context menu for a component, the 
model will now be saved even when saving to a folder with international 
characters. 

●​ Many translation fixes for localized versions of SketchUp. 

EPix: 

●​ Five separate fixes for EPix export including correctly exporting 
similar-looking materials and materials that matched the background color, 
exporting the default front face color, and exporting edges correctly. 

Ruby: 

●​ The View.pick_helper(x,y,aperture) method now respects arguments passed 
to it allowing the Bezier.rb and BZ tool plugins to work again. 

●​ Over ten fixes for Ruby issues and a few new methods for Ruby developers. 
Please see the SketchUp Ruby API site for details. 

Crashes: 



●​ We've resolved some of the top SketchUp crashes (as determined by our Bug 
Splat and BreakPad data). SketchUp should be more stable now. 

Other: 

●​ (Mac only) On machines where Arial Bold and Arial Italic fonts were missing 
or corrupted, the Components dialog could be blank or unresponsive. This 
issue has been fixed and the Components browser should now work even in 
this case. 

●​ Images correctly hide when editing components with "hide rest of model." 
●​ Walk tool no longer bounces when walking. 
●​ Measurement toolbar works as expected when in the top toolbar. 
●​ The customizable Standard Views tool palette no longer shows cryptic 

numbers for the tooltips. 
●​ Watermarks behave as expected during scene transitions and when 

switching to a Matched Photo scene. 
●​ The full text is visible for Entity Info for components or groups. 
●​ Launching SketchUp by dragging and dropping a model to the SketchUp.exe 

now does a proper validity check. 
●​ Previously, after switching scenes, the ground plane/edge effects and 

shadows over a background matched photo image degraded/flashed as you 
moved the mouse over the model. This flashing occurred until the model was 
modified. This issue should now be fixed. 

Known issues 

●​ The shadows strings fix will, in some models, make shadows look better, but 
in other models, may cause different kinds of shadow artifacts to show up. 
Because of this, the shadows strings fix is implemented as a toggle button on 
the new Shadow Strings Fix toolbar and is turned off by default. 

●​ (NVIDIA graphics cards only) Users with NVIDIA cards are more likely to see 
the "shadow strings" bug reported above, especially when the eye is in 
shadow. Toggle on the Shadow String Fix to work around this issue. 

●​ (PC only) If you have an English operating system set to a different language, 
you may have problems with Microsoft's .NET installation dialog box. In this 



case we suggest installing .NET separately then restarting your SketchUp 
installation. 

LayOut 

The following issues have been fixed: 

Preserve Scale on Resize - we worked on preserving scale to handle typical user 
workflows in a more efficient way. 

●​ LayOut now rescales SketchUp models after editing. 
●​ When editing a SketchUp model, "Preserve scale on resize" should be 

automatically disabled. 
●​ Setting the scale of a model no longer changes the style back to the style 

seen in the "Last saved SketchUp view." 

DWG/DXF export bug fixes: 

●​ Dashed lines scaling is improved in export to DWG/DXF. (Note: if you're 
planning on viewing your export in Model space, you'll want to export to 
model space; if you're viewing in Paper space use that export instead.) 

●​ Fixed three bugs affecting DWG/DXF Unicode character export. 
●​ Rotated entities in scaled DWG/DXF export are place correctly. 
●​ Export scale is correct when exporting to DWG/DXF model space. 
●​ Metric scaling should be the correct scale. 
●​ (Mac only) Previously, when exporting to DWG/DXF for the first time the page 

range of "All" wasn't honored. This has been fixed. 
●​ (Mac only) Lines break on a space when possible for DWG/DXF export. 
●​ (Mac only) When lines break mid-word in a DWG/DXF export, the lines are 

complete. 
●​ (Mac only) Previously, if you had text on more than one page of a DWG/DXF 

export, text would scale at an incorrect size on subsequent pages. This has 
been fixed. 

Localization: 



●​ Fixed three bugs affecting DWG/DXF Unicode character export. 
●​ (PC only) Previously, some Chinese, Japanese, and Korean characters didn't 

display properly at all or in Display mode. These characters should now be 
correctly visible. 

●​ Various translation fixes including template names. 

Fonts: 

●​ Previously, undoing a font color would link that action to the previous undo 
item, and you couldn't undo just the font change. Now font color changes are 
their own undo item. 

●​ Previously, if you had mixed-sized fonts in the same text box, the box would 
render differently than seen in text edit. Text now renders the same in both 
conditions. 

Other bug fixes: 

●​ The "Scale to weight" drop-down in the Shape Style inspector better handles 
systems where a comma is used as the decimal separator. 

●​ Fixed a crash that occurred when using Document Setup > References > 
Relink to link to invalid SketchUp file. 

●​ Many Template fixes to make settings more consistent from template to 
template. 

●​ Previously, you were not able to use a window select to select a clipped 
image unless you selected the entire hidden image bound. This issue has 
been fixed. 

●​ Previously, when editing inside a group, clicking outside of a dimension, text, 
SketchUp model, or path editor would exit the entire group edit. This issue 
has been fixed. 

●​ Previously, getting the center, endpoint, or on edge inference, would cause 
on face inferences stop working. This issue has been fixed. 

●​ (Mac only) Fixed a crash that occurred when trying to edit a SketchUp file 
after doing so in presentation mode. 

●​ (Mac only) Pan cursor correctly shows up with the shift key activated. 



  

Style Builder 

●​ Previously, applying any color (other than black) to the strokes caused many 
of the lines to drop out in the Style Preview model. This issue has been fixed. 

 



December 1, 2011 
​
New functionality 

  

●​ OS X Lion support: With SketchUp M2, we now officially support the Lion 
operating system. See below for specific fixes. 

●​ Ruby plugin improvements: 
○​ Ruby manager: This version of SketchUp has a simple UI to install and 

upgrade Ruby extensions. 
○​ .rbz file format: Ruby extensions typically consist of several files, so 

Ruby developers had to zip up those files into a standard .zip file and 
then give their users instructions on how to unzip them and where to 
place them. Now developers can zip up the files into the .rbz format 
and users can easily load an .rbz by going to Preferences > Extensions 
and clicking the "Install Extension" button. 

○​ Ability to turn off all Ruby plugins: With this release, it's much easier to 
disable (and re-enable) Ruby plugins for troubleshooting purposes. 

○​ Ruby plugin hooks: In addition to the above functionality, we have 
added several API hooks to allow Developers to more easily write their 
own Ruby extension managers. 

●​ Advanced Camera Tools are now installed by default, so they no longer 
require a separate plugin. 

●​ Account authentication: SketchUp now uses a more advanced technology to 
log into the 3D Warehouse. Instead of seeing the old SketchUp login dialog, 
you may see two dialogs, one prompting you for your username and 
password, and a second dialog asking for your permission to view and 
manage your 3D Warehouse data. As before, SketchUp should remember 
your login across sessions. 

●​ SketchUp Pro Trial no longer reverts to free features at the end of the 
evaluation period. Instead, you'll be prompted to purchase a license or 
downgrade to SketchUp (free). 



The following issues have been fixed: 

SketchUp: 

OS X Lion issues 

●​ Previously, when scene thumbnails were generated for models with 
background images (i.e., those with Match Photo scenes), SketchUp would 
hang and would need to be force closed. This issue has been fixed. 

●​ The error message "Service not available. Try again later" was shown when 
logging into the the 3D Warehouse. This error should no longer occur and 
the login should be successful. 

●​ SketchUp would hang in cases where it would have previously crashed. 
SketchUp will now no longer hang in these cases and the crash dialog that 
allows crash information to be sent should be presented again. 

●​ When exporting dae/kmz files to two different directories, SketchUp would 
hang. This has been resolved. 

●​ When certain snappy dialog boxes were stacked together and one of the 
dialogs in the stack was resized, the dialogs could break apart. They should 
now stay attached. 

●​ Mouse scroll direction is now set up to be consistent with the normal 
SketchUp behavior. Prior to this release the OS X preferences controlled the 
scroll direction so zooming in and out appeared to be backwards. 

●​ Previously, after making some kind of change to a scene (e.g., changing the 
camera), SketchUp would not reset the scene when clicking on the current 
scene tab. This issue has been fixed. 

Collada ​
​
We worked hard making sure that SketchUp's Collada importer and exporter are 
compliant with official Collada standards, set by the Khronos group. As part of this 
effort, we used the official Khronos Collada test suite, and are now 92% compliant 
with Collada standards. The following bugs were fixed as part of this effort: 



●​ Export: 
○​ We fixed an issue where some transparent textures were not exported 

correctly. 
○​ We now preserve texture names when exporting to the *.dae format. 

●​ Import: 
○​ Tags were not read correctly, resulting in a loss of textures on import. 
○​ Transparent textures in some dae files failed to import (e.g. when the 

texture location is stored as a value directly under the tag). 
○​ Textures in some dae files failed to import, resulting in an error . 
○​ The geometry in some dae files (those with tags) imported incorrectly . 
○​ When a color was specified only under the tag or when specifying the 

color using the tag, colors could fail to import. 
○​ Some valid dae files failed to import ​

. 
○​ When colors or textures were specified in a tag under the technique 

they did not import. 
○​ Importing transparency in some cases could yield a reversed 

transparency value (e.g. 1-correct_transparency instead of 
transparency). 

○​ Newparam values under library_effect were incorrectly read. 
○​ Crash when importing a file with a newparam under several different 

tags. 

Ruby: When SketchUp shows the Preferences > Extensions panel, it needs to ask all 
of the registered extensions for some metadata about themselves (e.g. name, 
author). Prior to this release, SketchUp would ask for this data on every mouse 
move. Now it should only ask for the metadata when showing the Extensions panel, 
which should improve performance. 

SketchUp Writer C++ API: In earlier versions, ISketchUpGroup::CreateGroup became 
slower each time it was called. This shouldn't slow down any longer. 

Crashes 



●​ Previously, when painting stand-alone soft/smoothed edges, SketchUp would 
crash. This crash has been fixed. 

●​ (PC only) Under certain conditions including having the Components Browser 
open, SketchUp could crash on exit. This was our second most frequent 
crash and should now be fixed. 

●​ (Korean, Japanese, and Chinese) SketchUp previously crashed when opening 
or saving a model containing certain validity errors. This was our number one 
crash and should now be fixed. 

●​ (Mac only) Previously, if you viewed a component collection, clicked the 
Previous button, and repeated those same viewing steps, SketchUp would 
crash. This crash has been fixed. 

Miscellaneous 

●​ (Mac only) When changing the width and height Print fields on the Mac, the 
changes weren't preserved, resulting in the inability to print to multiple 
pages. The print size settings should now be saved with the document and 
printing to multiple pages should be possible. 

●​ (SketchUp Pro only) On rare occasions, SketchUp Pro would appear to accept 
a license, but access to Pro features was never granted. With this version, if 
you appear to be licensed, you should have access to all functionality 
including LayOut and Style Builder. 

●​ (Mac only) When exporting to EPS or PDF on the Mac and setting scale values, 
the scale values were not accurate in the exported file. This issue should be 
fixed and scaling should be accurate with these formats. 

LayOut: 

●​ We received a customer file that crashed due to an incorrect tag. We added 
error handling to fix this problem. 

●​ We received a number of crash reports with comments like "I clicked on the 
style box and it crashed," "Using Scrapbook images," "I was changing type," 
and "attempting to open the tool palette." These crashes appeared to be 
coming from accessing tools on a page, so we changed the way we're 
accessing page content to fix these issues. 



●​ We received a number of crash reports that were related to performing 
actions in LayOut. The descriptions included things like inserting, copying, 
moving, rendering, updating, and resizing SketchUp models. We were able to 
isolate the issue to a particular area, and we added error handling to fix this 
issue. 

●​ LayOut previously crashed on DWG/DXF export with files that contained 
certain Chinese Unicode characters on Windows. This issue has been fixed. 

●​ (Mac only) The Shadow Time for a SketchUp Model in LayOut should have the 
correct range now, however you adjust it. Previously, if you were adjusting 
via the circular knob it only allowed a range of 5:00 PM to 9:38 PM. 

 



May 23, 2012 
The following issues have been fixed 

●​ SketchUp can crash when using Ruby plugins that call Ruby observers. In this 
release we addressed many of our top crashes, which should significantly 
improve the stability of SketchUp. The crashes were related to Ruby 
Observers. In particular: 

○​ Windows - SketchUp was not correctly cleaning up observers on exit, 
which could lead to crashes. 

○​ Mac - There were several issues with how observers interacted with 
the Mac's multiple document interface. 

●​ Previously, when working in SketchUp with a large number of Ruby plugins, 
some SketchUp context menu items could incorrectly become grayed out. 
With this release, this issue should happen far less frequently, if ever. 

●​ Models created in localized versions of SketchUp 7.0 and 7.1 had a Layer0 
which was translated. If those models were opened in any version of 
SketchUp prior to M3 and the translated Layer0 was purged or deleted, 
SketchUp could crash. When opening these models in Maintenance 3, the 
translated name of "Layer0" is no longer translated, which prevents the 
crash. When the model is saved, the problem is fixed for all versions of 
SketchUp. 

●​ Improved messaging and workflow for users without a nickname: In order to 
use the 3D warehouse, users must login using a Google account that has a 
nickname associated with it. Previously, when logging into the 3D warehouse 
using an account with no nickname, the login would fail. In this version, users 
without a nickname now see a better error message and are directed to a 
login screen to add a nickname. 

●​ Mac: Previously, when using the Ruby method Entities.add_group(), 
performance was much slower than on Windows. This issue has been fixed. 

New functionality 

●​ SketchUp now only uses one network license seat when launching multiple 
instances of SketchUp on the same Windows machine. Previously, when 
using a Windows network license each instance of SketchUp would use a 



separate license seat. In this version, launching multiple instances of 
SketchUp on the same machine will now result in only one network seat 
being used. 

●​ More secure image libraries, better protected from potential security 
vulnerabilities. 

●​ Added a link displaying Open Source Credits in the About SketchUp dialog. 
●​ Mac: We made a change that made uploads to the 3D Warehouse more 

reliable. 

 



August 28, 2012 
Win 8.0.15158​
Mac 8.0.15157 

SketchUp​
​
The following issues have been fixed: 

●​ SketchUp has been re-branded as a Trimble product. Most references to 
Google have been updated or removed as needed and we have a new icon. 
Some exceptions, such as the install path, still contain references to Google. 

●​ Mac: Better support for Retina display. 
○​ Text is easier to pick. Prior to M4, you had to click on the top left side 

of the text to select it and when edited, the text changed size, making 
it hard to edit. 

○​ Text and dimensions display at a correct size. 
○​ SketchUp now takes advantage of the full resolution of the Retina 

displays. 
●​ Mac: Text boxes within web dialogs no longer display with a black 

background. After Apple's release of Safari 5.16, text boxes within web 
dialogs (e.g., Add Location, Photo Textures, Add New Building, Dynamic 
Components and lots of the 3D Warehouse dialogs) could display with a 
black background, which made it impossible to see what you were typing. 

●​ Mac: Installer is now recognized as coming from an "identified developer " 
which complies with Mountain Lion's Gatekeeper feature. 

●​ Windows: When sending to LayOut from SketchUp on a machine where 
LayOut had never been launched as an administrator, the send previously 
would fail. This issue has been fixed. 

LayOut​
​
The following issues have been fixed: 

●​ LayOut, like SketchUp, has been re-branded. 



●​ Mac: Better support for Retina display 
○​ Mouse input is now recorded correctly. 
○​ A SketchUp model view that is part of a subview that has been scaled 

renders correctly 
○​ Text from a SketchUp model was shows up at the correct size. Prior to 

M4, text may have appeared very small. 

 



December 19, 2012 
Win 8.0.16846​
Mac 8.0.16845 

SketchUp​
​
The following changes were made: 

●​ We have new versions of both SketchUp and SketchUp Pro for the following 
languages: French, Italian, German, Spanish, Japanese, Korean, Traditional 
Chinese, Simplified Chinese and Brazilian Portuguese. We have new 
SketchUp versions of Russian and Dutch. 

●​ Windows: We fixed a bug in the DWG exporter that was preventing 2D from 
exporting properly. 

●​ Mac: Drop down menus on the Dynamic Component Options dialog were 
missing arrows, making it hard to know that they could be "dropped down" 
to show different options. This issue should now be fixed. 

●​ Mac: The new installer did set some folder permissions incorrectly. This issue 
should now be fixed. 

●​ Ruby: Extension creator/copyright was incorrect when an extension 
creator/copyright was not specified. Previously, when a Ruby extension did 
not specify a creator via the extension.creator and extension.copyright 
methods, the extension defaulted to being created by "SketchUp" with a 
copyright attributed to "Trimble Navigation Limited." With M5, the 
creator/copyright fields are left blank in this case. 

LayOut​
​
The following changes were made: 

●​ We have new versions of LayOut for the following languages: French, Italian, 
German, Spanish, Japanese, Korean, Traditional Chinese, Simplified Chinese 
and Portuguese. 



●​ On Mountain Lion, LayOut 3 could consistently crash on startup. Previously, 
if the OS system preference "Close windows when quitting an application" 
were unchecked and a LayOut 1 or LayOut 2 document was opened in 
LayOut 3, LayOut could crash and continue to crash on startup. This crash 
has been fixed. 

 



September 22, 2009 
Good to know 

●​ Please note that installing SketchUp 7.1 will overwrite version 7.0. 
●​ SketchUp 7.1 models are fully compatible with SketchUp 7.0 and LayOut 2.0. 

If you save a model in 7.1, it will automatically be able to be read by SketchUp 
7.0 and LayOut 2.0. 

Known Issues: 

●​ Mac - SketchUp may crash if you open a large file and navigate through the 
model a lot, or try exporting to a 2D format. Enable 'Hardware acceleration' 
in the 'OpenGL' section of the Preferences dialog box to work around this 
issue. 

LayOut 2.1: ​
​
Released 9/22/2009 

Known Issues: 

●​ If you've made changes to the default scrapbooks or templates that shipped 
with LayOut 2.0 (without renaming the files), those changes will be 
overwritten when you upgrade to LayOut 2.1. To save your changes, follow 
the Windows steps in this Help Center article before you upgrade. 

●​ When upgrading from LayOut 2.0 to LayOut 2.1, any customized toolbars and 
customized toolbar icons will be replaced with LayOut's default configuration 
| Windows only. 

●​ The Measurements box won't respond to any value you enter when used 
with the Dimension tool. 

●​ If you create a file in with bulleted or numbered lists and save that file in 
LayOut Version 1 format, LayOut Version 1 will crash when attempting to 
open the file | Windows only. 

 



November 17, 2009 
The following issues have been fixed: 

SketchUp 

Crashes 

●​ (Mac only) Under certain conditions, painting with the current material or 
clicking on a previously used material in a new model could cause SketchUp 
to crash. This crash should no longer occur. 

●​ (Mac only) SketchUp can crash when zooming in large models if the "Use 
Hardware Acceleration" option (SketchUp > Preferences > OpenGL) is turned 
OFF. This bug appears to be caused by the software renderer, and we're 
working with Apple to provide a fix. To workaround the issue, on first launch 
of this maintenance release, hardware acceleration is turned ON for all Mac 
users. If you turn hardware acceleration OFF again, the crash currently could 
return. 

Selection/inferencing 

●​ Selecting and inferencing could seem less precise. It was sometimes 
necessary to zoom in more in the original release of SketchUp 7.1 than in 
previous versions of SketchUp, and SketchUp could feel less snappy. 
Selection and inferencing now feel accurate and snappy again. 

●​ The intersection inference of two faces was not always found unless x-ray 
mode was turned on. Intersection inferences should be available again in this 
case. 

●​ Text and section planes were sometimes not selected. When opening some 
models with text on different layers, text and section planes sometimes 
could no longer be selected until SketchUp was reopened. This issue has 
been fixed and text and section planes should always be able to be selected. 

●​ When drawing a line from edge to edge in one of the axis directions, you 
could see an "intersection" inference when you should see an "on edge" 
inference. This issue has been fixed. 



●​ Finite guides could be incorrectly selected. Finite guides created via Ruby 
were previously selected as if they were infinite guides - i.e. if you picked a 
point parallel to the guide or did a crossing select in that same area, the 
guide was incorrectly selected. These guides should now be selected only if 
they are directly picked. 

Display 

●​ When editing a component and selecting a component within it, instances of 
that component were incorrectly highlighted if the "hide similar components" 
setting was checked. Instances are no longer highlighted in this case. 

●​ Text or dimensions added to an intersection were drawn incorrectly. Text or 
dimensions added to intersections would previously be drawn at the origin. 
They should now draw where they are placed. 

●​ Section planes sometimes appeared triangulated. When a section plane was 
placed directly on certain slanted surfaces, it displayed triangular faces. 
Section planes should no longer appear triangulated. 

Collada 

●​ Hidden geometry within groups was incorrectly exported to Google Earth. 
Previously, hidden geometry within a group or component was visible in 
Google Earth when the model was exported to Google Earth. This issue has 
been fixed. 

●​ Component or group names were not exported. The Collada exporter 
previously did not preserve component or group names. The DAE exporter 
now remembers these names. 

●​ KMZs created by earlier versions of SketchUp were not always imported 
correctly. Simple opaque colors in KMZs created in older versions of 
SketchUp would import as transparent. This issue has been fixed. 

●​ (Mac only) Canceling KMZ or DAE export caused issues with subsequent 
exports. After canceling a KMZ or DAE export, subsequent exports would no 
longer work. This issue has been fixed. 

●​ (Mac only) The "Export Components Hierarchy" option for the DAE exporter 
couldn't be set. The "Export Components Hierarchy" option was always 



exporting as if it were unchecked. SketchUp should now respect whatever 
setting is chosen for this option. 

●​ Placing a model twice resulted in multiple temporary places in Google Earth. 
When placing a model in Google Earth multiple times, the temporary place in 
Google Earth was not overwritten and a new temporary place was created. 
The temporary place should now be overwritten. 

Other 

●​ (Mac only) Measurements box was not always responding to input. When a 
user brought focus to the Measurements box on the Mac by clicking in it or 
tabbing to it, the Measurements box no longer accepted input. This issue has 
been fixed. 

●​ (Mac only)Styles browser didn't work with UTF-16 languages. When running 
an English version of SketchUp with a UTF-16 language setting (i.e., Korean, 
Chinese, Japanese), the Styles browser didn't work and was labeled "Generic 
browser." This issue has been fixed. 

●​ Not always prompted to save model after uploading a component. When 
opening a model and uploading a component to the 3D Warehouse, 
SketchUp didn't always prompt the user to save the model. Saving the model 
is necessary after an upload in order to uniquely identify the component to 
the 3D Warehouse. This issue has been fixed. 

●​ Links in Photo Texture failed to start a new browser instance. When clicking 
on the links in the License agreement for the Photo Texture feature, 
SketchUp didn't start a new browser instance making it confusing to return 
to the agreement. This issue has been fixed. 

●​ Needed a way to test the origin of polygons. A Ruby method 
(Sketchup::Curve.is_polygon?) for testing if polygons were made with the 
Circle or Polygon tool has now been added. 

LayOut 

Crashes 



●​ Crashing when moving models or lines. In certain scenarios, a file could 
become corrupt, and LayOut would crash when attempting to move or rotate 
a specific entity in that file. LayOut should be able to handle those files 
without crashing now. 

●​ Crashing when adding or sharing a layer. It was occasionally possible for a 
file's layer list to become corrupt. This could cause a crash when attempting 
to add or share a layer. New files should no longer get corrupted in this way, 
and older files that showed this problem should now work as expected. 

●​ Crashing when copy/pasting an invalid text box. It was possible to create an 
invalid, empty text box using the Label tool. LayOut would then crash if that 
invalid text box was copied and pasted. LayOut no longer creates an invalid 
text box, and no longer crashes when the text is pasted. 

●​ (Mac only) Crashing when closing a document. LayOut could crash when 
closing a document if the Document Setup dialog was open to the Grid panel. 
This crash has been fixed. 

●​ (Mac only) Crashing when rendering Hybrid or Vector SketchUp models. 
When rendering the far edge of a model's extents in Hybrid or Vector mode, 
LayOut could crash. This crash has been fixed. 

●​ (Mac only) Crashing when exporting very large PDF files. When exporting 
PDFs of very large files, LayOut could hang or crash. LayOut now handles the 
export more efficiently and should export without crashing. 

●​ (Windows only) Crashing when opening certain files with Auto-Render on. It 
was possible to see a crash when opening certain files when the SketchUp 
Auto-Render setting was turned on. This crash should be fixed. 

Dimensions 

●​ When creating a dimension that used Auto-Scale, the Dimension Style panel 
could show the wrong scale and Auto Scale setting. This has been fixed. 

●​ When disconnecting a model-space dimension from its model, the 
Dimension Style panel didn't update to show that the dimension had been 
converted to paper-space. It now updates to show that Auto-Scale can be 
toggled on or off and that the scale is 1:1. 



●​ It was possible to toggle the Auto-Scale button and chose a new scale while 
creating a model-space dimension, but neither of these settings actually 
affected that dimension. The Auto-Scale button is now disabled, and the 
scale will show "No Scale." 

Text 

●​ (Windows only) When switching between open documents, the Text Style > 
List > Start At value of one document could be mistakenly used in another 
document. This has been fixed; the "Start At" value is no longer carried from 
one file to another. 

●​ (Mac only) When pasting new text into an unbounded text box, the existing 
text could lose its formatting. This bug has been fixed. 

Other 

●​ Unchecking the Document Setup > Major Grid checkbox did not toggle the 
visibility of the major grid when points were used. This checkbox works with 
the point grid now. 

●​ The "Save As Version 1" setting could create files that LayOut 1 could not 
read. This would occur if the file contained dimensions or bulleted lists. This 
issue has been fixed. When saving a document as Version 1, dimensions are 
now removed from the file, and the bulleted lists are saved in a format that 
can be read by LayOut 1. 

●​ (Mac only) When exporting a PDF, the options dialog listed a "Create PDF 
Layers from LayOut Layers" setting, which was always disabled. It's not 
possible to export layers to PDF, so it was impossible for the user to enable 
this option. We removed this setting to avoid confusion. 

●​ If a SketchUp model used a clipping mask, it was possible to see snapping 
inferences to parts of the model that were clipped - and not visible. This has 
been fixed; LayOut should no longer snap to the geometry that is hidden by a 
clipping mask. 

●​ On Machines that use international number formatting (where commas 
indicate the equivalent of US decimal points), it wasn't possible to create a 



line that was less than 1 pt wide. For instance, it wasn't possible to create a 
0,35 pt line. This is fixed. 

●​ Minor changes have been made to the default templates. There were a 
number of text boxes that contained kerning, which would cause a template 
to look different on Mac (which has kerning built into the native OS text 
system) and PC (which does not). The kerning has been removed from the 
text boxes. 

 



January 13, 2010 
The following issues have been fixed: 

SketchUp 

●​ (Windows only) SketchUp 7.1 M2 Pro now requires Windows XP, SP2 as a 
minimum operating system version. SketchUp 7.1 M2 Free is not impacted. 

●​ (Windows only) The BugSplat dialog has been updated for the French and 
Spanish builds. 

●​ (Mac only) A language identifier has been added to the .dmg file so that users 
can identify which language version of SketchUp they're installing. 

●​ Several SketchUp dialogs have been translated. Prior releases had these 
dialogs always in English, even in the localized builds. 

●​ Several URL links have been corrected to go to the appropriate pages. 
●​ In SketchUp, an error is now displayed if an attempt is made to create a 

material with an invalid texture file. 
●​ This new release contains fixes for two security issues: 

1.​ The first is a pointer arithmetic error leading to memory corruption, 
which is triggered when parsing a malicious .3DS file. We would like to 
thank Francisco Falcon from CORE Security for reporting this issue to 
us. 

2.​ The second is an integer overflow leading to heap corruption, which is 
triggered when parsing a malicious .SKP file. We would like to thank 
Dave Weston from the Microsoft Vulnerability Research Center (MSVR) 
for reporting this issue to us. 

LayOut 

●​ (Mac only) LayOut would crash on a Mac running OSX 10.4 when attempting 
to export more than one page of a document to a PDF. This has been fixed. 

●​ (Mac only) LayOut had a bug that could cause a multi-page document 
exported to PDF to have the pages out of order. This has been fixed. 
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